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Preface 

How this guide is organized 

This guide is organized by task, rather than by command. For example, 
when you want to move a file, refer to Chapter 5, "Managing directories and 
files, "  rather than a chapter that describes the Move command. 

To find information about a specific command, task, or subject, refer to the 
index. We have included as many synonyms as possible for each subject and 
task. 

Use of terminology in this guide 

Throughout this guide, we have tried to avoid the use of technical terms. 
When it is necessary to use a term, we italicize it the first time it is used. For 
information about general computer terms or concepts introduced in this 
guide, see your system documentation or a general glossary of computer 
terms. 

In this guide, we use the word files to refer to any type of file found in your 
system.  This includes text files, data files, applications, FIFOs, symbolic 
links, sockets, and devices. 

We use the word directories to refer to any type of directory found in your 
system. 

In a few places in this manual, we use the word objects to refer to all types of 
files and directories in your system. 
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Style conventions 

Most of this guide is devoted to step-by-step instructions for per­
forming tasks. 

Procedure styles 

The following style conventions are followed in all procedures. 

The steps of a procedure are printed in boldface. 

For example: 
1. Choose Open from the File menu in the Directory 

window. 

The names of buttons and check boxes are capitalized as they are 
on your screen. 

For example: 
1. Click the Maximize button. 

To perform certain actions, it is necessary to hold down one key 
while typing another. 

For example: 
Control+N 

The number of the last (or only) step in each procedure is printed 
in outlined type. 

For example: 
no Choose Quit Looking Glass from the System menu 

in the Global window. 

or 

1. If the files and directories you want displayed 
first are not already selected, select them. 

�"Choose Group Selected Objects from the Sort menu 
in the Directory window. 

The names of files, directories, programs, and arguments to pro­
grams are printed in Courier font. 
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For example: 
The FSS maintains a small database file ( .  lgdb) in each direc­
tory with information needed to display, print, edit, and acti­
vate each file. 

Text that you should type is printed in boldface Courier font. 

For example: 
If all of your text files are encrypted, you may want to use the 
editor vi with the -x argument for editing encrypted files. 
In this case you would type: 

/usr/bin/vi -x #f 

Command language syntax styles 

The following style conventions are used in command and lan­
guage syntax descriptions. Most of these apply only to the informa­
tion in Chapter 13, "Defining file types." Most Looking Glass users 
won't need to perform the tasks that require use of command and 
language syntax descriptions. 

Syntax diagrams and source code samples are printed in Courier 
type. 

In generalized syntax diagrams, sections for which detailed syntax 
is not presented are represented by descriptive labels enclosed in 
" less than" (<) and "greater than" (>) symbols. 

Generalized__j 
syntax d iagram� 

For example: 

DEFINE TYPE <type name> 

END 

ICON <icon name> 
FILE DESCRIPTION <text> 
<rule statement> 
<command section> 

Fixed elements of the command or language (including keywords, 
mathematical symbols, and other non-alphabetic characters) are 
printed in boldface in syntax diagrams. These elements are repre­
sented literally, with any required capitalization, both in the syntax 
diagram and in accompanying text. When referenced in text that is 
not part of a syntax diagram or table, these elements are printed in 
the font used by the surrounding text and retain any upper and 
lowercase characteristics indicated in the syntax diagram. 
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Variable data supplied by the user is represented by italicized 
descriptive labels. When referenced in text that is not part of a syn­
tax diagram or table, they are italidzed and printed in the font used 
by the surrounding text. 

For example: 
Fixed elements-----========..,----:---, 

FILE DESCRIPTION "Description" 

Variable element----_:_===__:___....::.....::_....::._:::::::::::r .:..::.= 

Optional syntax elements are enclosed in brackets ("[" and "]") .  

Lists of items separated by vertical bars (I) are exclusive lists from 
which the user may choose one and only one item. If the list is 
enclosed in braces ("{" and "}"), one item must be used. 

For example: 
Optional syntax ------------::-:----==:::::L:-:--

element CONTENT Offset [TO Offset] 

Exclusive list from 
which user must 

choose one 

{STRING I BYTE I SHORT I LONG} [< I > I =l 
{"String" II NumericValueJ 

Ellipses ( . . .  ) following a syntax element indicate that the element 
can be repeated an unlimited number of times. 

For example: 

Optional element-----====::-::----;:;::;::L---., that can be repeated DIRECTORY Name [Name ... ) 
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In this chapter, you'll learn what Looking Glass is and how to start it: 

• Automatically (as your login shell) 
• Manually (from a command line) 

You'll also learn how to quit Looking Glass. 

After you have learned the basics of starting and quitting, we'll give you a brief tour 
of a typical Looking Glass workspace. You'll become familiar with the Looking Glass 
windows and icons that you'll use in your work. 
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What is Looking Glass? 

Looking Glass is a graphical user environment for your workstation 
or X Window System terminal. It gives you the ability to organize 
your personal workspace so that the programs, files, and directories 
you use most often are within easy reach. 

With Looking Glass, you can run a program (like a spreadsheet or 
word processor) by simply double-clicking on the program's icon or 
one of its data files. Moving a file between directories is just as easy: 
you drag it from one window to another with the mouse. You can 
even perform tasks such as creating links and changing file owner­
ship and access permissions without typing a single command. 

Here are just a few of the many tasks that Looking Glass simplifies 
for you: 

• Running programs 
• Opening files for editing 
• Printing files 
• Viewing the contents of directories 
• Creating new directories 
• Moving, copying, and removing files 
• Viewing and changing information about directories and files 
• Finding directories and files in your system 
• Displaying and changing information about directories and files 

In the following sections, we'll tell you how to start and quit 
Looking Glass, give you a brief tour of a typical Looking Glass 
workspace, and introduce you to Looking Glass icons. 

Starting Looking Glass 

There are two ways to start Looking Glass: 

• Use it as your login shell 
• Run it from a command line 

Depending on your system, you or your system administrator may 
have to start the License Server before you can start Looking Glass. 
For information about the License Server, refer to the Looking Glass 
Release Notes. 

Starting Looking Glass as your login shell 

If Looking Glass is set up as your login shell, you can simply log in 
to your system following your normal procedures. After you log in, 
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Looking Glass starts up immediately, and you are ready to start 
working. 

If Looking Glass is not your login shell and you would like it to be, 
see your system administrator. 

If you are responsible for installing Looking Glass as a login shell 
for yourself or other users, refer to the descriptions of the com­
mand-line arguments for Looking Glass in "Specifying Looking 
Glass options at startup" later in this chapter. 

Starting Looking Glass from a command line 

You can run Looking Glass from your system's command-line 
prompt by executing the program lg. 

If you start Looking Glass from a command line, you should run 
the program as a background process by placing the ampersand (&) 
character at the end of the command. If you don't run Looking 
Glass in the background, the terminal window that you start 
Looking Glass from will be busy until you quit Looking Glass. 

1.  Type: 

lg& 

�0 Press Return. 

The Looking Glass startup window appears, followed by the 
Looking Glass windows. 

If you need help the first time you run Looking Glass from a 
command line or use any program options, see your system 
administrator. 

Specifying Looking Glass options at startup 

This section is intended for system administrators and other users 
who are responsible for maintaining Looking Glass. 

Looking Glass provides a set of startup options that allow you to 
open specific directories at startup time and control certain aspects 
of the program's appearance and operation. If your users start 
Looking Glass from a command line, they can do this easily at the 
time they run Looking Glass. If your users start Looking Glass as 
their login shell, you can specify these arguments for them. 
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1.  Click in the window of the command-line shell you 
want to run Looking Glass from. 

2. Enter: 

lg <arguments> & 

where <arguments> is the list of arguments you want to specify 
(refer to the following table for the list of arguments you can use) . 

For example: 
lg budget plans -display lotus:O.O & 

This example tells Looking Glass to: 

• Start as a background process (indicated by the &) 
• Open the directories budget and plans 
• Use the machine " lotus" as its display 

iBo Press Return. 

The following table describes the arguments you can specify at 
startup: 

This argument: 

-help 

-version 

or 
-ver 

directories 

-u>OID&tyle 

or 
-uwm 

Does this: 

Tells Looking Glass to print a summary of com­
mand-line arguments. 

Tells Looking Glass to d isplay version information 
without starting. 

Opens the directories you specify at startup 
automatically. 

Tells Looking Glass to d isplay windows compatible 
with the uwm window manager. 
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Does this: 

Tells Looking Glass to put a frame around its 
windows. 

Use this argument for window managers that do 
not supply frames for windows. 

-bordercolor color Lets you specify a color for Looking Glass 
or window borders. 
-color 

This argument only takes effect when the 
-frame argument is also used. 

-lookandfeel style Lets you specify a look-and-feel style. 
or 
-laf style 

-font font 
or 
-fn font 

-bold font 
or 
-fb font 

-memo 

-foreground color 
or 
-fg color 

Specify 3d or 2d style. 3d is OSF/Motif 
compliant. 

Lets you specify a font for plain (nonbold) 
text. 

You can use any font available on your system. 

Lets you specify a font for bold text. 

You can use any font available on your system. 

Forces a monochrome display on a color 
monitor. 

Lets you specify a color for the user interface 
elements that are in the foreground. 

Use a color from the system's color database or 
specify a color's Red, Green, Blue (RGB) value in 
hexadecimal notation. 
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This argument: 

-background color 
or 
-bg color 

-topshadow color 
or 
-ts color 

-bott� color 
or 
-bs color 

-di�lay machine 

-preload 

-napreload 

Quitting Looking Glass 

Does this: 

Lets you specify a color for the user interface 
elements that are in the background. 

Use a color from the system's color database 
or specify a color's Red, Green, Blue (RGB) 
value in hexadecimal notation. 

Lets you specify a color for the top shadow 
of the user interface elements. 

Use a color from the system's color database 
or specify a color's Red, Green, Blue (RGB) 
value in hexadecimal notation.  

Lets you specify a color for the bottom 
shadow of the user interface elements. 

Use a color from the system's color database 
or specify a color's Red, Green, Blue (RGB) 
value in hexadecimal notation. 

Lets you specify the hardware d isplay name 
for the machine whose display wil l  be used 
by Looking Glass. 

This option is only valid under the X Window 
System. The machine name supplied will be 
used to set the DISPLAY environment variable. 

Tells Looking Glass to preload all icon images 
at startup for faster display performance. 

This is the default. 

Tells Looking Glass not to preload icon 
images at startup. 

n. Choose Quit Looking Glass from the System menu in 
the Global window. 

If there are no programs running that you launched from 
Looking Glass, Looking Glass quits. 
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If there are programs running that you launched from Looking 
Glass (for example, the Icon Editor or a terminal emulator win­
dow), a message box opens asking you if you want to quit 
Looking Glass without quitting the programs you launched. 

one or more programs laW1dled from wiU1In 
Looking Glass are still running. Quit 
anyway? 

Yes I �- No II 

To close this message box, click: 

• Yes to quit Looking Glass and leave the other programs 
running 

• No to cancel and return to Looking Glass 

NOTE: 
Any Looking Glass windows you have open when Looking Glass 
quits will open automatically in the same positions the next time 
you start Looking Glass. 

A brief tour of Looking Glass 

In this section, we'll give you a brief tour of a typical Looking Glass 
workspace. We call this a "typical" workspace because Looking 
Glass gives you the ability to organize your workspace any way you 
want, placing the programs, files, and directories you use most 
often within easy reach. When you quit, Looking Glass remembers 
how you left your workspace and restores that arrangement the 
next time you start Looking Glass. 

In addition, Looking Glass lets you name and save an unlimited 
number of workspace layouts so you can switch easily from one lay­
out to another. For instructions on organizing your workspace and 
saving layouts, refer to Chapter 9, "Organizing your workspace."  

The illustration on the following pages shows you a typical Looking 
Glass workspace. We've labeled the windows so you can begin to 
familiarize yourself with them. In this chapter we'll introduce the 
major windows in Looking Glass. 
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Global window 

Directory window 
in Name view 

Directory window in 
Wide view 

..... 
eo Benefits 

eo Reviews 

..... 
eo HandbooK 

eo Ads 

eo Litigation 

1\'1 Agencies 1\'1 Employee_lnfo 1\'1 Hiring_Sched 

1\'1 Offer_Letler 

1\'1 Staffing_Ptan 

1\'1 Recruit_Letler 1\'1 Salaries 

.... rwx r-x r-x 

eo rwx r-x r-x 

eo Archive rwx r-x r-x 

eo Budget rwx r-x r-x 

eo Data rwx r-x r-x 

1\'1 Acme_Letler rw- r-- r--

1\'1 Ad_ Copy rw- r-- r--

1\'1 Appointments rw- r-- r--

1\'1 Client_List rw- r-- r--

1\'1 Forecast rw- r-- r--

1\'1 Phone_List rw- r-- r--

1\'1 Sales_Leads rw- r-- r--

hal 

root 

hal 

hal 

hal 

hal 

hal 

hal 

hal 

hal 

hal 

hal 

dsgrp 16 1024 
system 25 512 
dsgrp 2 512 
dsgrp 4 512 
dsgrp 2 512 

dsgrp 339 
dsgrp 4827 
dsgrp 234 
dsgrp 18179 
dsgrp 4646 
dsgrp 3016 
dsgrp 54397 
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Directory window in Icon view Desktop Panel 

0 
Archive Zycor 

0 
Exec_Summary 

Zycor_Cost 

Worldwide Worldwide_Cost 

a m • 

Phone_List News 

� IJ . 
Sales_Leads Forecast 

DMV 
Staffing Deadlines 

DMV_Cost 

0 � 
Letlers Proposals 

Administrators Acme Acme_Cost 0 � 
Budget Personnel 

" --
Paint Database 

�==)!!!Modification Time I:!Eype li,lunk Content 

71 701 09:56 Oct 28 1 990 Directory 

� 
2 14:47 Nov 20 1 990 Directory 

34823 1 8:56 Jul 26 1 99 0  Directory 

73766 1 1 :5 0  O c t  1 4  1 990 Directory 

88072 1 5:35 Oct 15 1 990 Directory 

� 
Editor Spreadsheet 

71 709 1 2:53 Mar 1 4  1 990 Text file 

71 703 1 1 :32 Apr 28 1 99 0  Text file 

71 738 1 3:1 5 Oct 2 1 99 0  Desktop calendar document 

71 730 1 1 :37 Sep 25 1 990 Card file 

71 705 1 3:38 Nov 20 1 989 Spreadsheet data file 

7 1 7 0 7  1 2:48 Aug 5 1 988 Card file 

71 731 1 2:58 Feb 28 1 99 0  Database data file 
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The Global window 

The Global window is the only window in Looking Glass that 
always appears on your screen when Looking Glass is active. All 
other windows can be opened or closed at your command. 

Here is a typical Global window: 

From the Global window, you can perform "global" tasks such as: 

• Setting your preferences for how Looking Glass operates 
• Opening other Looking Glass windows 
• Maintaining environment variables 
• Accessing the help system 
• Running a terminal emulator 
• Quitting Looking Glass 

When you launch a program with Looking Glass, the application's 
icon is displayed in the Global window as long as its application is 
active. 
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Directory windows 

Directory windows display the contents of a directory. 

Here is a typical Directory window: 

� � 0 0 
Archive Budget 

0 0 0 0 
Data Letters Personnel Proposals 

I - I - � � 
Acme_letter Ad_ Copy Appointments Client_list 

� 11 I . 

-

Forecast Phone_list Sates_Leads Stafling_Ptan 

� I -

To_Do Zycor_Letter 

From Directory windows, you can perform tasks like: 

• Opening and closing selected directories and files 
• Launching programs 
• Changing the way you view directories and files 
• Printing files 
• Moving and copying files 
• Removing directories and files 

You can view objects in a Directory window by their icon or name, 
or in a wide format that contains detailed information. The exam­
ple above shows a Directory window with objects displayed as 
icons. For more information about these display formats, refer to 
"Changing display formats" in Chapter 4, "Working with Directory 
windows." 

If you have a color display, you can also control the color of icons 
in Directory windows. For more information about viewing directo­
ries and files in Directory windows, refer to "Changing display for­
mats" in Chapter 4, "Working with Directory windows." 
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Directory windows separate directories from files with a horizontal 
bar called a splitter. The top section of a Directory window displays 
the subdirectories in that directory and the bottom section displays 
the files in that directory. You can move the splitter to adjust the 
height of each section. 

You also have the option of removing the splitter and positioning 
directories and files anywhere in the Directory window. For informa­
tion about positioning directories and files, refer to "Repositioning 
directories and files" in Chapter 4, "Working with Directory win­
dows." 

You can display as many Directory windows as you want, but you 
can only display a particular directory in one window at a time. 

The Desktop Panel 

The Desktop Panel gives you a place to put frequently used pro­
grams, files, and directories. The objects you put on the panel are 
not actually moved from their locations in the file system-they are 
just displayed there for easy access. You can open or activate any 
object from the Desktop Panel the same way you can in Directory 
windows. 

Here is a typical Desktop Panel: 

ai m -
Phone_Ust News 

" 'I -
Paint Database 

0 0 
Budget Personnel 

0 0 
Letters Proposals 
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Notice that there are several directory and file icons i n  our sample 
panel. Objects you put on the panel stay there until you take them 
off. You'll probably find yourself keeping directories and files on 
the panel on an "as needed" basis. For example, you might display 
the directory Budget _90 during the week you are working on a bud­
get. On the other hand, if you use your spreadsheet application all 
year round, you would probably keep it on the panel all the time. 

Once you have placed an object on the Desktop Panel, you can put 
it in any position you want. This allows you to put directories and 
files in the most convenient order. 

When you save a workspace layout, the size and position of the 
Desktop Panel, as well as its contents, are also saved. 

looking Glass icons 

Icons play an important role in your Looking Glass workspace. 
Looking Glass icons are images that represent directories and files 
in your system. There's an easily recognized icon for each type of 
directory or file in your system. As you can see from our "typical" 
workspace, icons can appear in a number of locations. 

Looking Glass provides an Icon Editor for managing icons. With 
the Icon Editor, you can: 

• View the Looking Glass icons in your system 
• Edit existing icons 
• Create new icons 

If you browse through the icons that come with Looking Glass, 
you'll notice that certain characteristics are represented in more 
than one icon design. Icons with the same design make up an icon 
"family." Some of the more important icon families are described 
on the following page. 
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Icons with one fold in the upper right corner represent data files 
that may be opened by more than one application. An example of 
this type of file is a file that contains only text. This type of file can 
be edited by more than one editor or word processor. Icons in this 
family often contain another visual cue that indicates what applica­
tion created them or what kind of data is in them. Here are some 
examples of icons used to represent data files: 

I - � [iJ 
Text file Empty Password 

file file 

Icons with two folds in the upper right corner are data files that 
contain data in a format that is probably meaningful only to the 
application that created them. Files in this family include the data 
files that programs create to store your work. Here are some exam­
ples of icons used to represent data files containing data formatted 
for a specific program: 

Spreadsheet 
document 

Word processor 
document 

Database 
data file 

The folder icon represents a directory. Within this family, there are 
different types of directories. For example, the picture of a house on 
a folder represents your home directory. When a directory is open 
somewhere on your workspace, its folder icon is "fanned" to make 
it appear open. Here are some examples of icons used to represent 
directories: 

Home 
directory 

Open 
directory 

Mounted 
directory 

As you work with Looking Glass, you'll notice other common char­
acteristics that make up icon families; you can even create some of 
your own icons with the Icon Editor. For more information about 
the Icon Editor, refer to Chapter 10, "Working with the Icon 
Editor." 
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This chapter teaches you the basic skills for interacting with Looking Glass. It is 
intended to help users who have not used icon- and mouse-driven programs such as 
Looking Glass. 

You'll learn how to move around in Looking Glass using a mouse and keyboard to 
activate commands and operate Looking Glass controls such as menus and buttons. 

In this chapter, you'll also become familiar with the window frame elements and 
learn how to use your window manager to: 

• Move windows around on your workspace 
• Change the size of windows 
• Close windows 

The appearance and behavior of Looking Glass is based on the Open Software 
Foundation's MotifTM user interface guidelines. These guidelines ensure that standard 
operations, such as choosing items from menus, can be performed the same way in 
all programs. For more information about Motif, refer to the OSF/MotifUser's Guide. 
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Using the mouse and keyboard 

This section explains how to use the mouse and keyboard to inter­
act with Looking Glass. The term mouse refers to any kind of point­
ing device used to control your workstation or X terminal. 

Most Looking Glass actions require a mouse, but some actions can 
be controlled using the keyboard. This section explains how to navi­
gate with a mouse first, then describes some keyboard shortcuts. 

Using the mouse 

Throughout this manual, you'll be instructed to perform basic 
mouse actions, such as clicking and dragging. The following para­
graphs explain these basic actions and tell you how to perform 
them. Looking Glass does not distinguish between mouse buttons, 
so when you are told to press a mouse button, you can press any of 
them. 

You'll perform four basic mouse actions in Looking Glass: 

• Click 
• Double-click 
• Shift-click 
• Drag 

Clicking 

Clicking the object that the pointer is on in a window selects that 
object. Clicking in a text field moves the cursor to the place where 
you clicked. If an object or word is already selected, clicking any­
where else in the window unselects the object or word. 

1. Put the pointer on an object or in the new location in 
the text. 

:ilo Press and release a mouse button. 

If you clicked an object, it is highlighted. If you clicked in a text 
box, the insertion cursor moves to that spot. 
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Double-clicki ng 

Double-clicking the object that the pointer is on in a window acti­
vates or opens that object. You double-click a word in a text field to 
select (highlight) that word. 

1. Put the pointer on an object or word. 

�0 Quickly press and release a mouse button twice. 

If you double-clicked an object, it is activated. If you double­
clicked a word in a text field, it is highlighted. If you double­
clicked a an item in a list, the command associated with that 
item is activated. 

Shift-cl icking 

The shift-click action selects (or unselects) the object that the 
pointer is on in a window without unselecting other selected 
objects. 

1.  Put the pointer on the object you want to select. 

�0 Press the Shift key while you press and release a 
mouse button. 

If you shift-clicked an unselected object, it is selected. If you 
shift-clicked a selected object, it is unselected. If you shift­
clicked a word, it is highlighted. 

Dragging 

Dragging allows you to select or move one or more objects from one 
place to another in a window. You can also select a word or a block 
of text in a text field by dragging. 

Before you select a group of objects, you should imagine a rectangle 
around the group of objects you want to select. You'll drag across 
the group of objects by starting at one of the corners of this imagi­
nary rectangle. 

Selecting a g roup of objects by dragging 

1.  Put the pointer in the window near the objects you 
want to select, at the corner of the imaginary rectan­
gle surrounding the objects. 
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2. Hold down a mouse button. 

3. Move the pointer diagonally across the area contain­
ing the objects you want to select. 

As you move the pointer, the objects are enclosed in a selection 
rectangle. 

Here is an example of a group of objects that have been 
selected: 

� � 0 0 
Archive Budget 

0 0 0 0 
Data Letters Personnel Proposals 

I -

Acme_Letter 

A group of selected ----tiH---ti;;;;;t!r-----1 
objects 

Forecast 

s 
To_Do Zycor_Letter 

4lo When all of the objects you want to select are enclosed 
in the rectangle, release the mouse button. 

The objects are highlighted. 

Moving an object by d ragging 

1. Put the pointer on the object you want to move. 

2. Hold down a mouse button. 

3. Move the pointer to move the object to a new location. 

4lo When the object is where you want it, release the 
mouse button. 
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Selecting text in a text box by dragging 

1. Put the pointer at the beginning or end of the text 
you want to select. 

2. Hold down a mouse button. 

3. Move the pointer across the text you want to select. 

4.\o When you are finished highlighting the text, release 
the mouse button. 

Using accelerator keys 

Open menu 

Looking Glass is intended to be controlled primarily with a mouse. 
However, you can use the keyboard to perform certain tasks. 

An accelerator key is a single key (such as Fl) or a combination of 
keys (such as Control+Fl) that is assigned to a command in a menu. 
Using an accelerator key has the same effect as selecting a com­
mand from the menu with the mouse. 

Not all commands in Looking Glass can be selected with accelerator 
keys, but many can. When a command can be selected with an 
accelerator key, the key sequence is displayed next to the command 
in the menu. 

Here is an example of a menu with commands and their keyboard 
equivalents: 

0 
Budget 

lntomm1ion A( 

0 0 f'Yilll A(' 

01m11 A() Personnel Proposals 

f{f�H}I)V(� I (<�py ... � 
MOV(� ... Appointments Client_List 

Uuk ... At_ � 11 Omnu<� Prop<�r1i(!S ... 
Put on Onsk1nJI f>tuml Sales_Leads Staffing_Pian 
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The accelerator keys in Looking Glass are abbreviated in the menus. 

For example, when you see "N in the Create menu, you press 
Control+N. 

The following table lists the commands in Looking Glass that can 
be selected with accelerator keys. To use any accelerator key, press 
the key or combination of keys listed in the table. 

Window Command Menu Accelerator key 

Global Open Directory Windows Controi+Y 
window 

Terminal Emulator Run Controi+T 

Command Line Run Controi+R 

Directory Change Directory File Controi+Y 
window 

Close File Controi+W 

Information File Control+! (or TAB) 

Print File Controi+P 

Open File Controi+O 

link File Control+l 

Directory Create Controi+N 

Icon View Controi+K 

Wide View Controi+E 

Group Selected Objects View Controi+G 

Clean Up View Controi+U 

Select By Pattern Select Controi+S 

Select All Files Select Controi+A 

Find Select Controi+F 

Terminal Emulator Run Controi+T 

Command Line Run Controi+R 
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Window Command Menu Accelerator key 

Desktop Close File Controi+W 
Panel 

Open File Controi+O 

Show File Controi+H 

Print File Controi+P 

Icon View Controi+K 

Clean Up View Controi+U 

Tree View Open In Tree Directory Controi+O 
window 

Close In Tree Directory Control+( 

Show In Tree Directory Control+l 

Open In  Window Directory Controi+Y 

Close Tree View Directory Controi+W 

Name View Controi+N 

Icon View Controi+K 

All Directories Select Controi+A 

All Open Directories Select Controi+P 

All Unselected Select Controi+U 
Directories 

Parent Directories Select Controi+Q 

Subdirectories Select Controi+Z 

Subtrees Select Controi+B 

Save Tree As Tree Controi+S 

Open Saved Tree Tree Controi+T 

Merge In Saved Tree Tree Controi+M 

Find Show Controi+F 

To use an accelerator key, hold down the Control key and press the 
appropriate letter key. You can also access the online help for 
Looking Glass by pressing the F1 key. 
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For information about the commands executed by these keystrokes, 
refer to the sections in this manual that explain the task associated 
with the command. For example, for information about the Link 
command, refer to Chapter 5, "Managing directories and files." 

Using your window manager 

A window manager is a special program that controls the appearance 
and behavior of windows displayed by programs such as Looking 
Glass. Because of the differences among window managers, you 
may notice differences between the window frames on your screen 
and the Looking Glass window frames shown in this manual. This 
manual shows Looking Glass windows with the OSF/Motif window 
manager, mwm . 

If your window manager doesn't put frames around windows, you 
can have Looking Glass put frames around windows by starting it 
with the - frame option. For more information on Looking Glass 
startup options, refer to "Specifying Looking Glass options at 
startup" in Chapter 1, "Getting started with Looking Glass." The 
frame that Looking Glass provides works according to OSF/Motif 
user interface guidelines. 

NOTE: 
Even though Looking Glass can provide frames if you need them, it 
does not replace the need for an actual window manager. 

Knowing how to use your window manager is important because it 
allows you to move, resize, and close Looking Glass windows. This 
section tells you how to perform some basic actions using the 
frames that Looking Glass puts around its windows when using the 
-frame option. 



Frame 
controlled 

by window 
manager 

Area 
inside frame 

controlled by 
Looking Glass 
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The following illustration shows the portion of a typical Looking 
Glass window that is displayed and controlled by the window man­
ager and the area that is controlled by Looking Glass: 

Archive Budget 

0 0 0 0 
Data Letters Personnel Proposals 

I - I - II � 
Acme Letter Ad_ Copy Appointments Client_List 

m � I I . -

Forecast Phone_Usl Sales -Leads Statting_Pian 

� I -

Notice in this example that the window manager controls the outer 
portion of the window (the frame around the window). Everything 
inside the window is controlled by Looking Glass. 

Window frame elements 

Looking Glass window frames contain these elements: 

• Window Manager button 
• Title bar 
• Minimize and and Maximize buttons 
• Resizable border 

The following illustration shows you the locations of the window 
frame elements: 

Window Manager --JiiijiiliiiiE����§�5J 
menu button 

Title Bar --11----' 

Maximize button ---111---------------------' 
Window frame 
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You can access some of the window manager functions through the 
Window Manager button. This button allows you to perform simple 
tasks such as maximizing, lowering, and closing the window. 
However, most of the actions in this menu can be performed more 
quickly with the other elements of the window frame. These ele­
ments are described in the next section. A command is dimmed 
(grayed out) when the option is not available. 

The Window Manager button is located to the left of the title bar at 
the top of the window frame. 

Accessing the Window Manager menu 

n. Click the Window Manager button. 

The Window Manager menu opens. 

Moving windows 

One of the ways you'll find yourself manipulating windows is by 
moving them around on your workspace. 

The window manager provides an area called the title bar at the top 
of each frame for the name of the window. The title bar also pro­
vides a fast way to move the window to another location. 

Moving a window to another position 

1.  Move the pointer to the title bar in the window. 

2. Drag the window to its new position. 

3l. When the window is where you want it, release the 
mouse button. 

Bringing a window to the front of a stack of windows 

n. Click in the title bar on the window. 

The window moves to the front of the stack. 

NOTE: 
Some window managers allow you to click anywhere in a win­
dow to bring it to the foreground. 
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Here is an example of stacked windows: 

0 � 0 I! Benefits 

I - I - I -

Database Offer_Letter Staffing_ Ptan 

You can bring a Looking Glass Directory window to the front of a 
stack of windows by using the Windows menu in the Global win­
dow (for more information, refer to Chapter 4, "Working with 
Directory windows"). Using the Windows menu is helpful if  you 
have so many windows open on your workspace that the window 
you want to bring to the front is completely hidden. 

Moving a window behind a stack of windows 

TI. Choose Lower from the Window Manager menu. 

The window moves to the back of the stack. 

Resizing windows 

In addition to letting you move a window to a new location on the 
workspace, the window manager also lets you control the size of 
the window. You can make most windows smaller or larger by 
using the frame provided by your window manager. 
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There are two ways to enlarge a window: stretching the frame in 
increments, or using the Maximize button to blow up the frame. 

Resizing a window using the frame 

1.  Move the pointer to a corner or edge of the window 
frame. 

2. Drag the window frame up, down, left, or right to 
resize it. 

3l. When the window is the size you want it, release the 
mouse button. 

Resizing a window using the Maximize button 

n. Click the Maximize button. 

The window is enlarged so that it fills-your screen. 

Restoring a maximized window to its original viewing size 

n. Click the Maximize button again. 

The window is restored to its original size and position on the 
workspace. 

NOTE: 
You can only restore a window to its original size if you used 
the Maximize button. If you used the frame to enlarge the win­
dow, clicking the Maximize button won't restore it. You must 
use the frame to make the window smaller. 

Closing windows 

Although you can close any window on your workspace by select­
ing a command from a Looking Glass menu, the window manager 
also lets you close any window with a frame around it by using the 
Window Manager button at the top of the frame. 
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NOTE: 
If you close a terminal emulator in which you have been running a 
shell or application, you must exit the shell or quit the application 
before you close the window. Using the window manager to close 
the terminal emulator window won't quit the shell or application. 

JL Choose Close from the Window Manager menu. 

The window closes. 

Working in Looking Glass windows 

Now that you know how to perform basic mouse and keyboard 
actions and use your window manager, you are ready to work with 
Looking Glass windows. 

Window types 

As you work in Looking Glass, you'll use windows and dialogs. This 
section describes windows and dialogs and shows you how to use 
the controls that appear in them. 

Using windows 

A window is an area that stays open on your workspace unless you 
explicitly close it. Windows can be controlled using your window 
manager. Windows usually contain menus. 

The most important windows in Looking Glass are: 

• The Global window 
• Directory windows 
• The Desktop Panel 

These three windows were introduced in Chapter 1, "Getting 
started with Looking Glass. "  You'll learn more about the specific 
tasks you can perform using these windows as you continue 
through this manual. 
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Here is an example of an option menu displayed in a dialog: 

---- -

••••••• Gruen 
---· BlUe 

Choosing a command from an option menu 

1.  Move the pointer to the option that is showing. 

2. Click a mouse button. 

The option menu opens. 

33. Click the option you want to select. 

The menu closes and the option that you chose is displayed in 
the dialog. 

Pop-up menus 

Pop-up menus are similar to option menus because they may appear 
anywhere in a dialog. However, pop-up menus display the title of 
the menu rather than the currently selected option. When you click 
the title, the menu opens. 
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Here is an example of a pop-up menu: 

�mm�d: ! I 
Menu title --t-----: ��R�u�n ��n�T�e�rm�i�nai�Wi�n�do�w�flliab�l 

:::j 
1!11 Pause Afwr Execution 

Sym 0 s 

History: I SchH:tml nlf�s 
Pop-up menu ---11------+--, -----------1- S�>h><:tml llir�>ctmi�>s 

Effective User L-------------� Effective Group 
-------;:===��=� OJrrent Directory 

B<mww I I aose I Ill'-·=- ===:ll':="'=,J_.: 
Run command 

Choosing a command from a pop-up menu 

I .  Move the pointer to the menu title that is showing. 

2. Click a mouse button. 

The pop-up menu opens. 

33" Click the option you want to select. 

Text boxes 

The menu closes and the value that you chose is displayed in 
the dialog. 

A text box lets you enter or edit information in a dialog by adding, 
replacing, or deleting text. 

Text box -��7-N�am�e�,��;;;;;;;;;;;;;;;;;;;;;��l Value: '----1 _ ______1.%.1 
Add Variable I ll 1.1 �eel : .......... OK 
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Adding text to a field 

1.  Move the pointer to the part of the field that you 
want to add text to. 

2. Click a mouse button. 

A text insertion cursor appears where you clicked in the text 
box. 

3lo Type the new text. 

Replacing text in a field 

1.  Move the pointer to the beginning or end of the text 
you want to replace. 

2. Hold down a mouse button. 

3. Drag across the text you want to replace or double­
click the word you want to replace. 

The text is highlighted. 

41o Type the new text. 

The text you type replaces the highlighted text. 

Deleting text in a field 

1.  Move the pointer to the beginning or end of the text 
you want to delete. 

2. Drag across the text you want to delete. 

3lo Press Delete. 

Push buttons 

Push buttons are used to tell Looking Glass to carry out an action. 
The OK and Cancel buttons in dialogs are examples of buttons. 
Clicking the OK button tells Looking Glass to process and close a 
dialog. Clicking the Cancel button closes a dialog and causes 
Looking Glass to ignore any changes you've made in the dialog. If a 
button is dimmed (grayed), you cannot use it. 
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I n  most dialogs, there i s  a default button. A default button i s  the 
button that is automatically activated when you press Return unless 
you select another button. The default button is always highlighted 
with a double border. 

Here is an example of a default button in a dialog: 

Remove 2 files? 

Default button -��---------;====�;;;;;;;k=,; Yes 1 1 1 No I I 

Selecting a push button 

Lists 

A sample list 

1. Move the pointer to the push button. 

�" Click it. 

Some windows contain a list of options you can choose from. Some 
lists appear with a text box. The contents of the text box are 
replaced by the option you choose from the list. 

Here is an example of a typical list in Looking Glass: 

Directory: I I 
History: !Yisix/user/hai/Data 

/Yisix/user/hal 

/vi six/user/hal/Budget 

1Yisix/user/hai/Budget/Budget_69 

lvisixfuserlhai/Personnel 

IYisixluserlhaJIPersonneVReviews 

/1/isixluser/haVLetters 

IYisixluser/hallletters/Office_Memos 

lvisixluser/hai/Archive 

Open Directory I cancel I � 
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A list usually has a title that identifies its purpose. For example, sev­
eral Looking Glass dialogs contain lists of directories that have the 
title "History" because they are lists of the directories that you have 
visited most recently. 

Using a l ist 

1. Click the selection you want to choose in the list. 

Your selection is highlighted in the list. 

�0 Click the appropriate button to activate your 
selection. 

Your selection is activated. 

Radio buttons 

Radio buttons 

Radio buttons offer you a group of options. They appear in dialogs 
and on menus. When you turn one on, the others turn off. You can 
only select one radio button from a group at a time. 

Here is an example of a group of radio buttons: 

-

R w X 01 1 0  - -x- -x- - -
0 0 1!!1 OWner 0 set User ID On ExecuUOII 
0 0 1!!1 Group 0 Set Group ID On ExecuUOII 
0 0 0 others 0 Save Text After ExacUUOI 

+ Add 0 Subtlact 0 Replace 

Selecting a radio button 

1.  Move the pointer to the radio button you want to 
select. 

� o Click it. 
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Check boxes 

Check boxes -

Check boxes offer one or more options that can be turned on or off 
(unlike radio buttons, where turning one on turns the others off) . 
When a check box is selected, the option associated with the check 
box is turned on. When the check box is not selected, the option 
associated with the check box is turned off. 

Check boxes can also appear on menus as well as dialogs to indicate 
whether an option is turned on or off. 

--
R W X 01 1 0  - - x- -x- - -

D O  Ill OWner D set User ID On Executl8n 
D O  Ill Group D Sat Group ID On Executl8n 
D D D ot��ers D save Text After ExecutiOI 

• Add <> SUbtract <> Replace 

Selecting a check box 

1. Move the pointer to the check box you w-t to select. 

�. Click it. 

Scroll bars 

Scroll bars allow you to bring hidden information into view. Scroll 
bars appear anywhere that text or graphics are displayed but might 
not fit in the display area, such as text fields and lists. 

Scroll bars contain arrows that you can click on to scroll a line at a 
time in a certain direction. They also contain slider boxes that you 
can click on and move in order to scroll several windows at a time. 
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Arrow 

Scroll bar 

Slider box 

"White" area shows 
you how much more 

there is to scroll 

Here is an example of a scroll bar: 

Directory: I I 

lli!ttnrv: !Yislxluser/hai/Proposals 

/Yislxluser/hai/Budget 

IYislxluser/hai/Budget/BudgeLSO 

IYislxluser/haJ/Letters 

/Yislxluser/hallletters/LegaJ 

IYislxtuser/hai/Dala 

IYisi></user/haJ 

IYislxluser/hai/BudgettBudgeL6S 

IYislxluser/haVPersonnel 

/Yislxluser/hai/PersonneVRevlews 

Olange Directory I Cmcel I [I �-J 

The size of the slider box in the scroll bar shows you how much of 
the available information is currently displayed. For example, if the 
slider box fills half of the scroll bar, one-half of the available infor­
mation is shown. If the entire scroll region is filled by the slider 
box, all of the available information is shown. 

You can use the scroll bar three ways: 

• Scroll line by line 
• Scroll a windowful of information at a time 
• Scroll to a specific location 

Scrol l ing l ine by l ine 

1. Move the pointer to one of the arrows. 

�0 Click the arrow until the information you want is 
displayed. 

The information scrolls one line in the direction of the arrow 
for each click. 

Scrol l ing one window at a time 

1.  Move the pointer to the scroll region above or below 
the slider box. 
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:;G, Click the mouse button. 

The information scrolls up or down one windowful of 
information. 

Scrol l ing to a specific location 

I.  Move the pointer to the slider box. 

The scroll region represents all the information available. The 
slider box in the scroll region shows your relative position in 
the information. 

�' Drag the slider box up or down to the location you 
want to view. 

The information scrolls as you drag the slider box. 

Scale bars 

Scale bars allow you to choose or adjust a value from a range of val­
ues. Scale bars always have an associated text or graphic box that 
shows the currently selected value. 

Here is an example of a scale bar: 

Scale bar --f!-----, 

Hue 
Readout box --11���������������-:::::�

--
shows 

current Saturation 

adjustment 
_

_ JL�������· 
Drag slide 

arrow to 
adjust 

Pick Background Color 

Brightness 

.__can_ce
_

l _.l ll ___ _ ?� _ _lj 
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Choosing or adjusting a value with a scale bar 

n.  Drag the sllde arrow to the left or right until the 
value you want is displayed in the readout box. 

The scale bar reflects the value you chose. 



Getting help 

This chapter introduces you to the Looking Glass help system and tells you how to 
ask for help in Looking Glass by: 

• Using the Help key 
• Using the Help command 

This chapter also gives you a brief tour of the following windows: 

• Help window 
• Index window 
• History window 

You'll learn how to use hypertext links, lists, and control buttons to move through 
the help system. Using these navigation tools, you'll be able to: 

• Walk through entries in a topic 
• Jump to related entries 
• Retrace your steps along the path you've created 
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Entering the help system 

There are two ways to enter the help system: 

• Using the Help key 
• Using the Help command 

Using the Help key 

When you enter the help system by pressing the Help or Fl key, 
you can indicate the topic you want help on by clicking in an area 
of the current dialog or window. 

1. To enter the help system, press the Help or F1 key. 

If  your keyboard doesn't have either of these keys, press: 

• Control+Shift+? 
or 

• Control+Shift+_ 

The pointer becomes a question mark and the areas for which 
help is available are shaded. 

Here is an example of the Find dialog after pressing the Help or F l  
key: 
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2. Put the period of the question mark on the area you 
want help on and dick. 

The help entry for the component you clicked is displayed in a 
Help window. 

Here is a Help window describing one of the components of the 
Find window: 

Section: Ust of items found 

list of items found 

The box at the bottom of the Find dialog contains the 
list of items found . 

.As it finds directories or files that match the name 
pattern you specified, Looking Glass displays them in 
the list. 

You can then select any item from this list and use the 
Show button to have Looking Glass show it in a 
Directory window. 

Index ... [Cirrn] [ cilrn] 1 aos• 

A new Help window is opened each time you use the Help key. 

Once you're in the help system, you can move to other entries 
using the buttons in a Help window or by using the lists in the 
Index window. For more information on how to navigate, refer 
to "Navigating through the help system" later in this chapter. 

3lo Click Close to leave the window. 

Using the Help command 

When you enter the help system using the Help command, a help 
window opens displaying the Introduction to Help topic. 

1.  Choose Help from the Show menu in the Global 
window. 
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A Help window opens, displaying the Introduction to Help topic. 

Once you're in the help system, you can move to other entries 
using the buttons or hypertext links in a Help window or the 
lists in the Index window. For more information on how to 
navigate, refer to "Navigating through the help system" later in 
this chapter. 

� , Click Close to leave the window. 

A brief tour of the help system 

Looking Glass's help system contains descriptions of all its com­
mands and functions. It is designed to help you find information 
for a specific topic quickly, but you can also use it to browse and 
learn about Looking Glass. 

The Looking Glass help system is composed of three types of 
windows: 

• Help windows 
• An Index window 
• A History window 

Help windows 

When you ask for help on a particular topic using the Help key, a 
Help window is displayed. The Help window contains the descrip­
tion and procedures for using the command, field, dialog, button, or 
other object that you asked for help on. 

Help window text contains two unique features that let you navi­
gate quickly to other entries: 

• Hypertext links 
• Indexed keywords 

Hypertext links let you jump to a new topic and are indicated by 
underlined words in the help text. 

Most of the other words in the text are indexed to the Phrases list 
in the Index window. You can double-click one of these other (non­
underlined) words to open the Index window and see the topics 
that contain information about the word. 



Hypertext l ink 

Chapter 3 :  Getting help A 3-5 

Here is a Help window showing help on the File menu in the 
Desktop Panel: 

iieip oii .. taiiie iir ciiiiiiiii\S 

Section: 1 4.1.1 F�e menu ( OesktJJp Panel) I I Hyperpalh I 

I 

File menu 

The File menu in the Desktop Panel lets you control 
the general operation of the Desktop Panel. With this 
menu, you can open, show, and print applications, 
directories, and files. You can also close the Desktop 
Panel. 

The File menu contains the following commands: 

• Close 
• Open 
• Show 
• Print 
• Take Off Desktop Panel 

For information on any of the commands in the File 

Index ... I [cirrn J c �rnJ , Oose I 
You can have several Help windows open on your workspace for 
different entries. 

For information on opening a Help window, refer to "Entering the 
help system" earlier in this chapter. 

The Index window 

Once you've entered the help system by opening a Help window, 
you can click the Index button at the bottom of the window to 
open the Index window. The Index window gives you access to all 
of the topics and subtopics in the help system. It also contains a list 
of keywords and phrases you can choose from if you're not sure of 
the particular subject you want help on. 

When you first open the Index window, the items highlighted in 
the open Index window reflect the entry displayed in the active 
Help window. If you open a new Help window or select another 
topic in the Index window, the Index window selections change to 
reflect the entry in the new Help window. When you close the last 
open Help window, the Index window also closes. 
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Here is an example of the Index window: 

010sen Phrase: 

''''**"'' 
Phrases: 

sort 

splitter 

stack 

status change 

stop 

subtree 

super-user function 

symbols 

system 

terminal emulator 

terminate 

text box 

time 

tree 

tree view 

view 

window 

window size 

window title 

write 

HisiDry ... 

Topics: 

1 Looking Glass 

2 Getting Help 

3 The Global Window 

5 Directory Windows 

6 Tree View window 

7 La outs 

SubiDpics: 

4.1 DeskiDp Panel Overview 
.1 .1 File menu ( Desk tor, Pauel) 

4.1 .1.1 aose command (DeskiDp Pan 
4.1 .1.2 Open command (DeskiDp Pane 
4.1 .1 .3 Show command (DeskiDp Pan 
4.1 .1 .4 Flint command ( DeskiDp Panel 
4.1 .1.5 Take Off DeskiDp Panel comm 
4.1 .2 Vlew menu ( DeskiDp Panel) 
4.1 .2.1 Name and Icon options 
4.1.2.2 Show Full Path Name checkbo 

Related SubiDpics: 

nest on� 

4 . 1 .1 .1 Close command (Des<top Panel) 

4.1 .1 .2 Open command (Des<top Panel) 

4.1 . 1 .3 Show command (Desktop Panel) 

Show Oose 

One of the most important components of this window is the 
Phrases list. Use the Phrases list in the Index window when you 
know the task or object that you want information on but you 
don't know which topic to select. When you select a phrase from 
the Phrases list, the Index window selections change to reflect the 
chosen phrase. 

The Phrases list contains: 

• Looking Glass concepts 
• Operating system concepts 
• Window manager concepts 
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The list contains the names of specific Looking Glass components, 
like: 

• Windows 
• Commands 
• Dialogs 
• Components of windows and dialogs, such as text boxes, list 

boxes, and buttons 

The list also contains common tasks and new features. Select the 
"table of contents" phrase to see the complete list of entries in the 
Topics and Subtopics lists. 

NOTE: 
The Help window text also contains invisible links to all of the key­
words in the Phrases list. You can double-click almost any word in a 
Help window to open the Index window and see which topics con­
tain information about that word. 

If you've changed the topic, subtopic, or chosen phrase in the 
Index window during your search for a particular entry, you can 
change the lists back to reflect the entry displayed in the Help win­
dow by clicking the Restore button. 

There is only one Index window in the help system. If you select 
the Index button again from another Help window, the Index win­
dow moves to the foreground. The Index window selections change 
to reflect the entry in the active Help window. 

The History window 

The History window shows you all of the topics and subtopics that 
you've visited. You can use this window to see where you've been 
or select an entry from the list to open a Help window for that 
topic. 
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Using the Subtopic arrows 

Use the arrow buttons in the Subtopic area at the bottom of the 
Help window to move to the previous or next entry. 

Here is a Help window with the subtopic area identified: 

Section: 1 6.1.1 Directory menu 

Directory menu 

The Directory menu in the Tree View window lets you 
open and close selected directories in the Tree View 
window. 

You can also open selected directories in their own 
Directory windows and close the Tree View window 
from the Directory menu. 

The Directory menu contains the following 
commands: 

"' Open In Tree 
• Close In Tree 
• Show In Tree 
• Open In Window 

Index . . .  Oose 

The entries in the subtopic you're in depend on the word high­
lighted in the Phrases list in the Index window. Therefore, as you 
walk through the entries in the subtopic, you'll skip any entries 
that aren't related to the word in the Phrases list. 

I.  In the Subtopic area at the bottom of the Help window, 
click: 

• The left arrow to move to the previous entry in the subtopic 
or 

• The right arrow to move to the next entry in the subtopic 

�0 Continue clicking until you reach the entry you want 
help on. 

When you reach the end of a topic going in either direction, 
the arrow is dimmed. You must use the Topics list in the Index 
window to switch to a new topic. For information on using the 
Index window, refer to the "Jumping to different subtopics" 
section later in this chapter. 
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Using the History a rrows 

As you move through entries in a Help window, the window keeps 
track of the entries you visit. Use the arrow buttons in the History 
area at the bottom of the Help window to move to the previous or 
next entry in the window's history list. 

Here is a Help window with the History area identified: 

Hiiiii iiii .!able of 
·
canfeii\S 

Section: , 6.1.1 Directory menu I I Hyperpalh I 
Directory menu 

The Directory menu in the Tree View window lets you 
open and close selected directories in the Tree View 
window. 

You can also open selected directories in their own 
Directory windows and close the Tree View window 
from the Directory menu. 

The Directory menu contains the following 
commands: 

• Open In Tree 
• Close In Tree 
• Show In Tree 
* Ogen In Window 

I Index . .. I lffitoein 1 �rnl 1  aose I 
NOTE: 
lf  you move to another entry by any means other than the History 
arrows, all of the forward history disappears, as if you were never 
there. 

1. In the History area at the bottom of the Help window, 
click: 

• The left arrow to restore the last en try 
or 

• The right arrow to return to where you were before you 
clicked the left arrow 

�0 Continue clicking until you reach the entry you want 
help on. 

When you reach the end of the window's history list going in 
either direction, the arrow is dimmed. 
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Jumping to different subtopics 

There are two basic ways to jump to a related entry in the help 
system: 

• Using the Index window 
• Using hypertext links in a Help window 

You can see where you are in the current subtopic by using the 
Section menu at the top of the Help window. You can then select 
another entry in the menu to jump to. You can also see where you 
are in the hyperpath by using the Hyperpath menu at the top of the 
Help window, and then select an entry to jump back to. 

Using the Index window 

You can open the Index window and choose a new entry from the 
Subtopics list to jump to. For information on opening the Index 
window, refer to "A brief tour of the help system" earlier in this 
chapter. 

When you open the Index window, the name of the subtopic that 
is currently displayed in the Help window is highlighted. 
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Here i s  a n  example of a n  Index window: 

01osen Phrase: 
Chosen---��--����������r===� 

Phrase 

Topics: 

Looking Glass 

Getting Help field Phrases: 

sort 

The Global Window 

splitter 5 Directory Windows 

list of ---lt---t-s
::-

ta
:c:

c
cc

k
�=-=-=--

----ll-t------+::6 Tree View win dow 

available status change L7�L!!a:l.!o�uwts,_ ________________ _JW 
topics stop 

subtree 
Subtopics: 

super- user function 

symbols 

system 

terminal emulator 

.1 Deskt011 Pauel Overvle\1/ � 4.1 .1 Rle menu (Desktnp Panel) 4.1 .1 .1 aose command (Desktnp Pan 4.1 . 1 .Z Open command ( Desktnp Pane 4.1 .1 .3 Show command (Desktnp Pan 

5 u bto P ics ----llt---lF.uw.'"""'-------t-+----+.4. 1 .1 .4 Print command ( Desktnp Panel 

of chosen text box 4.1 .1 .5 Take Off Desktnp Panel comm 

topic time 4.1 .2 View menu (Desktnp Panel) 

tree 4.1.2.1 Name and Icon options 

tree view 4.1.2.2 Show Full Path Name checkbo 

view 

window Related Subtopics: 

window size 5.1 .1 .1 0 Put On Desktop Panel comman 

Subtopics ---
8---1-'Wl"'·"nd,_,o::.:w,_t!!!it,le ____ --l.-----+:3.1 .4.1 Desktop Panel option 

related to write 4 .1 .1 File menu (Desktop Panel) 

chosen 
subtopic 

Histnry ... Restore Show aose 

To choose a new subtopic: 

1. Select "table of contents" from the Phrases list. 

The Topics list changes to display all of the topics in the help 
system. 

2. From the Topics list, select the topic that contains the 
subtopics you want to see. 

You can use the scroll bar on the side to move down the list. 

3. From the Subtopics list, select the subtopic that you 
want to see. 

You can use the scroll bar on the side to move down the list. 
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41. Click Show. 

The entry you selected is displayed in the Help window. 

Using the Help window 

In addition to using the Index window for j umping to other 
subtopics, you can use hypertext links in a Help window. 

You can also use the Section menu to j ump to any entry within the 
current subtopic and the Hyperpath menu to return to any entry 
already in your hyperpath. 

Using hypertext links 

Hypertext links appear in a Help window and allow you to j ump to 
a new related entry. Links are like threads that connect two entries 
and are indicated by underlined words in the help text. 

Many other words in the text are indexed to the Phrases list in  the 
Index window. You can double-click one of these other (non-under­
lined) words to open the Index window and see the topics that con­
tain information about the word. 

Here is a typical Help window that contains hypertext links: 

Section: 

Directory menu 

The Directnry menu in the Tree View window lets you 
open and close selected directories in the Tree View 
window. 

· 

You can also open selected directories in their own 
Directory windows and close the Tree View window 
from the Directory menu. 

The Directnry menu contains the following 
commands: 

Underlined phrases --IH­
indicate hypertext 

links 

Index ... [ffiwrn J [ ciJrn J I ao•• 
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11,  I n  the Help window, double-click in the underlined 
phrase that yon want more help on. 

The entry you selected is displayed in the Help window and the 
entry you jumped from becomes part of the hyperpath. 

Using the Section menu 

The Section menu is an option menu that displays the name of the 
help entry currently showing in the Help window. The menu con­
tains the topic above and all of the entries directly below the 
subtopic showing. Entries are dimmed in the Section menu if they 
aren't related to the chosen phrase in the Index window. 

When you click the Section menu, the menu opens and you can 
jump to another entry. 

Here is an example of a Help window with the Section menu open: 

can also open selected directories in their own 
Directory windows and close the Tree View window 
from the Directory menu. 

The Directory menu contains the following 
commands: 

Index ... [ciTm] [ ciJrn] 1 Oose 

1. Click the entry showing in the Section menu. 

The menu opens displaying all of the subtopics above and all of 
the entries below the current entry. 
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�. Select the entry you want help on. 

The entry you selected is displayed in the Help window and the 
entry you jumped from becomes part of the hyperpath. 

Using the Hyperpath menu 

You can see the entries you jumped from by using the Hyperpath 
menu at the top of the Help window. If you use this menu to go 
back to one of the entries you jumped from, all of the entries that 
followed it in the menu disappear from the Hyperpath menu. The 
Hyperpath menu will then reflect any new places you jump from. 
You can use the History arrows to retrace your steps back to the 
hyperpath jumps that disappeared from the menu. 

NOTE: 
If you've only walked through the entries in a subtopic and haven't 
jumped to any entries outside the subtopic, the Hyperpath menu is 
dimmed. 

on - of conten 

SecUon: l s.l .l Dlractory merw I 
Diredory menu 

Hyperpath menu ---•t----'-----------��� 
showm_g help entries 

you've v1sited recently 
The Directory menu in the Tree View window lets you 
open and close selected directories in the Tree View 
window. 

You can also open selected directories in their own 
Directory windows and close the Tree View window 
from the Directory menu. 

The Directory menu contains the following 
commands: 

• Open In Tree 
• CIQS!! ln Tree : Show In Tree 

lndax •••  

1. Click Hyperpath. 

The menu opens, displaying all of the help entries in your 
hyperpath in the order that you jumped from them. The entry 
you visited most recently is displayed at the bottom of the 
menu. 
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�0 Select an entry you want to return to. 

The entry you selected is displayed in the Help window. 

All of the entries below the one you selected in the hyperpath 
are removed from the Hyperpath menu. The menu now con­
tains only the entries that you visited before the one you 
selected. 

Detouring using the History window 

You can detour from walking or jumping through entries by open­
ing a new Help window from the History window. The help system 
History window is similar to other history lists in Looking Glass in 
that it lets you quickly select a help entry that you've visited. The 
most recently visited entry is always at the top of the list. 

When you select a help entry from the History window, a new Help 
window is opened. You can then navigate through the new Help 
window by walking or jumping. 

For information on opening the History window, refer to "A brief 
tour of the help system" earlier in this chapter. 

To open a new Help window from the History window: 

1. Select an entry from the list that you want to return to. 

�0  Click Show. 

A new Help window opens, displaying the entry you selected. 
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In this chapter, we'Ll introduce you to Looking Glass Directory windows and tell you 
how to perform these basic operations: 

• Opening directories in new Directory windows 
• Closing Directory windows 
• Changing the directory displayed in the current Directory window 
• Moving a Directory window to the foreground on your workspace 
• Stacking Directory windows on your workspace 

You'll also learn how to customize the display of directories and files in Directory 
windows by: 

• Setting display formats 
• Choosing whether to show or hide hidden files 
• Adjusting the amount of space used to display the directory and file sections in a 

D irectory window 
• Sorting directories by a category such as name, time the file was last changed, or file 

type 
• Grouping selected directories and files 
• Positioning icons in a Directory window 
• Assigning colors to directory and file icons 
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The new Directory window opens, displaying the contents of 
the directory you double-clicked. 

If you want to change the action associated with double-clicking, 
use the Operational Preferences command in the System menu. For 
more information about the Operational Preferences command, 
refer to "Changing operational preferences" in Chapter 12, 
"Changing Looking Glass preferences." 

Opening Directory windows using the Open command 

The Open command in the File menu of a Directory window is the 
most efficient way to open more than one directory at a time when 
those directories are displayed in the same Directory window. 

1. In a Directory window, select the directories you want 
to open. 

� . Choose Open from the File menu in the Directory 
window. 

A Directory window opens for each directory you selected. 

Opening Directory windows using the Open Directory command 

The Open Directory command in the Windows menu of the Global 
window opens a dialog containing a history list of recently visited 
directories. Use this command to select a directory that is not acces­
sible in the workspace. 

1. Choose Open Directory from the Windows menu in the 
Global window. 
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The Open Directory dialog is displayed: 

Directory: j!usr/haVProposal� 
History: /usrlhaVPersonnel 

/usrlhaVPersonnei/Benefits 

/usr/haVLetters 

/usr/haVLetters/Personal 

/usr/haVDala 

/usr/hallmlsc 

/usr/hai/Budget 

/usr/hal 

Ofll!n Directory 

In this dialog, you specify the directory you want to open in 
the new Directory window. 

2. To specify the directory you want to open: 

• Select a directory from the history list 
or 

• Enter the pathname of a directory in the Directory field (as 
a shortcut, you can leave this field blank to change to your 
home directory) 

3lo Click Open. 

A Directory window opens for the directory you selected. 

Closing Directory windows 

llo  Choose Close from the File menu in the Directory win­
dow yon want to close. 

The Directory window closes. 
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Changing the directory displayed in the current Directory window 

There are two ways to change the directory displayed in a Directory 
window: 

• Double-click a directory 
• Use the Change Directory command 

Changing directories by double-clicking 

JL Control+double-click the icon or name of the direc­
tory you want to display. 

The directory you double-clicked is displayed in the current 
Directory window. 

If you want to display the contents of a directory in a new Directory 
window, refer to "Opening Directory windows" earlier in this chapter. 

If you want to change the action associated with the Change Directory 
command, refer to "Changing operational preferences" in Chapter 12, 
"Changing Looking Glass preferences." 

Changing directories using the Change Directory command 

1. Choose Change Directory from the File menu in a 
Directory window. 

The Change Directory dialog is displayed: 

Dlrectory:fusr/hai/Letter� 
History: /usr/hai/Personnel 

/usr/hai/Personnei/Benefits 

/usrlhat/Letters/Personal 

/usr/hai/Proposats 

/usr/hai/Data 

/usr/haVmisc 

/usr/hai/Budget 

/usr/hal 

Olange Directory cancel 1 [1  _ _  �-��� l j 
In this dialog, you specify the directory you want to change to. 
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2. To specify the directory you want to change to: 

• Select a directory from the history list 
or 

• . Enter the pathname of the new directory in the Directory 
field (as a shortcut, you can leave this field blank to change 
to your home directory) 

£. Click Change. 

The new directory is displayed in the current Directory window. 

Moving Directory windows 

If you have several Directory windows open on your workspace, 
you can use the Windows menu in the Global window to move a 
window from the back of the group to the front. You can also use 
the Windows menu to stack all of the Directory windows neatly on 
the workspace. 

Moving a Directory window to the foreground 

The Windows menu in the Global window lists the names of all the 
directories that are currently open on your workspace. You can 
choose the name of one of these directories to move it in front of 
the other windows. 

n. Choose the name of the directory you want to move to 
the front from the Windows menu in the Global 
window. 

The directory you chose is moved in front of the other windows 
on the workspace. 
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Stacking Directory windows 

At your request, Looking Glass stacks any open Directory windows 
neatly on the left side of the screen. 

ll.  Choose Stack from the Windows menu in the Global 
window. 

Your open Directory windows are neatly stacked on your 
workspace. Here is an example of stacked windows: 

0 0 
Budget_BS Budget_SO 

t::l 1::: 

Changing display formats in Directory windows 

In Directory windows, there are three ways to display directories 
and files: 

• Name view 
• Icon view 
• Wide view 

View by name 

When directories and files are displayed in Name view, a miniature 
icon next to each name indicates whether the object is a directory or 
file. 



Directories 
and files 

displayed in 
Name view 
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n. Choose Name from the View menu in a Directory 
window. 

The directories and files in the current Directory window are 
displayed by name. 

Here is an example of directories and files that are displayed by 
name: 

reiuae:tUsrmar 
Rle o-eate View Sort Select Run COlor 

I; 0 0 Archive ! Budget 0 Data 0 Letters 

Personnel 0 Proposals 0 bin 

Ill Acme_Letter Ill Ad_ Copy Ill Appointments 

I 
Ill Client_List Ill Forecast Ill Phone_List 
Ill Sales_Leads Ill Staffing_plan Ill To_Do 

Ill Zycor_letter 

View by icon 

When directories and files are displayed in Icon view, a full-size 
icon is displayed for each object in a Directory window. The name 
appears below the icon. 

n. Choose Icon from the View menu in a Directory 
window. 

The directories and files in the current Directory window are 
displayed by Icon. 
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Here is an example of directories and files that are displayed by 
icon: 

File create View Sort Select Run Color 

� � 0 0 
Archive Budget 

0 0 0 0 
Data Letters Personnel Proposals 

Directories and files -----11--f:===========:======� 
displayed in Icon � � lfl �w � - -

Acme_LeHer Ad_Copy Appointments 

I � [ii1 
� 

Ctient_List 

m 
Forecast Phone_List Sales_Leads Stafling_Pian 

Wide view 

I 
To_Do Zycor_Letter 

! 

When directories and files are displayed in Wide view, the follow­
ing information can be displayed: 

• Name 
• Access privileges 
• Owner and Group 
• Number of links 
• Size (in bytes) 
• !node number 
• Time and date of last update 
• File type 
• Link content 

A miniature icon next to each name indicates whether the object is 
a directory or file. 

llo Choose Wide from the View menu in a Directory 
window. 

The directories and files are displayed in a wide format that 
gives you information about each directory and file. 



Directories 
and files in 
Wide view 

(links, lnode, 
and Link 

Content not 
shown) 
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Here i s  a n  example of directories and files that are displayed in 
Wide view: 

relude:tusr/haJ 
File O'eate VIew Sort Select Run COlor 

lb- J �J � ��fGfOUPJ�jModification nme I trype 

o . 

" · 
� Archive 
o Budget 
o Data 
o Letlers 

lil Acme_Letter rw-

til Ad_Copy 
Appointments rw-

Client_List 
Ill Forecast 
Ill Phone_Ust 
rlJ Sales_Leads rw-

lil Stamng_Plan rw-

Ill To_Do 

hal dsgrp 
root system 
hal dsgrp 
hal dsgrp 
hal dsgrp 
hal dsgrp 

hal dsgrp 
hal dsgrp 
hal dsgrp 
hal dsgrp 
hal dsgrp 
hal dsgrp 
hal dsgrp 
hal dsgrp 
hal dsgrp 

1 024 15:09 Nov I S  1990 Directory 

� 
512 18:21 Nov 1 3 1990 Directory 
512 1 6:56 Jul 26 1990 Directory 
512 1 1 :50 Nov 1 4  1990 Directory 
5 1 2  21:31 Nov 13 1990 Directory 
512 1 9:03 Nov 1 3 1990 Directory 

339 12:53 Mar 14 1 990 Text me 
4827 1 1 :32 Apr 26 1 990 Text file 

234 13:15 Nov 2 1990 Desktop calendar do 
1 61 7 9  1 1 :37 S e p  25 1 990 Card file 

4648 13:38 Dec 20 1 989 Spreadsheet data file 
3016 1 2:48 Aug 5 1 988 Card tile 

54397 12:58 Feb 28 1990 Database ttata file 
1825 13:01 Jun 28 1 990 Spreadsheet ttala file 

154 1 3 : 1 3  Nov 2 1990 Card me 

You may have to resize a Directory window or adjust the column 
headings to see the information you want in Wide view. 

The following table describes how to adjust the display of informa­
tion in Wide view. 

To: 

Increase or decrease the 
width of a column 

Move a column from one 
position to another 

Remove a category from 
the display 

Eliminate unused space 
between all categories 

Sort by a category 

Do this: 

Drag the edge of the column heading left or 
right 

Drag the column heading to a new position 
on the title line 

Drag the column heading (all except the 
Name column heading) down off the title 
line 

Double-click anywhere in the title line 

Double-click the column heading 
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For information about changing the default views for Looking 
Glass Directory windows, refer to "Specifying the default display 
format for new Directory windows" in Chapter 12, "Changing 
Looking Glass preferences. " 

Choosing whether to show or hide hidden files 

Hidden files are directories and files whose names begin with " . "  
(with the exception of  the current and parent directories). The " . "  
prefix is often used in  naming system configuration files o r  data 
files that users rarely need to view. 

Use the Show Hidden Files check box in the View menu to show or 
hide the hidden files in the active Directory window. If this check 
box is selected, hidden files are displayed; if the check box is not 
selected, hidden files are hidden. 

11. Select or unselect the Show Hidden Files check box in 
the View menu in the Directory window. 

If you selected the check box, hidden files are displayed; if you 
unselected the check box, hidden files are hidden. 

If you want to change whether hidden files are displayed by 
default, refer to "Specifying whether hidden files are displayed in 
Directory windows" in Chapter 12, "Changing Looking Glass 
preferences." 

Setting display formats 

There are two display formats that you can use in Name and Icon 
views: 

• Positionable 
• Non-positionable 

When you select Positionable, the splitter is removed and the 
directories and files are displayed together in the Directory 
window. 

When you select Non-positionable, the Directory window is 
divided into two sections: one for directories and one for files. The 
directories and files are aligned on a permanent grid in each 
section. 
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Changing to Positionable format 

Looking Glass lets you remove the splitter and reposition your 
directories and files anywhere you want. You can use the 
Positionable format in the Name and Icon views. 

I. Select the Positionable check box in the View menu in 
the Directory window. 

The splitter is removed and your directories and files are dis­
played together. 

�0 Drag the directories and files anywhere in the 
Directory window. 

After you have moved directories and files to new positions in 
the Directory window, you can return them to the grid with the 
splitter by selecting Positionable again. 

Changing to Non-positionable format 

If a Directory window is in Positionable format, you can change it to 
Non-positionable format, which divides the window with a splitter. 

lL Select the Positionable check box in the View menu in 
the Directory window. 

The Directory window is displayed with the splitter separating 
the directories and files. 
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Moving the spl itter 

The splitter that divides Directory windows lets you adjust the 
amount of space given to the directory and file sections of the 
window. The splitter is only present in Name, Icon, and Wide views 
when a Directory window is in Non-positionable format. 

0 0 
Data Letters 

Archive Budget 

0 0 
Personnel Proposals 

Drag splitter to adjust --IH==========::::::========:::; 
amount of space in � � E2ll! each section § § � 

Acme_Letter Ad_Copy Appointments 

m � 1 
� 

Client_List 

m 
Forecast Phone_List Sales_Leads Staffing_Pian 

I 
To_Oo Zycor_Letter 

You can change the default position of the splitter in new Directory 
windows with the Display Preferences command in the System 
menu. For information about the Display Preferences command, 
refer to "Changing display preferences" in Chapter 1 2, "Changing 
Looking Glass preferences." 

1. Put the pointer on the splitter in a Directory window. 

�0 Drag the splitter up or down. 

The splitter moves to the new position and the amount of space 
is adjusted. 

Cleaning up repositioned directories and files 

You can align any directories or files that you've repositioned 
according to your cleanup preferences using the Clean Up com­
mands from the Sort menu. For more information about setting 
your cleanup preferences, refer to Chapter 1 2, "Changing Looking 
Glass preferences."  
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You can only use the Clean Up commands i n  Positionable format. 
You can clean up all directories and files in Name or Icon view. You 
can also select specific directories or files to clean up. 

Cleaning up using the Clean Up command 

11 .  Select Clean Up from the Sort menu in the Directory 
window you want to clean up. 

All the directories and files are arranged in neat rows and 
columns on an invisible grid, filling in the Directory window 
from left to right and top to bottom. 

Cleaning up using the Clean Up Selection command 

1. Select the directories or files you want to clean up. 

� . Choose Clean Up Selection from the Sort menu in the 
Directory window you want to clean up. 

The directories and files you selected are moved to the nearest 
available space on the grid-not necessarily filling in the 
Directory window from left to right and top to bottom. 

The directories and files you selected are repositioned according 
to the pattern you specified in your cleanup preferences. 

Sorting directories and files 

In Looking Glass; you can sort directories and files in a Directory 
window according to a specific category and in a particular order. 
You can sort in any view in the Non-positionable format. 

When your directories and files are displayed in Icon or Name view 
in a split Directory window, you can sort by either of the following 
categories in ascending or descending order: 

• File or directory name 
• Icon color 
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When your directories and files are displayed in Wide view, you can 
sort by any of the following categories in ascending or descending 
order: 

• File or directory name 
• Owner name 
• Group name 
• Size 
• Time and date the directory or file was last changed 
• File type 

NOTE: 
You can sort by any category in Wide view by double-clicking on 
the column heading. 

If any of these categories have been removed from the Wide view 
display, you can't sort by that category. 

1. Choose a sorting category from the Sort menu in a 
Directory window. 

The directories and files in the current Directory window are 
sorted and redisplayed. 

NOTE: 
Your current Directory window must contain at least two items 
in addition to your " . "  and " .. " directories in order to sort. 

�0 Choose Ascending or Descending from the Sort menu 
in a Directory window to change the sort order. 

When either Ascending or Descending is selected, they appear 
selected in the menu (a checkmark, a filled-in square, or some 
other mark appears in front of the command in the menu). 

Grouping selected directories and files 

Sometimes it is useful to group all selected directories or files in a 
Directory window. The Group Selected Objects command groups 
any selected directories or files first, then lists the rest of the direc­
tories and files. You can group directories and files in any view in 
the Non-positionable format. 
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1. Select the directories and files you want displayed if 
they are not already selected. 

� " Choose Group Selected Objects from the Sort menu in 
a Directory window. 

The selected directories or files are listed together. 

Assigning colors to directories and files 

If you have a color display, you can assign colors to directories and 
files. When you assign a color to a directory or file, it appears in 
that color in Directory windows and the Desktop Panel until you 
change it. Assigned colors are stored on a per-user basis, so the col­
ors you assign aren't seen by other users. 

1. Select the directory or file to which you want to 
assign a color. 

�" Choose a color from the Color menu in a Directory 
window. 

The selected directory or file is displayed in the color you chose. 

Retyping a directory 

When Looking Glass first visits a directory, it looks at the files and 
directories in it to determine their "type" based on a set of rules 
defined at your site. When Looking Glass visits a directory it has 
already been in, it only examines files that were added since the last 
visit. 

Typing a file correctly is very important because Looking Glass uses 
the type information in several ways, including: 

• To display the correct icon when files are viewed by icon 

• To carry out the correct action when files are activated 

• To determine whether files are "printable" and to print them 
correctly 

• To determine whether a program needs to be run in a terminal 
emulator window 
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There may be occasions when you want Looking Glass to "retype" a 
directory. For example, you would want to retype a directory if new 
file typing rules have been defined in your system, and you think 
that you may have some files in a directory that may be typed more 
effectively based on the new rules. 

1. Open the directory you want to retype in the current 
Directory window. 

� . Choose Retype Directory from the
. 
File menu. 

The directory is retyped. 
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In this chapter, you'll learn how to manage the directories and files in your Directory 
windows. 

You'll learn how to: 

• Create new directories and files 
• Create links for directories and files 
• Find and display directories and files in Directory windows 
• Select directories and files in the active Directory window 
• Group selected directories and files 
• Move files 
• Copy files 
• Remove directories and files 
• Print files 
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Creating directories and files 

Use the Create menu in a Directory window to create directories, 
files, FIFOs, and devices. 

NOTE: 
If the Directory, File, FIFO, and Device commands are dimmed in 
the Create menu, you do not have write permission for the current 
directory. For more information about access permissions, refer to 
Chapter 7, "Accessing information about directories and files. "  

Creating directories 

1. Choose Directory from the Create menu in a Directory 
window. 

The new directory is named Directory! and its name is selected. 
Each new directory you create is consecutively numbered until 
you rename it. 

�0 To rename the new directory, type the new name 
while it is still selected. 

Creating files or F I FOs 

1. Choose File or FIFO from the Create menu in a 
Directory window. 

If you created a new file, the new file is named Filel and its 
name is selected. Each new file you create is consecutively num­
bered until you rename it. 

If you created a new FIFO, the new file is named FIFO! and it is 
selected. Each new FIFO you create is consecutively numbered 
until you rename it. 

:ll o To rename the new file or FIFO, type the new name 
while it is still selected. 

Creating devices 

Creating a device is not an everyday activity for most users. On 
most systems, only the super-user is allowed to create devices. 



Chapter 5: Managing directories and files JA 5-3 

NOTE: 
If you create a device, you must make sure the device driver it refer­
ences is properly installed in the operating system kernel. 

1.  Choose Device from the Create menu in a Directory 
window. 

The Device dialog is displayed: 

+ Block Device 
<> Olaracter Device 

MajOr Device Number: CJ 
Minor Device Number: CJ 

oeate Device I cancel I [I OK _ 1_\  
2. Select the Block or Character button in the Device 

Type section. 

3. Enter the major device number in decimal notation in 
the Major Device field. 

4. Enter the minor device number in decimal notation in 
the Minor Device field. 

S. Click OK. 

The new device is named Device! and its name is selected. Each 
new device you create is consecutively numbered until you 
rename it. 

ciDo To rename the new device, type the new name while it 
is still selected. 

Changing the name of an existing directory or file 

There are two ways to change the name of a directory or file using 
Looking Glass: 

• Edit the name in a Directory window 
• Use the Information command 
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The following section tells you how to change the name of a 
directory or file in a Directory window. To find out how to 
use the Information command to change a directory or file's 
name, refer to Chapter 7, "Accessing information about 
directories and files. "  

1.  Select the name o f  the directory o r  m e  you want 
to change. 

A box appears around the directory or file name and the 
name is highlighted. 

� . Edit the name just as you would any text field. 

Looking Glass allows you to change the name of all 
directories and files in your directory except the " ."  
(current) and " . .  " (parent) directories. 

NOTE: 
If you make a mistake, delete the entire name and press 
Return. The old name is restored. 

Creating links 

A link allows you to access a directory or file from more than 
one location in your file system. 

Links are simply a way of providing access to directories or 
files by giving them additional names (called linked refer­
ences): either the simple directory or file name, the full path­
name, or a relative pathname. You use a different type of link 
depending on how you want to reference that directory or 
file. 

NOTE: 
Another way to quickly access a directory or file is to put it 
on the Desktop Panel. 

Links take up very little disk space-much less than an actual 
copy of a directory or file. Therefore, it's sometimes better to 
create a link rather than make another copy of a directory or 
file. 
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Here are some examples of things you can do using links: 

• Make a directory or file appear in more than one directory 
under the same name 

• Make a directory or file appear in more than one directory 
under different names 

There are two types of links you can create with Looking Glass: 

• Hard 
• Symbolic 

A hard link is simply a new name for an already existing file. Hard 
links cannot be created for directories. 

For hard links, the link names may be in different directories, but 
they must be on the same file system. A file system is a set of direc­
tories and files that can be mounted (connected) or unmounted 
(disconnected). 

Creating a hard link is like copying a file without physically dupli­
cating it. When you make a change to a file through one hard link, 
you'll see the change when you access it through any of its other 
hard links. Hard links can only be created for files. 

For example, let's say you've created a link called /usr / j oe /testl 

to a file called /usr / j oe/testfiles/file l .  If you accessed your 
file by using the link (testl) and made a change to the file, you 
would see the change when you open the original file 
(/usr/ joe/testfiles/ fi lel) .  

Because creating a hard link is like copying a file, you haven't 
removed a file from your system until you've removed all of its 
hard link names. One way to find out how many hard links a file 
has is to use the Information command in the File menu of any 
Directory window. For more information on the Information com­
mand, refer to "Viewing information for one directory or file at a 
time" in Chapter 7, "Accessing information about directories and 
files ."  Another way to find out how many hard links a file has is to 
use the Wide view option in the Directory window of the file under 
the Links column. 

Unlike a hard link, a symbolic link can be made across file systems 
and can reference directories as well as files. When you create a 
symbolic link, a file is created that contains the pathname of an 
actual directory or file. Like a hard link, when you make a change 
to a file through one symbolic link, you'll see the change when you 
access it through any of its other symbolic links or the original 
name. 



5-6 A Looking Glass User's Guide 

A key distinction between hard and symbolic links is that a hard 
link is a reference to a physical file and a symbolic link is a refer­
ence to a directory or file name. 

Because a symbolic link only points to a directory or file name and 
is not an actual file system reference, when you remove the original 
directory or file you also make all of its symbolic links invalid. The 
link is still there, but since it points to nothing, the link will cause 
errors if you try to use it. The symbolic link becomes available again 
if you put a file with the same name in the same location. 
This is different from a hard link, where you have to remove each 
hard link even if you've removed the original directory or file name 
that the hard link refers to. 

There are two types of symbolic links: 

• Absolute 
• Relative 

An absolute symbolic link is a full pathname that leads to the origi­
nal directory or file. Because it explicitly refers to each directory in 
the pathname, you would create an absolute symbolic link if you 
intend to keep the original directory or file in the same location in 
the directory structure. However, you are able to move the linked 
reference because its location doesn't determine the reference. If 
you remove, move, or change the name of the original directory or 
file, you won't be able to access that directory or file because the 
pathname is invalid. 

A relative symbolic link is a relative pathname that leads to the orig­
inal directory or file. The location of the linked reference is used to 
determine the location of the original directory or file, so one can't 
move relative to the other without making the link invalid. Relative 
symbolic links allow you to move the portion of the directory struc­
ture containing the original directory or file and the linked refer­
ence within the file system. 

For more information about the types of links supported by your 
system, refer to your system documentation. 
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Creating a hard l ink 

1.  Select the files that you want to create a link for. 

2. Choose Link from the File menu in the Directory 
window. 

The Link dialog is displayed: 

W*Th:l�;;;===================�' 
History: /usr/hai/Dala 

/usr/halllg 

/usr/h.Vmisc 

/usr/hai/Personnei/Litlgation 

/usrlhai/Personnel 

/usr/hai/Personnei/Handbook. 

/usr 

/usr/hal 

W* Type: + Hard <> Relative SymboUc <> - SymboUc 

Hard l ink button ----11--:====:l-----------:===:-;;;;;;;;;;:;;;-1 cance1 I [� Link Files to Dlractory 

3. To specify where the linked reference will appear and 
what it will be named: 

• Select the directory that you want the linked reference to 
appear in from the history list 
or 

• In the Link To field, enter the full or relative pathname of 
the directory you want the link to appear in or the full or 
relative pathname of the link 
or 

• Press Return to create the link in your home directory 

If you selected several files, you can only specify a directory 
path (not a filename) . 

4. Select Hard to create a hard link. 

If you try to create a hard link with the same name as a file that 
currently exists in the directory you want to put the hard link 
in, a message box is displayed asking if you want to overwrite 
the existing file. 

ti>o  Click Link. 
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The link is created in the directory you chose. If you are 
creating links for several files at one time, a status dialog is 
displayed. 

If a status dialog is displayed, you can cancel the unfinished 
part of the operation by clicking Cancel in the status dialog. 

Creating a symbolic link 

If the Relative Symbolic and Absolute Symbolic buttons do not app­
pear in the Link dialog, your system does not support symbolic 
links. 

1.  Select the directories or files that you want to create a 
link for. 

2. Choose Link from the File menu in the Directory 
window. 

The Link dialog is displayed: 

�w:l�========================�l 
History: /us r  

I 

lusr/havData 

tusr/hat/Personnel 

tusr/hai/Personnei/Benefll1 

lusr/halll.ellers 

/usr/halll.eHersiPersonat 

lusr/hat/Proposats 

Unk Type: 0 Hard +  Relative Symbolic 0 Abs- SymboUc 

� FDes to Dlnlctory I cance• I t--�� ... . J 

3. To specify where the linked reference will appear: 

• Select the directory that you want the linked reference to 
appear in from the history list 
or 

• In the Link To field, enter the full or relative pathname of 
the directory you want the link to appear in or the full or 
relative pathname of the file that the link references 
or 

• Press Return to create the link in your home directory 
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If you selected several files or one or more directories, you can 
only specify a directory path (not a filename) . 

4. Select the appropriate button for the type of link you 
want to create: 

• If you entered a relative pathname, select Relative Symbolic 
to create a relative symbolic link 
or 

• If you entered a full pathname, select Absolute Symbolic to 
create an absolute symbolic link 

If you try to create a symbolic link with the same name as a file 
that currently exists in the directory you want to put the sym­
bolic link in, a message box is displayed asking if you want to 
overwrite the existing file. 

ti>o Click Unk. 

The link is created in the directory you chose. 

If you are creating links for several directories or files at one 
time, a status dialog is displayed. 

If a status dialog is displayed, you can cancel the unfinished 
part of the operation by clicking Cancel in the status dialog 
box. 

You can set the access permissions for symbolic links, but not 
for hard links. For information about setting access permissions, 
refer to "Changing access permissions" in Chapter 7, "Accessing 
information about directories and files. " 

Anding directories and files 

Use the Find command to_ search your file system for a specific 
directory or file. The Find command is available from three menus 
in Looking Glass: 

• The Show menu in the Global window 
• The Select menu in a Directory window 
• The Show menu in the Tree View window 
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In the Find dialog, you specify a name or a pattern (using special 
characters) that you want Looking Glass to search for. Looking 
Glass lists the directories and files that it finds. You can then use 
the Show button in the Find dialog to display them. 

To learn how to select directories or files that you already know the 
location of, refer to "Selecting directories and files" in this chapter. 

Finding all names that match a pattern 

1. Choose Find from: 

• The Show menu in the Global window 
or 

• The Select menu in a Directory window 
or 

• The Show menu in the Tree View window 

The Find dialog is displayed: 

II Files II Symbolic Unl<s II Sockets 
II Directories II Devices II FIFOs 

Sean:h Within: lr,:'":.:"::..:lh:.::ai:...._ _____________ ..J 
II Sean:h Subdirectories 

0 Sean:h Tree View Selections 

Show Sh>JI I I <:ontinu" i ll Find i l l aose 

In this dialog, you specify a name or pattern to match the direc­
tories or files you want to find. 
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The following table describes the special characters you can use 
to specify a directory or file: 

Use this 
character: To specify a pattern that Includes: 

? A single, variable character 

For example, memo? finds all names that begin with memo 
followed by exactly one character (like memol or memoX, 
but not memo, memol O, or memoXY). 

[ ] One character from a set of characters 

For example, Wor[dkm] finds names that begin with Wor 
and end in d, k, or m (Word, Work, Worm). 

* Zero or more variable characters 

For example, •.c finds any names with the .c extension 
(Paper.c, PROG.c, Classworkprog.c). 

You cannot prefix a pattern with the ? or the * character to 
match names that begin with a " . "  (dot). 

2. In the Name Pattern field, enter the name of the direc­
tories or files you want to find or a pattern that will 
match the names you want. 

3. Select the check boxes for the items (directories, files, 
devices, FIFOs, etc.) that you want to find. 

4. Verify the path in the Search Within field. 

If you need to change the path, edit it. 

When you choose the Find command from the Global window, 
this field defaults to the root directory (/). 

When you choose Find from a Directory window, this field 
defaults to the pathname of the directory displayed in the cur­
rently active Directory window. 
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When you choose the Find command from the Tree View win­
dow, you can either type a name in this field or leave it blank 
and select a directory in the Tree View window. 

s. Select: 

• Search Subdirectories to have Looking Glass search all 
subdirectories of the path in the Search Within field. If you 
unselect this check box, Looking Glass will search only the 
specified directory. 

• Search Tree View Selections to have Looking Glass search 
directories selected in the Tree View window. If you select 
this check box with no directories selected in the Tree View 
window, the Tree View window moves to the foreground so 
you can select the directories that you want Looking Glass 
to search. 

6. CUck Find. 

Looking Glass begins searching your file system. The subdirec­
tories it's searching are displayed in the Searching field. 

At this point, you can wait for the operation to finish, or you 
can continue your work in another window. When the search is 
complete, Looking Glass beeps. 

'1/. CUck: 

• Stop to stop the find operation. 

• Continue to continue a find operation after you have 
stopped it. 

• Find to restart a find operation from the beginning after 
you have stopped it. When you restart a find operation, the 
directories and files that were found are removed from the 
list. 

• Close to quit the find operation after you have stopped it. 

Displaying a directory or file located with the Find command 

To view directories and files displayed in the list below the 
Searching field: 

• Double-click the name of a directory or file you want to display 

• Select the name of the directory or file you want, then click 
Show 
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A Directory window is displayed (or brought to the foreground) 
with the selected directory or file highlighted. 

Selecting directories and files 

If you know that the directory or file you're looking for is in the 
active Directory window, you can find and highlight it using the 
Select menu. 

With this menu, you can select all the directories or files in the 
active Directory window or you can select directories and files in 
the active Directory window that match a name or pattern (using 
special characters). 

Selecting names in a Directory window that match a name or pattern 

1. Choose Select By Pattern from the Select menu in a 
Directory window. 

The Select By Pattern dialog is displayed: 

�m:l�==============�l 

--1 I 
[ ���-.-_t_

t
_
l
--

u
-

�

=-selac-:-
=
-:tlon::--
�-::]
_..... 

S81ac
t By Pattam C8ncel I l l _ OK- _j 

In this dialog, you specify a name or pattern to match the direc­
tories or files you want to select. 
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Use this 
character: To specify a pattern that Includes: 

? A single, variable character 

For example, memo? finds all names that begin with memo 
followed by exactly one character (like memol or memoX, 
but not memo, memo1 0, or memoXY). 

[ ] One character from a set of characters 

For example, Wor[dkm] finds names that begin with Wor 
and end in d, k, or m (Word, Work, Worm). 

* Zero or more variable characters 

For example, •.c finds any names with the .c extension 
(Paper.c, PROG.c,. Classworkprog.c). 

You cannot prefix a pattern with the ? or the • character to 
match names that begin with a " . "  (dot) . 

2. In the Pattern field, enter the name of the directory or 
file you want to select or a pattern for the names you 
want to select. 

Pattam: l•.!!iJ 

_,,1 I 
� �-'=-1 

t 
t -� =c� 

Select By Pattam cancel l [ oK II 
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3 .  In the Action section, choose: 

• Select to select the objects that match the pattern you 
specified 
or 

• Unselect to unselect the objects that match the pattern 
you specified 

If you want to unselect a group of directories and files, make 
sure the Unselect button is selected. 

4. In the Selection section, make sure the check boxes for 
the objects you want are selected: 

• Select Files to select files that match the pattern 

• Select Directories to select directories that match the 
pattern 

• Select both check boxes to select directories and files that 
match the pattern 

�. Click OK. 

Any directories and files that match the pattern are selected or 
unselected in the current Directory window. 

NOTE: 
If any directories or files are already selected, they remain 
selected when you use the Select By Pattern command. 

Selecting all fi les or all directories in a Directory window 

n. Choose Select All Files or Select All Directories from 
the Select menu in a Directory window. 

All files or all directories are selected in the current Directory 
window. 

Grouping selected directories and files 

Sometimes it is useful to group all selected directories or files in a 
Directory window. The Group Selected Objects command groups 
any selected directories or files first, then lists the rest of the direc­
tories and files. This command is only available when the Directory 
window contains the splitter (in other words, when Positionable is 
not selected in the View menu). 
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Selected directories 
and files are brou9 ht 

to the top of lists 

1. If the directories and files you want displayed first are 
not already selected, select them. 

�' Choose Group Selected Objects from the Sort menu in 
the Directory window. 

The selected directories or files are listed together. 

Data 

I 
Mii!Mii§l 

Ill 
Dlllllll 

0 
Personnel 

� l_§j 
Ad_ Copy 

� rnru 
Client_List Phone_List Sales_Leads 

Moving and copying files 

In Looking Glass, you can move and copy files by using mouse 
actions or the Move and Copy commands from the File menu. 

Moving files 

There are two ways to move a file from one directory to another: 

• Drag the file to its new location 
• Use the Move command 
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Moving files by dragging 

If the directory you want to move a file into is displayed on your 
workspace, you can drag the file to its new location. 

1- Select the files you want to move. 

�. Drag the selected files to: 

• The file section of a Directory window 
or 

• The name or icon of a directory in a Directory window or 
the Desktop Panel 

If you move large files or several files at one time, a status 
dialog displays the progress of the move operation. 

If a status dialog is displayed, you can cancel the unfinished 
part of the move operation by clicking Cancel in the dialog. 

Moving files with the Move command 

1.  Select the files you want to move. 

2. Choose Move from the File menu in the Directory 
window. 

The Move dialog is displayed: 

Move To: I:==============;;;' 
History: /visix/user/havmisc 

/vls ix/user/hai/Proposals 

/vislx/user/hal/Budget 

/Yis ixluser/hal/Budgei/BudgeL90 

/Yislx/user/hallleners 

/Y is ixluser/hallleUersllegal 

/Y is ix/user/havoata 

/Yislx/user/hal 

/v is ixluser/hal/Budgei/Budget_89 

/Yisixluser/haVPersonnel 

Move FUes to Directory C8ncel I [L_-_ _J 
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3. To specify the directory you want to move files to: 

• Select a directory from the history list 
or 

• In the Move To field, enter a new filename or the path­
name of a directory 
or 

• Press Return to move the files to your home directory 

41. CHck Move. 

If you move large files or several files at one time, a status 
dialog displays the progress of the move operation. 

If a status dialog is displayed, you can cancel the unfinished 
part of the move operation by clicking Cancel in the dialog. 

Copying files 

There are two ways to copy files in Looking Glass: 

• Drag them 
• Use the Copy command 

Copying files by dragging 

If the directory you want to copy a file into is displayed on your 
workspace, you can drag the file to the new location to put a copy 
of it there. 

1. Select the files you want to copy. 

2. Bold down the Control key. 

33. Drag the files to: 

• The file section of a Directory window 
or 

• The name or icon of a directory in a Directory window or 
the Desktop Panel 

If you copy large files or several files at one time, a status dialog 
displays the progress of the copy operation. 

If a status dialog is displayed, you can cancel the unfinished 
part of the copy operation by clicking Cancel in the dialog. 
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Copying fi les with the Copy command 

1. Select the files you want to copy. 

2. Choose Copy from the File meuu iu the Directory 
wiudow. 

The Copy dialog is displayed: 

� Th:l�======================�l 
History: /vlslx/user/hal/mlsc 

/vislx/user/hai/Proposals 

/Yislx/user/hai/Budget 

/Yislx/user/hai/Budgei/Budget_so 

IYislx/user/hallletters 

/Yislx/userlhalllettersllegal 

/Yislx/userlhai/Data 

/Yislx/user/hal 

IYislx/user/hai/Budgei/Budget_89 

IYislx/user/hai/Personnel 

Copy Flies to lllrBctory Cllncal I [ __ � I I 
In this dialog, you specify the directory or file that you want to 
copy to. 

3. To specify the directory or file you want to copy to: 

• Select a directory from the history list 
or 

• In the Copy To field, enter a new filename or the path­
name of a directory 
or 

• Press Return to copy the selected directories and files to 
your home directory 

41o Click Copy. 

If you copy large files or several files at one time, a status dialog 
displays the progress of the copy operation. 

If a status dialog is displayed, you can cancel the unfinished 
part of the copy operation by clicking Cancel in the dialog. 
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Removing directories and files 

In Looking Glass, you can delete directories and files from your sys­
tem with the Remove command from the File menu. 

WARNING: 
When you remove a file, it is deleted permanently. When you 
remove a directory, the directory and all of the files and subdirecto­
ries it contains are deleted permanently. 

If you accidentally remove something, see your system administra­
tor-it may be recoverable from a backup. 

1. Select the directories and files you want to remove. 

2. Choose Remove from the File menu in the Directory 
window. 

One or more confirmation dialogs may be displayed. 

If you select directories and files, Looking Glass displays a dia­
log asking you if you really want to remove both directories and 
files. Other dialogs may be displayed, depending on the level of 
confirmation selected in your removal preferences. For more 
information about setting removal preferences, refer to "Setting 
removal preferences" in Chapter 12, "Changing Looking Glass 
preferences." 

3l. In a confirmation dialog, click: 

• Yes to confirm the removal 
or 

• No to cancel the removal 

If you remove large directories and files or several directories 
and files at one time, a status dialog displays the progress of the 
remove operation. 

If a status dialog is displayed, you can cancel the unfinished 
part of the remove operation by clicking Cancel in the dialog. 
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2. Choose Information from the File menu in the 
Directory window. 

An Information dialog is displayed for each selected directory 
and file. 

3. Select Access. 

The execution options are displayed with the access 
information: 

Type: Database data file 

Size: 54397 Unks: 1 lnode: 71731 

+ Access 0 Ownership 0 Daws 

Execution options ----tlf---=R--::cw:-:-:x-------, 0644 rw-r--r--
1!11 1!11 0 owner 

Ill D D Group 

Ill 0 0 Others 

Ale lnfonnation 

4. Select: 

0 Set User 10 On Execution 

0 Set Group 10 On Execution 

0 Save Text Afwr Execution 

1 [1 I I  cancel 
.:. . . • _ 

o 
K 

• Set User ID On Execution if you want other users to be 
able to execute the file with the owner's access permissions 
or 

• Set Group ID On Execution if  you want other users to be 
able to execute the file with the access permissions of the 
owner's group 
or 

• Save Text After Execution if you want the file's executable 
text image saved to the swap area on the disk after 
execution 

S>. Click OK. 

If  you selected more than one directory or file, repeat steps 3 
through 5 until no more dialogs are displayed. 
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The Link Protection button is selected by default. Select the 
Reference Protection button if you want to view access informa­
tion for the actual directory or file (the directory or file the link 
references). 

4. Select: 

• R (read) to allow the Owner, Group, or Other.s to view the 
contents of the directory or file 
or 

• W (write) to allow the Owner, Group, or Others to change 
the contents of a file, or to put files in or remove files from 
a directory 
or 

• X (execute) to allow the Owner, Group, or Others to run a 
file as a command or open a directory 

f5, " Click OK. 

If you selected more than one directory or file, repeat steps 3 
through 5 until no more dialogs are displayed. 

Changing execution options 

In addition to viewing the access permissions for a directory or file, 
you can also view and change execution options. These options 
include: 

• The Set User ID On Execution and Set Group ID On Execution 
options, which allow other users to execute a program with the 
access permissions of the program's owner or group. These per­
missions should be used with extreme care because they may 
give other users control over your files. 

• The Save Text After Execution option, which causes an exe­
cutable binary file's text image to be saved to the swap area on 
the disk to speed loading for future invocations of the program. 
This attribute (sometimes referred to as the "sticky bit") has dif­
ferent roles depending on the system you are using. 

While these options may only seem meaningful for executable files, 
they can also affect directories on some systems. 

1. In a Directory window, select the directories and rues 
for which you want to change the execution options. 
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WARNING: 
You should only assign execute permission for files that can be used as com­
mands. If you assign execute permission for an ordinary file, there is always 
the chance that someone will try to "nm " it as a command. Because the file 
is "executable, " the shell will interpret its contents as commands. 

1. In a Directory window, select the directories and files 
for which you want to change access permissions. 

2. Choose Information from the File menu in the 
Directory window. 

An Information dialog is displayed for each selected directory 
and file. 

3. Select Access. 

The access information appears on the left in the third section 
as follows: 

Name: !sales Leads � 11m 
Type: Database data file 

Size: 54397 Unl<s: l lnode: 71731 

+ Access (> ownership (> Dates 

R W X 

Il l]  0 Owner 

Access information -----B--- Ill 0 0 Group 

Ill 0 0 Others 

File lnfonnation 

0644 rw-r--r--

0 Set User I D On Execution 

0 Set Group I D On Execution 

0 Save Text After Execution 

cancel I [I O K l i 
If  the directory or  file is  a symbolic link, two buttons are dis­
played below the access information: the Link Protection but­
ton and the Reference Protection button. These buttons let you 
choose whether to view and set the protection for the link or 
for the directory or file it references. For more information 
about links, refer to "Creating links for directories and files" in 
Chapter 5, "Managing directories and files." 
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3. Edit the Name field. 

41. Click OK. 

If you selected more than one directory or file, repeat steps 3 
and 4 until no more dialogs are displayed. 

Changing access permissions 

The access permissions of a directory or file determine who can 
read, write, or execute it. 

You may want to change access permissions for a directory or file: 

• To prevent it from being accidentally or maliciously removed 
• To keep it private 
• To share it with other users 

You can change access permissions for any directory or file you 
own. You can assign access permissions to the owner, the members 
of a group, and others (other users who aren't in your group). 

The following table summarizes the access permissions you can 
assign to directories and files: 

If you assign this For a directory, For a file, 
permission: specified users can: specified users can: 

R (read) View its contents View its contents 

W (write) Put directories or files in it Change its contents 

Remove directories or files 
from it 

X (execute) Search the directory Run it as a command 
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The fourth section contains the OK and Cancel buttons for the 
dialog. 

3. Click the appropriate button in the second section to 
view a different category of information in the third 
section of the dialog. 

4!. Click OK when you're finished viewing the 
information. 

The following paragraphs tell you how to change information dis­
played in the Information dialog. 

Changing information for one directory or file at a time 

This section provides instructions for changing information for one 
directory or file at a time using the Information command. You can 
change the following information: 

• Name of the directory or file 
• Access permissions (also called protection mode) 
• Ownership and group reference 
• Date and time the directory or file was last accessed or changed 
• Link information (symbolic links only) 
• Reference protection (symbolic links only) 
• Device type (devices only) 
• Major and minor device numbers (devices only) 

Changing the directory or file name 

You can use the Information dialog to change the names of directo­
ries and files. 

NOTE: 
You can also change the names of directories and files by selecting 
the name in a Directory window. When the name is selected, edit 
the name. 

1.  Select the directories and files whose names you want 
to change. 

2. Choose Information from the File menu in the 
Directory window. 

An Information dialog is displayed for each selected directory 
and file. 
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1. In a Directory window, select the directories and files 
for which you want to view information. 

2. Choose Information from the File menu in the 
Directory window. 

An Information dialog is displayed for each selected directory 
and file. 

Here is an example of an Information dialog: 

lnfonnation For Sales leads 

Name: !sates Leads 
Type: Datallase data file 

Size: 54397 Unks: l lnode: 71731 

These buttons . . . ----11---- + Access 0 Ownership 0 Dates 

R W X 

I!Jm I!Jm 0 Owner 

control this ----11-- l!!m D D Group 
information I!Jm D D Olhers 

Ale lnfonnation 

NOTE: 

0644 rw-r--r--

0 Set User ID on Execution 

0 Set Group 10 On Execution 
0 Save Text After Execution 

cancel I ll mm ��m •• JI 

Device type and device number are only displayed in the 
Information dialog if the file is a device. 

Notice that the dialog is divided into four sections. The first 
and third sections contain information about the selected direc­
tory or file. The second section contains a group of radio but­
tons that control the category of information shown in the 
third section: 

• The Access button displays access permissions (this is the 
default) 

• The Ownership button displays the owner and group 
reference 

• The Dates button displays the status change, access, and 
modification dates 

• If you're viewing a device file, the Device button displays 
information about devices 
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Accessing infonnation for one directory or file at a time 

You can use the Information command in a Directory window to 
open a dialog that contains information about any selected direc­
tory or file. 

With the Information dialog, you can view the following informa­
tion about a single directory or file: 

• Name 
• Type 
• Size (in bytes) 
• Number of links to the directory or file 
• !node number (a number used by the operating system to iden-

tify the file) 
• Access permissions (also called protection mode) 
• Ownership and group reference 
• Date and time the directory or file was created 
• Date and time the status of the directory or file was changed 
• Date and time the directory or file was last accessed or changed 
• Link information (symbolic links only) 
• Reference protection (symbolic links only) 
• Device type (devices only) 

. • Major and minor device numbers (devices only) 

You can also change the following using the Information dialog: 

• Name 
• Access permissions (also called protection mode) 
• Ownership and group reference 
• Date and time the directory or file was last accessed or changed 
• Link information (symbolic links only) 
• Reference protection (symbolic links only) 
• Device type (devices only) 
• Major and minor device numbers (devices only) 

Viewing information for one directory or fi le at a time 

Use the Information command to view information about selected 
directories and files in a Directory window. This section explains 
how to access the dialog and how to use it to view information. 



Accessing lnfonnatlon about 
directories and files 

In Chapter 4, "Working with Directory windows, " you learned how to display very 
detailed information about directories and rues in a Directory window using the 
Wide option from the View menu. You learned that you can change the name of a 
directory or me displayed in a Directory window. 

7 

In this chapter, you'll learn how to view and change other information about a sin­
gle directory or me or a group of directories or rues. 

You'll learn how to use the Information command to view and change information 
one directory or me at a time. If you select a group of directories and files at one 
time, an Information dialog is displayed for each directory and me. 

You'll learn how to use the Change Properties command to change information for a 
group of directories and files in one operation. One Change Properties dialog is dis­
played for all selected directories and files. 
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The Merge In Saved Tree dialog is displayed containing the 
names of previously saved layout files: 

l laZ -I 
0 .. 
1!1 lgZ_tree 

Open Tree I Cllncal I ll Open I I 
2. Use the option menu and the list to find the name of 

the layout you want to open, then select it. 

33. Click Open. 

The layout you chose opens in the Tree View window. The new 
layout is merged with any layout already in the Tree View 
window. 

You can now save this combined layout under a new name. For 
information about saving layouts in Tree View, refer to the "Saving 
Trees" section earlier in this chapter. 

Closing the Tree View window 

Use the Close Tree View command from the Directory menu to 
close the Tree View window. 

n. Choose Close Tree View from the Directory menu in 
the Tree View window. 

The Tree View window closes. 

When you close the Tree View window, Looking Glass saves the 
layout in the file lg_current_tree . The next time you open the 
Tree View window, that layout is displayed. 
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Opening existing Trees 

You can open layouts that you've saved using the Save Tree As 
command. 

1. Choose Open Saved Tree from the Tree menu in the 
Tree View window. 

The Open Saved Tree dialog is displayed containing the names 
of layout files: 

l 1az trees/ I 
0 .. 
Ill lg2_1ree 

Open Tree cancel I [I Open mi l 
2. Use the option menu and the list to find the name of 

the layout you want to open, then select it. 

33o Click Open. 

The layout you chose opens in the Tree View window. The new 
layout replaces any open layout. 

Merging Trees 

With the Merge In Saved Tree command, you can open two or 
more existing layouts in the Tree View window and save the new, 
merged layout. 

I.  Choose Merge In Saved Tree from the Tree menu in the 
Tree View window. 
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The Save Tree As dialog is displayed asking you to name your 
layout: 

I IQZ treesd 

f:! .. 
I J;,::.Jro:-e 

Save Tree 

,, .. I 
Save I cancel I �- Save II 

3. To name the Tree View layout: 

• Type the full or relative pathname for the layout. 
or 

• Use the option menu and the list to select the directory you 
want to save the layout in, then enter the name of the 
layout. 
or 

• In the Save Tree field, enter the full or relative pathname of 
the directory in which you want to save the Tree View, fol­
lowed by a slash (!) .  Press Tab or Return to view the con­
tents of that directory. Then type the name of the layout in 
the Save Tree field . 

.(!. Click Save. 

When you save a Tree View, Looking Glass saves everything in the 
layout, including which directories are open in the Tree View win­
dow, whether the Sorted check box is selected, which directories are 
visible in the window, and the directories that are selected. 
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Finding directories and files in Tree View 

Use the Find command to search specific directories for subdirecto­
ries or files. 

In the Find dialog, you specify a name or a pattern (using special 
characters) that you want Looking Glass to search for in Tree View. 
Looking Glass lists the directories and files that it finds. You can 
then use the Show button in the Find dialog to display them. 

To learn how to select directories that you already know the loca­
tion of in Tree View, refer to "Selecting directories" earlier in this 
chapter. 

When you use the Find command in Tree View, Looking Glass only 
searches directories selected in the Tree View window. If you don't 
select any directories in the Tree View window, Looking Glass won't 
perform the search. 

For a description of the Find command and procedures for using it, 
refer to "Finding directories and files" in Chapter 5, "Managing 
directories and files. "  

Storing Tree layouts 

You can name and save any layout in the Tree View window. This 
makes it easy to open a specific group of directories that you have 
already opened in Tree View. With Tree View, you can: 

• Save layouts 
• Open an existing layout 
• Merge layouts 

Saving Trees 

You can save and name new Tree View layouts for future use. 

1.  Open the directories that you want to save as part of 
your layout. 

2. Choose Save Tree As from the Tree menu in the Tree 
View window. 
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displayed with only directory names. Any selected directories 
that were closed previously are opened in the panel with full 
pathnames in their title bars. 

Organizing Tree View 

When you open subdirectories in the Tree View window, the subdi­
rectories are displayed underneath their parent directories. 
Subdirectories are arranged from left to right in the order in which 
they were opened, with the most recently opened subdirectory dis­
played on the far left. 

Using the Sorted check box 

Use the Sorted check box to rearrange all open subdirectories alpha­
betically underneath their parent directories in the Tree View win­
dow. When the Sorted check box is selected, all subdirectories you 
open in the future will be displayed underneath their parent direc­
tories in alphabetical order. 

lL Choose Sorted from the View menu in the Tree View 
window. 

The subdirectories are arranged alphabetically, from left to 
right, underneath their parent directory. 

Here is a Tree View window before and after sorting: 

Alsntlal I 
I:I ArChiYI ,;;, -
ei Budgll O bln 
e oa1a O dsh 
0 1cons 0 1g 
eli Lel!:arl O misc 
0 Personnel 

1-1�]1!1 ...... ! 
O Archlve O Legal Ell eudgat,_89 
1:1 �c_Summary �� omca_Msmos e Budgauro 

O Personal 

Before sorting 

I .....,.. 
O Archlve - -
e eudget o bln 
e oata o dsh 
0 1ccns 0 1g 
eli Lettan O mlsc 
0 Personnel 

After sorting 
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Any selected directories that were closed previously are opened 
in the panel in the view you chose. 

NOTE: 
A shortcut for switching views on a directory panel is to 
Shift+double-click the folder icon or the title bar of the direc­
tory that you want to change the view for. The directory panel 
changes to the other view. 

Here is an example of a Tree View window with one directory 
panel displayed in each view: 

s 
Budget_89 

Icon view ----a++---

s 
Budget_ SO 

Changing the way names are displayed in title bars 

Use the Full Pathname check box to choose whether to show the 
directory name or the full pathname in directory panel title bars. 

I.  Select: 

• The icons or names of subdirectories on directory panels 
or 

• The title bars of directory panels 

�. Choose Full Pathname from the View menu. 

Any selected directories whose title bars contained only direc­
tory names are displayed with full pathnames. Any selected 
directories whose title bars contained full pathnames are 
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In this dialog, you specify the directory that you want to open a 
Directory window for. 

2. To specify the directory you want to open a Directory 
window for: 

• Select a directory from the history list 
or 

• Enter the pathname of a directory in the Directory field 
or 

• Press Return to open your home directory 

:L Click Open. 

A Directory window opens, displaying the contents of the direc­
tory you selected. 

Changing the display format of directory panels 

You can view the subdirectories on a directory panel by name or by 
icon. A directory panel is displayed by name the first time it is 
opened. 

In addition, you can display either the directory name or the full 
pathname in individual directory panel title bars. By default, only 
the directory name is shown in the title bar the first time a direc­
tory is opened. 

Changing the view of directory panels 

1.  Select: 

• The icons or names of subdirectories on directory panels 
or 

• The title bars of directory panels 

:�Go Choose: 

• Name from the View menu in the Tree View window 
or 

• Icon from the View menu in the Tree View window 

The selected directories are displayed in Name or Icon view. 
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Opening Directory windows from Tree View 

In addition to opening directory panels that display the contents of 
directories, you can also open Directory windows. 

You can select directories in Tree View and then use the Open In 
Window command to open Directory windows for them. Or, you 
can open the Open Directory dialog by choosing this command 
without selecting any directories. Use this dialog to specify the 
name of the directory you want to open in a Directory window. 

NOTE: 
A shortcut for opening a Directory window from Tree View is to 
Control+double-click the folder icon of the directory that you want 
to open a Directory window for. 

To open Directory windows for selected directories: 

1. Select: 

• The icons or names of subdirectories on directory panels 
or 

• The title bars of directory panels 

�" Choose Open In Window from the Directory menu. 

Directory windows open for the directories you selected. 

To open a Directory window using the Open Directory dialog: 

1.  Choose Open In Window from the Directory menu. 

The Open Directory dialog is displayed: 

D�Wy:�l ;;
====================�l 

HisWy: /usr/halllg 

/usr/hai/Data 

/usr/hal/mlsc 

/usr/haJ/Personnei/LHigation 

/usr/hai/Personnel 

/us r/haJ/PersonneVHandbook 

/usr 

/usr/hal 

/usr/hai/Proposats 

/usr/hai/Personnei/Beneflts 

Open Dlractory I cancel I t-��-JI 
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NOTE: 
When you close a directory, all of its open children and descen­
dants also close. 

To close a directory using the Close Directory In Tree dialog: 

1.  Choose Close In Tree from the Directory menu. 

The Close Directory In Tree dialog is displayed: 

o�w�:l�=========================;�l 
His�: /usr/halllg 

/usrlhaVOata 

/usr/hal/misc 

/usr/hai/Personnelllitigation 

/usr/hai/Personnel 

/usr/hai/Personnei/Handboo� 

/usr 

/usrlhal 

/usr/hai/Proposals 

/usr/hai/Personnei/Benefits 

Oose Direcw� In Tree cancel I [L_ aose . JI 

In this dialog, you specify the directory that you want to close. 

2. To specify the directory you want to dose: 

• Select a directory from the history list 
or 

• Enter the pathname of a directory in the Directory field 
or 

• Press Return to close your home directory 

3lo Click Close. 

The directory closes. 

NOTE: 
When you close a directory, all of its open children and descen­
dants also close. 
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2 .  To specify the directory you want to show: 

• Select a directory from the history list 
or 

• Enter the pathname of a directory in the Directory field 
or 

• Press Return to see your home directory 

33" Click Show. 

If the directory was already open, it is automatically selected 
and scrolled into view. 

If the directory was closed, its opens, displaying any subdirecto­
ries it contains. Any of the directory's ancestors that were 
closed open as well. The opened directory is automatically 
selected and scrolled into view. 

Closing directories 

Use the Close In Tree command from the Directory menu to close 
an open directory. 

You can select a directory in Tree View and then use this command 
to close it. Or, you can choose this command without selecting any 
directories to display the Close Directory In Tree dialog. Use this 
dialog to specify the name of the directory you want to close in 
Tree View. 

NOTE: 
A shortcut for closing a directory in Tree View is to double-click the 
open folder icon of the directory that you want to close. 

To close selected directories: 

1. Select: 

• The icon or name of an unopened subdirectory on a direc­
tory panel 
or 

• The title bar of a directory panel 

�" Choose Close In Tree from the Directory menu. 

The directory closes. 
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To show a selected directory: 

1. Select: 

o The icon or name of a subdirectory on a directory panel 
or 

o The title bar of a directory panel 

� , Choose Show In Tree from the Directory menu in the 
Tree View window. 

If the directory was already open, it is automatically selected 
and scrolled into view. 

If the directory was closed, its opens, displaying any subdirecto­
ries it contains. Any of the directory's ancestors that were 
closed will open as well. The opened directory is automatically 
selected and scrolled into view. 

To show a directory using the Show Directory In Tree dialog: 

I. Choose Show In Tree from the Directory menu in the 
Tree View window. 

The Show Directory In Tree dialog is displayed: 

Directory:l:==============::::;-;;:1 
History: /usr/llallmisc 

/usr/hai/Personnei/Litigation 

/usr/hai/Personnel 

/usrlhai/Personnei/Handbook 

/usr 

/usrlhal 

/usrlhaVProposals 

/usrlhai/Personnell8enefits 

lusrlhallbin 

/usrlhai/Letters 

Show Directory In Tree cancel I [L��mlj 
In this dialog, you specify the directory that you want to bring 
into view. 
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2. To specify the directory you want to open: 

• Select a directory from the history list 
or 

• Enter the pathname of a directory in the Directory field 
or 

• Press Return to open your home directory 

33. Click Open. 

The directory opens, displaying any subdirectories it contains. 
All of the directory's ancestors that were not already opened 
open as well. 

The directory may be displayed out of sight in the Tree View 
window. You may have to use the scroll bar to bring it into 
view. 

NOTE: 
If the folder icon for a directory opens, but the directory doesn't 
open anywhere in the Tree View window, the directory doesn't 
contain any subdirectories. 

Showing directories 

Use the Show In Tree command from the Directory menu to bring 
an open, but hidden, directory into view. 

Choose this command without selecting any directories to open the 
Show Directory In Tree dialog imd specify the name of the directory 
you want to show in Tree View. 

You can also click a corner of a directory that's half-hidden to select 
it. If the directory is open when you choose the Show In Tree com­
mand, Looking Glass shows the directory. If the directory is closed 
when you choose the command, Looking Glass opens it. 

You can only bring one directory into view at a time. If you select 
more than one directory and then choose Show In Tree, Looking 
Glass will only show you the first directory. You must choose Show 
In Tree again to see the next directory. 
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To open selected directories: 

1. Select: 

• The icon or name of a subdirectory on a directory panel 
or 

• The title bar of a directory panel 

�. Choose Open In Tree from the Directory menu in the 
Tree View window. 

All selected directories open, displaying any subdirectories they 
contain. 

Directories may be displayed out of sight in the Tree View window. 
You may have to use the scroll bar to bring hidden directories into 
view. 

NOTE: 
If the folder icon for a directory opens, but the directory doesn't 
open anywhere in the Tree View window, the directory doesn't 
contain any subdirectories. 

To open a directory using the Open Directory In Tree dialog: 

1. Choose Open In Tree from the Directory menu in the 
Tree View window. 

The Open Directory In Tree dialog is displayed: 

D�c�: l�========================�
l 

History: /usr/hal/misc 

/usr/hai/Personnei/Utigation 

/usr/haVPersonnel 

/usr/haVPersonnei/Handbook 

/usr 

/usr/hal 

/usr/haiiProposaJs 

/usr/hai/Personnel!Benefits 

/usr/hallbin 

/usrlha.J/Letters 

Open Directory In Tree cancel I IL mm���J 

In this dialog, you specify the directory that you want to open. 
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Here is a Tree View window before and after using the Subtrees 
command: 

Directory View Select Tree Show 

I 
e::1 Archive 
e! Budget 
a Data 
o Icons 

o Proposals 
o bin 
o dsh 
"' lg 

e Letters o mise 
o Personnel 

I Budget I I Letters 
a Budget_69 "' Legal 
a Budget_90 o Office_Memos 

o Personal 

14 lid 

*ree·Wew 
View Select Tree Show 

Before using the After using the Subtrees 
Subtrees command command 

You can unselect all selected directories by clicking anywhere in the 
Tree View window. When you click in the window, all subdirecto­
ries that were selected become unhighlighted. 

NOTE: 
I f  you used the All Directories command, you can use the All 
Unselected Directories command in the Select menu to quickly uns­
elect all selected directories. 

Opening directories 

Use the Open In Tree command from the Directory menu to open 
directories in the Tree View window. 

You can select one or more directories in Tree View and then use 
this command to open them. Or, you can choose this command 
without selecting any directories and the Open Directory In Tree 
dialog will appear. Use this dialog to specify the name of the direc­
tory you want to open in Tree View. 

NOTE: 
A shortcut for opening a directory in Tree View is to double-click 
the closed folder icon of the directory that you want to open. 
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Here is a Tree View window before and after using using the 
Subdirectories command: 

'"' """" 

Directory VIew Select T� Show 

I IIJMti® 
t:! Archlve 0 Proposals 
<!!� Budget O bin 
o oata o dsh 
O tcons O tg 
0 Leners O misc 

- -
� ll*\.11111§1[ 
6 Budget_89 0 Ads 
8 Budget_90 0 Benefils 

e Handbook. 
e!I Litigatlon 
o Reviews 

Before using Subdirectories 
command 

Selecting descendants 

After using Subdirectories 
command 

Use the Subtrees command in Tree View when you have one or 
more directories selected and you want to select all of their 
descendants. 

lio Choose the Subtrees command from the Select menu 
in the Tree View window. 

All descendants of the selected directories are highlighted. All 
directories that were selected remain highlighted. 
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Here is a Tree View window before and after using the Parent 
Directories command: 

llfrllctory - Selact Tree Sllow 

I ......... I 
1:1 Archive 

- -
O oata 
o Icons 
O teuers 
e penonnel 

!:� Proposals 
l:l btn 
0 dsh 
"' lg 
O mtsc 

!--.1 I ""'""'""" I 
e sudgaL89 r=I Ads 
e sudget_90 o Beneftb 

'" 1111111111111 eli Litigation 
o Reviews 

l lltlga- 1  ,l!fm'D!dJMI 

Before using Parent 
Directories command 

Selecting children 

DlradorY VI8W S8l8ct Ti'88 ShaW 

I ;•m I 
o Archive 0 Proposals 
e sudgel O btn 

" Data 0 dsh 
O tcons "' lg 
O tetters O mtsc 

- -
C!!!iD 111P*i!I!JiUMI 
e Budga1_89 0 Ads 
e Budget_90 O senetlls 

e Handbook 
e!I Liflgalion 
o Reviews 

l lltlga- 1  i5'N. I� I 

After using Parent 
Directories command 

Use the Subdirectories command in Tree View when you have one 
or more directories selected and you want to select their children. 

11" Choose the Subdirectories command from the Select 
menu in the Tree View window. 

All children of the selected directories are highlighted. All direc­
tories and subdirectories that were selected, but weren't chil­
dren of other selected directories, are unhighlighted. 
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Selecting all unselected directories 

Use the All Unselected Directories command in Tree View to select 
all directories that aren't selected and u nselect those that are 
selected. 

llo Choose the All Unselected Directories command from 
the Select menu in the Tree View window. 

All directories and subdirectories that were previously unse­
lected are highlighted. All directories and subdirectories that 
were selected are unhighlighted. 

Here is a Tree View window before and after using the All 
Unselected Directories command: 

ree VieW 
Directory VIew Select Tree 

14 

I /usrhlaJ 

.( " '�""'"' 

• eJ bin 
• el dsh 
.. "' lg 
• 0 mise 
.. 

I 
Show 

lid 

Before using All Unselected 
Subdirectories command 

Selecting parents 

ree View 
Directory VIew Select Tree Show 

14 

I Mffi@ I 
� Archive 

�r 
e:J Budget 
o Data 
o Icons 
o Letters 
o Personnel 

lid 

After using All U nselected 
Subdirectories command 

Use the Parent Directories command in Tree View when you want 
to select the parents of all selected directories. 

llo Choose the Parent Directories command from the 
Select menu in the Tree View window. 

The parents of all selected directories are highlighted. All direc­
tories that were highlighted, but weren't parents of selected 
directories, are unhighlighted. 
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Selecting all directories 

When you use the All Directories command in Tree View, Looking 
Glass selects all open or closed directories and subdirectories dis­
played in the Tree View window. 

n, Choose the All Directories command from the Select 
menu in the Tree View window. 

All directories are highlighted. 

Selecting all open directories 

Use the All Open Directories command in Tree View to select all 
directories that are open. Open directory icons are folders that are 
fanned open. 

Not all open directories have subdirectories. If  the folder icon is 
fanned open but there is no directory panel open anywhere in the 
Tree View window, the directory may be empty or contain only 
files, or you may not have access permission. 

n, Choose the All Open Directories command from the 
Select menu in the Tree View window. 

All open directories are highlighted. 

Here is a Tree View window with all open directories and subdirec­
tories selected: 

� Benefits 

: . 
eJ Reviews 
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Here is an example of a group of subdirectories that have been 
selected: 

Group of selected ---iH-f= 
subdirectories 

When all of the subdirectories you want to select are enclosed in 
the rectangle, release the mouse button. 

The directories are highlighted. 

Extending a selection by Shift-dragging 

After you have selected a group of directories, you can extend the 
selection. This means that the newly selected directories are added 
to the directories already selected. 

n. Hold down the Shift key and drag diagonally across 
the subdirectories that you want to add to the 
selection. 

As you move the pointer, the subdirectories are enclosed in a 
selection rectangle. 

NOTE: 
Any directories in the selection rectangle that were previously 
selected become unhighlighted. 
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The subdirectory is highlighted. If the subdirectory is open, its cor­
responding title bar is also highlighted. 

o Litigation 

e:! Reviews 

0 Budget_B9 

o Budget_90 

Selecting a group of subdirectories 

There are three ways to select a group of directories in Tree View: 

• By Shift-clicking 
• By dragging 
• By Shift-dragging 

Selecting several d irectories by Shift-clicking 

llo Shift-click the directories you want to select. 

The directories are highlighted. 

Selecting a group of directories by dragging 

llo Drag diagonally across the subdirectories you want to 
select_ 

As you move the pointer, the subdirectories are enclosed in a 
selection rectangle. 
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Notice in the example that directory panels are connected by hori­
zontal lines that show that they are siblings; in other words, they 
belong to the same parent directory. If you open several directory 
panels that don't all fit in the Tree View window, you can click any 
visible part of a directory panel or on the horizontal line connect­
ing the panels to bring a whole panel immediately into view. 

Clicking is the fastest way to bring directory panels into view that 
are only partially out of sight in the Tree View window. You can 
also use the scroll bars in the Tree View window to bring hidden 
directory panels into view. 

Selecting directories 

In Tree View, you select directories that you want to open in direc­
tory panels or Directory windows or that you want to search using 
the Find command. You can select: 

• A single directory 
• A group of directories 
• All directories and subdirectories 
• All open directories 
• All unselected directories 
• The parent directories of selected child directories 
• The child directories of selected parent directories 
• All descendants of selected directories 

You can also unselect all selected directories. 

Selecting a single subdirectory 

You can select a single directory by simply clicking on the icon or 
name of a subdirectory on a directory panel or the title bar of a 
directory panel. 



Parent of 
P ersonnel 

and ancestor of  
Handbook 

Child of hal 

Child of 
Personnel and 

descendant of 
hal 
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You can open many directory panels at once to see all or part of the 
structure of a file system. 

Tree View is like a family tree, in that it shows the relationships 
among the directories in a file system. In this chapter, we use the 
terms parents and children, ancestors and descendants to describe 
the relationships between directories. 

The terms parent and child refer to the directories that are immedi­
ately above and below a directory in the file system. The terms 
ancestor and descendant refer to directories that are above and below 
a directory but are separated by at least one level of directories. 

For example, the /usr/hal directory is the parent of its immediate 
subdirectory /usr/hal/Personnel. In turn, Personnel is a child of 
hal .  A directory can have many children, but only one parent. 

The subdirectory /usr/hal/Personnel/Handbook is a child of 

/usr/hal /Personnel and therefore a descendant of /usr/hal.  This 
means that /usr/hal is an ancestor of the subdirectories of 
/usr/hal /Personnel .  

Understanding these relationships i s  important because performing 
an action on a parent directory (such as opening or closing it) may 
affect the display or selection of its ancestor and descendant 
subdirectories. 

Here is an example of the relationships between directories in a file 
system: 

····ree··View 
Directory VIew Select Tree Show 

tusr/hal 

o Archive o Proposals 

eo Budget f:l bin 
� Data � dsh 
O icons � tg 

o Letters o mise 

o Personnel 

Personnel I Proposals I I  Budget I 
� Ads 0 Archive � Budget_69 
0 Benefits 0 Exec_Summary S Budget_90 

o Handbook 

o Litigation 
0 Reviews 

Handbook I Utlgatlon U 
� Chapter_l � Claims I 
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Opening the Tree View window 

Subdirectories 
of usr/hal 

You can use the Tree View window to browse a file system as  well as 
select directories that are located in different areas of the file 
system. 

NOTE: 
Unlike Directory windows, the Tree View window only shows direc­
tories. To view the files in a directory, you can open a Directory 
window for any selected directory from the Tree View window. 

llo Choose Tree View from the Show menu in the Global 
window. 

The Tree View window is displayed: 

1-----tll-ll--- Directory panel tor 
usr/hal 

The first time you open the Tree View window, your home direc­
tory and its subdirectories are displayed. 

After your first visit to the Tree View window, Looking Glass 
remembers the layout of directories when you close the window. 
Looking Glass restores that layout when you open the window 
again. 

Viewing directories 

When you open a directory, its subdirectories are displayed in a 
rectangular area in the Tree View window called a directory panel. 



Viewing your file system with 
Tree View 

In this chapter, you'll learn how to view a condensed version of a file system using 
the Tree View window. With the Tree View window, you'll be able to: 

• View and select directories 
• Display subdirectories in Name or Icon view 
• Sort open directories alphabetically by name 
• Open individual Directory windows for selected directories 
• Select directories for searching with the Find command 

6 

Once you've opened several directories, you can name and save that particular Tree, 
open any of your saved Trees, or merge a saved Tree with your current one. 
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Printing files 

You can print files with the Print command from the File menu. 

1.  Select the files you want to print. 

� ' Choose Print from the File menu in the Directory 
window. 

Looking Glass prints the files. If you select a file that is not printable, 
Looking Glass displays a dialog telling you that it won't be printed. 

When Looking Glass prints a file, it uses two commands: one to for­
mat the file and one to spool it to the printer. You can specify the 
print formatter and spooler commands as part of your execution 
preferences. For information about execution preferences, refer to 
Chapter 12, "Changing Looking Glass preferences." 

The formatter command processes the file for printing-it may pagi­
nate the document or put in headers. The spooler receives the data 
produced by the formatter command and sends it to the printer. 

When you choose the Print command from the File menu, Looking 
Glass checks to see if the file is printable. If it is, Looking Glass 
checks to see if a special formatting command is defined for that 
type of file. If there is one, Looking Glass uses it. If there is no spe­
cial command, Looking Glass uses the command from the user's 
execution preferences. 

The output of the formatting step is then sent to the spooler com­
mand specified in the user's execution preferences. 
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Changing ownership and group reference 

Every directory and file has an owner and a group reference. You 
are the owner of the directories and files you create. If you own a 
directory or file, you control: 

• Who owns it 
• Which group it is associated with 
• Who can view it 
• Who can change it 
• Who can execute it (if it's a program) 

NOTE: 
If you give ownership of a directory or file to another user, you can­
not regain ownership unless the new owner or the super-user reas­
signs ownership to you. 

On some systems, you cannot change a file's owner or group 
reference. 

When you specify the group reference for a directory or file, you 
identify a group of users that you (or the owner of the directory or 
file) can specify a separate set of access permissions for. 

If your system allows you to give ownership of a directory or file to 
another user or change the group reference, use the Information 
command to make these changes one directory or file at a time. 

1. In a Directory window, select the directories and files 
for which you want to change the ownership or group 
reference. 

2. Choose Information from the File menu in the 
Directory window. 

An Information dialog is displayed for each selected directory 
and file. 

3. Select Ownership. 

The ownership and group reference information is displayed in 
the third section of the dialog. The Owner list contains an 
alphabetical list of the users in your system. The Group list con­
tains an alphabetical list of the groups in your system. 
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Owner list 

Name: !sales Leads 
Type: Database data file 

Size: 54397 Unks : 1  lnode: 71731 

(> Access + Ownership (> Dat>!s 

Owner Group 

hoyle guest 
ingres ingres 
janet!>! kmem 

User ID: j142 Group ID:izso 

File lnfonnation Cancel I It 

� � 

OK 

4. To specify the new owner or group: 

l i 

• Select the name of  the new owner from the Owner list or  
the new group from the Group list 
or 

• Enter the ID number of the owner or group in the text box 
below the list 

t'11 o Click OK. 

If you selected more than one directory or file, repeat steps 3 
through 5 until no more dialogs are displayed. 

Changing date and time information 

Your operating system stores the date and time that each directory 
or file in the system was last accessed and modified. It also stores 
the date and time that the status of each directory or file was 
changed. You can change the dates and times that a single directory 
or file was modified or accessed, but you can't change its status 
change date and time. 

1. In a Directory window, select the directories and files 
for which you want to change date and time 
information. 

2. Choose Information from the File menu in the 
Directory window. 
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An Information dialog is displayed for each selected directory 
and file. 

3. Select Dates. 

The date and time information is displayed in the third section 
of the dialog. 

Name: I sates Leads � 
Type: Database data file 

Size: 54397 Unks : 1  lnode: 71731 

0 Access 0 Owne,.,hip + Oates 

Status Change: I 1 1 /13/90 18 :20 :21 

Modification field ___ ..._ __ Modification: I 02/28/90 12 :58 :43 

• 

Access: I 1 1 /21/90 16 : 19 :02 

File lnfonnation cancel 1 [1 OK I[ 
4. Select the part of the date or time you want to change 

in the Modification or Access field. 

When you select a part of the date or time, it is highlighted and 
plus and minus boxes are displayed to the right of the date or 
time. 

5. Click the plus (+) or minus (-) box to change the num­
ber of the date or time. 
or 
Enter a new date or time. 

6. Select the next part of the date or time you want to 
change. 

Repeat steps 2 through 6 until you have made the changes you 
wanted to make . 
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:/ o Click OK. 

If  you selected more than one directory or file, repeat steps 3 
through 7 until no more dialogs are displayed. 

Changing device information 

The Information command from the File menu allows the super­
user to change the type of device and the major and minor device 
numbers for device files. 

WARNlNG: 
I( you are not sure of the changes you want to make to the device, do not 
attempt these changes. For more information about changing devices, 
refer to your system documentation. 

Changing the device type 

I. In a Directory window, select the device files for 
which you want to change the device type. 

2. Choose Information from the File menu in the 
Directory window. 

An Information dialog is displayed for each selected file. 

3. Select Device. 

This button is displayed only when the selected file is a device. 

When you select this button, device information is displayed in 
the third section of the dialog. 



Chapter 7: Accessing information about directories and files A 7-1 3 

Name: rrzOf 

Type: Raw hard disk 

Size: 0 Unks : l  Jnode: 2061 

<> Access <> Ownership <> Dat.!s + Device 

Device type ----llf-------<> Block Device 
+ Olaract.!r Device 

Major Device Number:� 
Minor Device Number: D 

• 

cancel I [I__ OK II • .J 
Omracter Device lnfonnation 

4. Select either Block Device or Character Device. 

fiJ. Click OK. 

If you selected more than one file, repeat steps 3 through 5 
until no more dialogs are displayed. 

Changing major and minor device numbers 

1. In a Directory window, select the device files for 
which you want to change the device numbers. 

2. Choose Information from the File menu in the 
Directory window. 

An Information dialog is displayed for each selected file. 

3. Select Device. 

This button is displayed only when the selected file is a device. 

When you select this button, device information is displayed in 
the third section of the dialog. 
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Name: rrzOf 

Type: Raw hard disk 
Size: 0 Unks: l 

• 

lnode: 21181 

0 Access 0 Ownership 0 Dates + Device 

0 Biock Devtce 
• Olaracter Device 

MajOr Device Humber:� 
Device numbers ----1------

Minor Device Number: D 

Olaracter DeVIce lnfonnatlon I cancel I [I OK I I 

4. Enter the major device number in decimal notation in 
the Major Device Number field. 

S. Enter the minor device number in decimal notation in 
the Minor Device Number field. 

tiD. Click OK. 

If you selected more than one file, repeat steps 3 through 6 
until no more dialogs are displayed. 

Changing infonnation for a group of directories and files in one 
operation 

You can use the Change Properties command in a Directory win­
dow to change information for a group of directories or files in one 
operation. For example, you may have selected 20 files in a 
Directory window that you want to assign certain access permis­
sions to. With the Information command, you would have to 
change the same information in 20 dialogs. 
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With the Change Properties command, you can change the follow­
ing information for a group of selected directories and files in one 
operation: 

• Ownership and group reference 
• Access permissions (also called protection mode) 
• Execution options 
• Date and time the directories or files were last modified or 

accessed 

Changing ownership and group reference 

If your system allows you to give ownership of directories and files 
to another user or to change group reference, use the Change 
Properties command to make these changes for a group of directo­
ries and files in one operation. For an explanation of ownership and 
group reference, refer to "Changing information for one directory 
or file at a time" earlier in this chapter. 

1. In a Directory window, select the group of directories 
and files for which you want to change ownership 
and group reference. 

2. Choose Change Properties from the File menu in the 
Directory window. 

The Change Properties dialog is displayed. 

Notice that the dialog contains four major sections and a row of 
buttons at the bottom. Ownership and group reference infor­
mation is displayed in the first section, access permission and 
execution option information is displayed in the second sec­
tion, and date and time information is displayed in the third 
section. 

3. Select either Owner or Group. 

When you select the check box, the list becomes active. This is 
an alphabetical list of the users or the groups in your system. 
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1. In a Directory window, select the group of directories 
and files for which you want to change access 
permissions. 

2. Choose Change Properties from the File menn in the 
Directory window. 

The Change Properties dialog is displayed. 

3. Select Access. 

When you select the check box, the Access section is activated. 

0000 
0 Set User ID On ExecuUon 
0 Set Group ID On ExecuUon 
0 Save Text After ExecuUon 

<> Add <> SUbtract <> Replal:e 

Olange Properties 

4. Select: 

atncel I It_ o� _ li 

• R (read) to allow the Owner, Group, or Others to view the 
contents of a directory or file 
or 

• W (write) to allow the Owner, Group, or Others to change 
the contents of a file, or to add or remove files from a 
directory 
or 

• X (execute) to allow the Owner, Group, or Others to run a 
file as a command or open a directory 
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S. Select: 

• Add to add the new permissions you specify to the permis­
sions that are already in place 
or 

• Subtract to remove the permissions you specify from the 
permissions that are already in place 
or 

• Replace to replace the permissions that are already in place 
with the new permissions you specify 

<ID. Click OK. 

If you change access permissions for a group of directories and 
files at one time, a status dialog displays the progress of the 
operation. 

If a status dialog is displayed, you can cancel the unfinished 
part of the change by clicking Cancel in the status dialog. 

Changing execution options 

Looking Glass allows you to set several options for directories and 
files that can have an effect at execution time. Use the Change 
Properties command to change the execution options for a group of 
directories and files at one time. For an explanation of execution 
options, refer to "Changing information for one directory or file at 
a time" earlier in this chapter. 

NOTE: 
Before using any of the options, refer to your system 
documentation. 

1. In a Directory window, select the group of directories 
and files for which you want to change execution 
options. 

2. Choose Change Properties from the File menu in the 
Directory window. 

The Change Properties dialog is displayed. 

3. Select Access. 

The execution options are displayed. 



Chapter 7: Accessing information about directories and files A 7-19 

rLJ-awner ..r\...c..num. 

,,.,,., � 

lautl1rtmd 

� 

�dial I bin 
HllHVld�l tlamnm1 

Us�>r m:l I Group ID:I I 
Execution options -----11-+����===�--------l 

R w X I oouo ---------
�ces 

0 0 0 Owner 0 Set User ID On Execution 
0 D 0 Group D Set Group ID on Execution 
D D D Others 0 Save Text After Execution 

0 Add 0 SUbtrat:t 0 Replace 

a.ange l'nlpertie• I cancel I ll m?.�mmJi 
4. Select: 

• Set User ID On Execution if you want other users to be 
able to execute the files with the owner's access permissions 
or 

• Set Group ID On Execution if you want other users to be 
able to execute the files with the access permissions of the 
owner's group 
or 

• Save Text After Execution if you want the files' executable 
text images saved to the swap area on the disk after 
execution 

S,o Click OK. 

Changing date and time information 

With the Change Properties command, you can change the dates 
and times that a group of directories and files were last modified or 
accessed. 
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Changing the modification date 

1. In a Directory window, select the group of directories 
and files whose modification date you want to 
change. 

2. Choose Change Properties from the File menu in the 
Directory window. 

The Change Properties dialog is displayed. 

3. Select Last Modified. 

DODO 
D Sel User 10 (�I EKecutlon 

D Sel Grotql ID (hi EKecuuon 

D Save Text Arter E>ce<lllion 

0 Adll 0 SUblrru:l 0 R0111ru:e 

10:52:41 

Olange Aopertles � 111 OK li 
4. Select the part of the date or time you want to change. 

When you select a part of the date or time, it is highlighted and 
plus and minus boxes are displayed to the right of the date or 
time. 

5. Click the plus (+) or minus (-) box to change the num­
ber of the date or time. 
or 
Enter a new date or time. 

6. Select the next part of the date or time you want to 
change. 
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Repeat steps 2 through 6 until you have made the changes you 
wanted to make. 

;;,Click OK. 

If you change dates and times for a group of directories and files 
at one time, a status dialog displays the progress of the 
operation. 

If a status dialog is displayed, you can cancel the unfinished 
part of the change by clicking Cancel in the status dialog. 

Changing the access date 

I. In a Directory window, select the group of directories 
and files whose access date you want to change. 

2. Choose Change Properties from the File menu in the 
Directory window. 

The Change Properties dialog is displayed. 

3. Select Last Accessed. 

000(1 
0 se1 User ID 011 E:xecutioll 

0 Se1 Gn.11111 m 011 b:er:utiou 

0 Save Tmtt f\ft<�r E>U�Ctl1ion 
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4. Select the part of the date or time you want to change. 

When you select a part of the date or time, it is highlighted and 
plus and minus boxes are displayed to the right of the date or 
time. 

5. Click the plus (+) or minus (-) box to change the num­
ber of the date or time. 
or 
Enter a new date or time. 

6. Select the next part of the date or time you want to 
change. 

Repeat steps 2 through 6 until you have made the changes you 
wanted to make. 

I/o Click OK. 

If you change dates and times for a group of directories and files 
at one time, a status dialog displays the progress of the 
operation. 

If a status dialog is displayed, you can cancel the unfinished 
part of the change by clicking Cancel in the status dialog. 
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In this chapter, you'll learn how to use Looking Glass to run and terminate programs 
from: 

• Directory windows and the Desktop Panel 
• Command Line dialogs 
• Terminal emulator windows 
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Activating files 

When you activate a file, Looking Glass decides what type of file it is 
and runs the correct program. When Looking Glass runs a program, 
the program's icon and process ID are displayed in the Global 
window. 

You can usually terminate a program started from Looking Glass 
with the Request Job Termination or Force Job Termination com­
mands from the Jobs menu in the Global window. 

For information on defining the action taken when you activate a 
file, refer to Chapter 13,  "Defining file types." 

There are two ways to activate a file in Looking Glass: 

• Double-click the file 
• Use the Open command 

Activating files by double-clicking 

no In a Directory window or the Desktop Panel, double­
click the file you want to activate. 

If there are no actions associated with the file, Looking Glass 
displays a dialog telling you that. 

If there are actions associated with the file, the file is activated 
and Looking Glass displays the icon for the program associated 
with the file in the Global window. 

Activating files using the Open command 

1. In a Directory window or the Desktop Panel, select the 
files you want to activate. 

�" Choose Open from the File menu in the Directory 
window. 

If there are no actions associated with a file, Looking Glass dis­
plays a dialog telling you that. 

If there are actions associated with the files, the files are acti­
vated and Looking Glass displays the icons for the programs 
associated with the files in the Global window. 
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Displaying and choosing actions for a file 

Some files have more than one action associated with them. The 
action that occurs when you double-click a file is called its primary 
action. Looking Glass lets you display all the possible actions for a 
file and choose one. If you're not sure what a file's primary action 
is, you should view the possible actions before activating it. 
Choosing an action from the list of possible actions will have no 
lasting effect-the primary action for the file will not be changed. 

1. Control+double-click the file. 

If there are no actions associated with the file, Looking Glass 
displays a dialog telling you that. 

If there are actions associated with the file, Looking Glass dis­
plays the Select A Command dialog: 

Page through ftle 

Count file's lines, words and characters 

Command Una: 

tusr/ucb/YI Zycor; lg_pause 

I 

Select A Command C8ncld I [_OK II 
The top part of the dialog contains descriptions of all of the 
possible actions for the file. A description of the primary action 
for the file is listed first and highlighted. 

The bottom part of the dialog displays the command associated 
with the highlighted action. 

You may need to scroll through the list of actions to view all of 
the commands. 

2. Select an action to view the command associated with 
it. (Don't double-click an action unless you want to 
execute it.) 
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3lo To choose the action you want: 

• Double-click an action in the list 
or 

• Select an action from the list and click OK 

The dialog closes and the file is activated with the selected 
action. 

Terminating jobs 

When you run a program from Looking Glass, you will normally 
exit it from within the program itself using the appropriate com­
mand. However, sometimes a program will "hang" or malfunction 
so that you can't terminate it normally. If this happens, Looking 
Glass gives you a simple way to terminate the program. 

NOTE: 
Make sure that when you terminate a program, it's really hung, not 
simply waiting. 

Job is a general term for a running program. There are two ways to 
terminate most jobs launched from Looking Glass: 

• The Request Job Termination command 
• The Force job Termination command 

The Request job Termination command sends a message to the job 
asking it to stop. This command gives the program a chance to 
clean up and exit. The Force Job Termination command forces the 
job to terminate as soon as possible. 

If you try to terminate a job with the Request job Termination com­
mand and it does not stop, use the Force job Termination com­
mand. If you have difficulty stopping a job with the Force job 
Termination command, see your system administrator. 

1. In the Global window, select the icons for the jobs you 
want to stop. 

�0 Choose Request job Termination or Force job 
Termination from the jobs menu in the Global 
window. 

The jobs are stopped and the icons are removed from the 
Global window. 

If a job refuses to terminate, a dialog is displayed telling you 
that. 
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Using the Command line dialog 

The Command Line feature simplifies the task of running operating 
system commands from a shell by: 

• Providing a text field in which you can enter and edit 
commands 

• Automatically inserting directory and file names selected in the 
current Directory window (available only when run from a 
Directory window) 

• Substituting the current directory name and effective user and 
group names 

• Storing your most recently used commands in a history list 

Running commands 

1. Choose Command Line from the Run menu in any 
Directory window or the Global window. 

The Command Line dialog opens: 

� Run In Tenninal Window 1 Symbols 
� Pause After Execution L. :.!.:e.::..:.:::_ __ __J 

History: compress tf 

who 1wc -1 

we -I tf 

Run Command H""'"v" I I aose I II ll11n ..... JJ 

If you select Command Line from a Directory window, the cur­
rent directory reference is the directory displayed in the 
Directory window. 

If you select Command Line from the Global window, the cur­
rent directory reference is your horne directory. 
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2. Type your command in the Command text box, 
or select a command you have already run from 
the history list. 

If you select a command from the history list, you can 
edit it before running it. 

Your command can contain any text or symbols allowed 
by your operating system shell, including environment 
variables. In addition, you can embed Looking Glass spe­
cial symbols in the command, either by typing the sym­
bol or by putting the text insertion cursor where you 
want the symbol and selecting the corresponding option 
from the Symbols menu. 

The following table describes the values in the special 
Symbols menu: 

Inserts this 
This option: symbol: With this value: 

Selected Files #f The names of all the files cur-
(available only when Command rently selected in the Directory 
Une is run from a Directory window 
window) 

Selected Directories #d The names of all the directo-
(available only when Command ries currently selected in the 
Une is run from a Directory Directory window 
window) 

Effective User #u The current user name 

Effective Group #g The group name associated 
with the Looking Glass process 

Current Directory #c The full path name of the cur-
rent directory 
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If you want the program to run in a terminal emulator window, 
click the Run In Terminal Window button.  

If you want to be sure you'll be able to read the output when 
the program finishes, click the Pause After Execution button. 

NOTE: 
If you select the Pause After Execution button and the com­
mand isn't running in a terminal emulator window, you may 
have to use the Request job Termination command in the 
Global window to stop the program. 

ill. Click Run to execute the command. 

Here is an example demonstrating the use of special symbols in the 
Command Line dialog. Let's say you want to use the standard sys­
tem utility we to count the number of lines in three text files named 
report l ,  report2, and report 3 .  To do this from a standard com­
mand-line shell, you would need to type: 

we -1 report1 report2 report3 

(The -1 argument tells the we command to count lines.) 

Using the special symbol #f (the Selected Files option in the 
Symbols menu), you would select the files in a Directory window 
and then type: 

we -1 #f 

in the Command field of the Command Line dialog. When you run 
the command, the #f  symbol in this command line is replaced by 
the names of the selected files, resulting in the command we -1 
report1 report2 report3. This saves you the trouble of typing 
the filenames. 

Once you have run the command this way, it is stored in the his­
tory list with the #f in the text of the command, not the specific 
filenames. To run the same command again on a different set of 
files, you would only need to select those files and then select the 
command again from the history list. 

For more information on using commands and utilities available on 
your system, refer to your system documentation or see your system 
administrator. 
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Removing commands from the history list 

You can remove any command from the history list in the 
Command Line dialog. 

1. Choose Command Line from the Run menu in any 
Directory window or the Global window. 

The Command Line dialog opens. 

2. Select the command you want to remove in the his­
tory list. 

�0 Click Remove. 

The command is removed from the history list. 

Displaying a terminal window 

Looking Glass lets you use a command-line shell in a terminal emu­
lator window. Once you have displayed a terminal emulator win­
dow, you can enter shell commands to run programs, just as if you 
were logged in at a character-based terminal. Looking Glass doesn't 
limit the number of terminal emulator windows you can have 
open. 

Tio Choose Terminal Emulator from the Run menu in any 
Directory window or the Global window. 

A terminal emulator window is displayed on your workspace. 

If you display a terminal emulator window from a Directory 
window, the current directory is the one displayed in the 
Directory window. 

If you display a terminal emulator window from the Global 
window, the current directory is your home directory. 

With the Execution Preferences command from the System menu, 
you can specify both the terminal emulator program and your com­
mand-line shell. 

For more information about specifying your default terminal emu­
lator program or a shell, refer to "Execution preferences" in Chapter 
1 2, "Changing Looking Glass preferences." 
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In Chapter 1, "Getting started with Looking Glass," we introduced the concept of the 
Looking Glass workspace-a place to put the programs, files, and directories you use 
most often. No two Looking Glass workspaces are exactly the same because each 
reflects the work and preferences of an individual user. When you quit, Looking 
Glass remembers how you left your workspace and restores it the next time you start 
Looking Glass. We use the term layout to refer to the arrangement of your workspace, 
including the size and location of any open Looking Glass windows and the contents 
of the Desktop Panel. 

In this chapter, you'll learn how to: 

• Save a layout 
• Open a layout 
• Remove a layout 
• Change a saved layout 

We'll also show you how to use the Desktop Panel to help organize your work. You'll 
learn how to: 

• Open and dose the Desktop Panel 
• Put directories and files on the Desktop Panel 
• Remove directories and files from the Desktop Panel 
• View directories and files by their name or icon on the Desktop Panel 
• View the full pathname of directories and 

'
rues on the Desktop Panel 

• Open direftories and files from the Desktop Panel 
• Show directories and files on the Desktop Panel in Directory windows 
• Print files from the Desktop Panel 
• Move directories and files around on the Desktop Panel 
• Clean up the Desktop Panel 
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Working with layouts 

Looking Glass lets you organize your workspace many different 
ways and then name and save each layout. Saving a layout makes it 
easy to switch from one activity to another without having to 
rearrange windows. 

For example, you might save a layout for working on budgets that 
includes the Desktop Panel with your spreadsheet program and any 
documents you're currently working on and a Directory window 
displaying the directory in which you keep business plans. You 
could create a separate layout for working on correspondence, and 
switch easily between the two. 

Saving a layout 

When you save a layout, you can only include windows that are 
controlled by Looking Glass. You can't save terminal emulator win­
dows or other external program windows as part of your layout. 

Saving a new layout 

1. Organize your workspace the way you want it. 

2. Choose Layouts from the Layout menu in the Global 
window. 

The Layouts dialog is displayed: 

Home 

Correspondence 

D 
Budgets 

Save... I I 0"11'1"··· I I 01"'" I I aose 

3. Click Save. 

A dialog appears asking you to name the layout you're saving. 

4. Type the name of your new layout in the Save Layout 
As field. 
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�.Click OK to save your new layout. 

The preview area on the right displays a thumbnail sketch of 
your workspace layout. The black areas represent the Global 
window and the Desktop Panel; the medium gray areas repre­
sent Directory windows; and the light gray areas indicate the 
positions of all other Looking Glass windows. 

Opening a layout 

There are two ways to open a layout: 

• Directly from the Layout menu 
• From the Layouts dialog 

Opening a layout di rectly from the Layout menu 

1. Open the Layout menu in the Global window. 

The list of saved layouts is displayed beneath the Layouts 
command. 

�. Select the layout you want to open. 

Your workspace changes to the layout you selected. 

Opening a layout from the Layouts dialog 

1. Choose Layouts from the Layout menu in the Global 
window. 

The Layouts dialog is displayed. The layouts you can open are 
displayed in the list on the left side of the dialog. 

�.To open the layout you want: 

• Double-click the name of the layout 
or 

• Select the name of the layout, then click Open 

Your workspace changes to the layout you selected. 
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When you click the name of a layout, a thumbnail sketch of the 
layout is displayed in the preview area on the right. 

Here is a typical layout thumbnail: 

Save... I I Delete... I I Open I I Oose 

Removing a layout 

1. Choose Layouts from the Layout menu in the Global 
window. 

The Layouts dialog is displayed. 

2. Select the layout you want to delete from the list. 

3. Click Delete. 

A dialog is displayed, asking you to confirm your selection. 

4:\. Click Yes. 

Changing a saved layout 

1. Select the layout you want to change from the Layout 
menu in the Global window. 

If you're already using the workspace layout you want to 
change, go to the next step. 

2. Organize your workspace the way you want it. 
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3. Choose Layouts from the Layout menu in the Global 
window. 

4. Click Save. 

A Save dialog appears, asking you to name the layout you're 
saving. 

S. Type the name of the layout you're changing exactly 
as it appears in the menu. 

6. Click OK. 

A dialog is displayed asking if you want to replace the existing 
layout. 

'$. Click OK. 

Your new layout is saved under the old name. 

Working with the Desktop Panel 

The Desktop Panel is a place to put icons for the directories and 
files you use most often. The directories and files you put on the 
panel are not removed from their actual location-they are just dis­
played there so you can access them easily. 

You can open directories and files on the Desktop Panel the same 
way you can in Directory windows. When you open a file from the 
Desktop Panel, the application's icon appears in the Global win­
dow. For more information about activating files, refer to Chapter 
8, "Running programs." 

In this section, we tell you how to: 

• Open and close the Desktop Panel 

• Put directories and files on the Desktop Panel 

• Remove directories and files from the Desktop Panel 

• View directories and files by their name or icon on the Desktop 
Panel 

• View the full pathname of directories and files on the Desktop 
Panel 

• Open directories and files from the Desktop Panel 

• Show directories and files on the Desktop Panel in Directory 
windows 
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• Print files from the Desktop Panel 

• Move directories and files around on the Desktop Panel 

• Clean up the Desktop Panel 

In addition to these actions, you can also move the Desktop Panel 
to another position on the workspace and resize it. For information 
about moving the Desktop Panel to another position on the work­
space and resizing it, refer to "Moving windows" and "Resizing win­
dows" in Chapter 2, "How you interact with Looking Glass." 

If a directory or file is dimmed on the Desktop Panel, it means that 
Looking Glass cannot locate it. 

Opening and closing the Desktop Panel 

When you start Looking Glass for the first time, the Desktop Panel 
opens on the right side of your screen. You can open and close the 
Desktop Panel from the Show menu in the Global window. You can 
also close the Desktop Panel from the File menu on the Desktop 
Panel. The Desktop Panel check box in the Show menu is selected 
or unselected, indicating whether or not the panel is displayed. 

Opening or closing the Desktop Panel from the Global window 

n. Choose Desktop Panel from the Show menu in the 
Global window. 

If the Desktop Panel was open, it closes. 

If the panel was closed, it opens. 

Closing the Desktop Panel from the Desktop Panel 

11. Choose Close from the File menu on the Desktop Panel. 

The Desktop Panel closes. 
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Putting directories and files on the Desktop Panel 

There are two ways to put any directory or file from a Directory 
window on the Desktop Panel: 

• Drag the directory or file to the Desktop Panel 
• Use the Put On Desktop Panel command 

Displaying a directory or file on the Desktop Panel by dragging 

no Drag the directory or file to the Desktop Panel. 

The directory or file appears on the panel. 

Displaying a directory or file on the Desktop Panel with the Put On 
Desktop Panel command 

1. Select the directory or file in a Directory window that 
you want to put on the Desktop Panel. 

;/;"Choose Put On Desktop Panel from the File menu in 
the Directory window. 

The directory or file appears on the panel. 

Removing directories and files from the Desktop Panel 

1. Select the directory or file on the Desktop Panel you 
want to remove. 

;JJ." Choose Take Off Desktop Panel from the File menu on 
the Desktop Panel. 

The directory or file no longer appears on the Desktop Panel. 

Removing a directory or file using the Looking Glass Remove 
command also removes the directory or file from the Desktop 
Panel. 

NOTE: 
Directories and files that are dimmed on the Desktop Panel 
can't be located by Looking Glass. This usually occurs when a 
directory or file has been moved or removed by a program 
other than Looking Glass, or resides in a file system that is not 
currently mounted or has been mounted at a different location. 
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Viewing directories and files by name or icon 

no Choose Name or Icon from the View menu on the 
Desktop Panel. 

All of the directories and files on the Desktop Panel are dis­
played by name or icon. 

Viewing the full pathname of directories and files 

no Choose Show Full Pathname from the View menu on 
the Desktop Panel. 

All of the directories and files on the Desktop Panel are dis­
played with their full pathnames. 

NOTE: 
If you move a file into a directory in a Directory window, the 
file's pathname changes in the Desktop Panel to reflect the new 
directory. 

Opening directories and files from the Desktop Panel 

You can open directories and files on the Desktop Panel the same 
way you can in Directory windows. The Open command opens a 
Directory window for the directory you selected, or activates the file 
you selected. 

1. Select the directories and files on the Desktop Panel 
you want to open. 

�0 To open the directories and files: 

• Double-click each directory or file you want to open 
or 

• Choose Open from the File menu 

If you selected a directory, it is displayed in a Directory window. 

If you selected a file, it is activated. 

Showing directories and files from the Desktop Panel 

The Show command displays a directory or file in a Directory 
window. 
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1. Select the directory or file on the Desktop Panel you 
want to show. 

� . Choose Show from the File menu on the Desktop 
Panel. 

A Directory window opens with the directory or file selected. 

Printing files from the Desktop Panel 

1. Select the files on the Desktop Panel you want to 
print. 

�. Choose Print from the File menu on the Desktop 
Panel. 

Looking Glass prints the files. If you select a file that is not 
printable, Looking Glass displays a dialog telling you that it will 
not be printed. For more information about printing files, refer 
to "Printing files" in Chapter 5, "Managing directories and 
files." 

Moving directories and files around the Desktop Panel 

n. Drag the directory or file to its new position on the 
Desktop Panel. 

The directory or file moves to its new position. 

Cleaning up the Desktop Panel 

You can clean up the Desktop Panel by using the Clean Up and 
Clean Up Selection commands to neatly line up directories and 
files. 

Cleaning up the Desktop Panel with the Clean Up command 

n. Choose Clean Up from the View menu on the Desktop 
Panel. 

All the directories and files are arranged in neat rows and 
columns on an invisible grid, filling in the Desktop Panel from 
left to right and top to bottom. 
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Cleaning up the Desktop Panel with the Clean Up Selection com mand 

1. Select the directories and files on the Desktop Panel 
yon want to clean np. 

:£"Choose Clean Up Selection from the View menn on the 
Desktop Panel. 

The directories and files you selected are moved to the nearest 
available space on the grid-not necessarily filling in the 
Desktop Panel from left to right and top to bottom. 
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The Visix Icon Editor is a standalone application that you can launch from the 
Looking Glass Global window or run as a separate program outside of Looking Glass. 

In this chapter you'll learn how to use the Icon Editor to: 

• View icons in a Gallery window 
• Create your own icon gallery 
• Edit icons in Gallery windows 
• Save icons 
• Change the display order of icons in Gallery windows 
• Import bitmap files 
• Export icons as bitmap files 
• Rename icons 
• Create icons and masks in Editing windows 
• Edit icons and masks in Editing windows 
• Install new icons 
• Merge icon galleries 

For a general discussion of icons, refer to "Looking Glass icons," in Chapter 1 ,  
"Getting started i n  Looking Glass." 
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Starting the Icon Editor 

There are two ways to start the Icon Editor: 

• Use Looking Glass 
• Use a command line 

Starting the Icon Editor from Looking Glass 

··· tf 
.. 
. 
. 
. . 
...... 

. 
• 

There are two ways to start the Icon Editor from Looking Glass: 

• Double-click the Icon Editor (vice) program icon shown on the 
left (the vice program is normally installed in the directory 
/usr/bin) 
or 

• Use the Icon Editor command from the Run menu in the 
Global window 

Starting the Icon Editor by double-cl icking 

n. Double-click the Icon Editor program icon. 

The Icon Editor program icon appears in the Global window, 
followed by: 

• The Icon Editor window, which displays the name of a new 
icon gallery, Untit ledl 

• A Gallery window named Untitledl 

Starting the Icon Editor using the Icon Editor command 

n. Choose Icon Editor from the Run menu in the Global 
window. 

The Icon Editor program icon appears in the Global window, 
followed by: 

• The Icon Editor window, which displays the name of the 
Main Gallery used by Looking Glass, lg_ i cons . d 

• A Gallery window named lg_ icons. d 

The Icon Editor window is always displayed when the Icon Editor 
program is running. You can use the File menu in the leon Editor 
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window to open and create icon galleries as well as quit the Icon 
Editor program. 

Here is an example of an Icon Editor window: 

Rle 

Main Gallery- f-iusrmhngng_icons.d 
used by 
Looking 

Glass 

Starting the Icon Editor from a command line 

llo At the command-line prompt, type: 

vice 

The following windows are displayed: 

• The Icon Editor window, which displays the name of a new 
icon gallery, Untitledl 

• A Gallery window named Untitledl 

Specifying command-line arguments at startup 

When you start the Icon Editor hom a command line, you can also 
specify arguments that control how the Icon Editor operates. 
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The following table describes the arguments you can specify at 
startup: 

This argument: 

filenames 

-frame 

-bordercolor color 
or 
-color color 

-lookandfeel style 
or 
-laf style 

-font font 
or 
-fn font 

-boldfont font 
or 
-fb font 

-mono 

Does this: 

Opens the icon galleries you specify at startup 
automatically. 

Tells the Icon Editor to put a frame around its 
windows. 

Use this argument for window managers that do 
not supply frames for windows. 

Lets you to specify a color for window borders. 

This argument only takes effect when the -frame 

argument is also used. 

Lets you to specify a look-and-feel style. 

Specify 3d or 2d style. 3d is OSF/Motif 
compliant. 

Lets you to specify a font for plain (nonbold) 
text. 

You can use any font available on your system. 

Lets you to specify a font for bold text. 

You can use any font available on your system. 

Forces a monochrome display on a color 
monitor. 



This argument: 

-foreground color 
or 
-fg color 

-background color 
or 
-bg color 

-tqpshadow color 
or 
-ts color 

-bott� color 
or 
-bs color 

-display machine 
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Does this: 

Lets you to specify a color for the user inter­
face elements that are in the foreground. 

Use a color from the system's color database 
or specify a color's Red, Green, Blue (RGB) 
value in hexadecimal notation. 

Lets you to specify a color for the user inter­
face elements that are in the background. 

Use a color from the system's color database 
or specify a color's Red, Green, Blue (RGB) 
value in hexadecimal notation. 

Lets you to specify a color for the top shadow 
of the user interface elements. 

Use a color from the system's color database 
or specify a color's Red, Green, Blue (RGB) 
value in hexadecimal notation. 

Lets you to specify a color for the bottom 
shadow of the user interface elements. 

Use a color from the system's color database 
or specify a color's Red, Green, Blue (RGB) 
value in hexadecimal notation. 

Lets you to specify the hardware display 
name for the machine whose display will be 
used by the Icon Editor. 

This option is only valid under the X Window 
System. The machine name supplied will be 
used to set the DISPLAY environment variable. 
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Quitting the Icon Editor 

There are two ways to quit the Icon Editor: 

• Use the Quit command from the File menu in the Icon Editor 
window 

• Use the Quit command from the File menu in a Gallery 
window 

JL To quit the Icon Editor, choose: 

• Quit from the File menu in the Icon Editor window 
or 

• Quit from the File menu in a Gallery window 

If any icon galleries are open with unsaved changes, the Icon 
Editor displays a dialog for each unsaved icon gallery asking if 
you want to save the changes. 

For information on saving an icon gallery, refer to the "Saving an 
icon gallery under a new name" section later in this chapter. 

Working with Gallery windows 

Looking Glass icons are stored in files called icon galleries. When you 
create a new Gallery window, or open an existing one, its name 
appears in the Icon Editor window. You can create as many icon gal­
leries as you want, but Looking Glass only uses the icons in the Main 
Gallery, whose full pathname is usually /usr/lib/ lg/lg_icons . d. 

Typically, any user can view and copy the icons in the Main 
Gallery, but only the super-user or system administrator can make 
changes to them. This is important to protect the working set of 
icons shared by all users on your system. If you don't have write 
permission for the Main Gallery, you can't save any changes you 
make to the icons in this gallery. You can, however, copy icons 
from the Main Gallery into an icon gallery you've created, where 
you can edit and save them. You can put new or modified icons 
into the Main Gallery with the help of your system administrator. 

Opening an existing icon gallery 

When you open an icon gallery, the icons and their names are dis­
played in a Gallery window. 



Option menu 

Gallery names 
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1. To open an existing icon gallery, choose: 

• Open Gallery from the File menu in the Icon Editor 
window 
or 

• Open from the File menu in a Gallery window 

The Open Gallery dialog is displayed: 

half 

0 .. 

o Archive 

o bin 

o Budget 

0 Dele 
0 dsh 

o etc 

Opan Gallery I Cllncel I[ Opan II 
Only icon galleries and directories are available in this dialog; 
other files are dimmed. 

2. To select an icon gallery: 

• Use the scroll bar to find an icon gallery and click the one 
you want to open 
or 

• Type the first few letters of the icon gallery name 

The name of the first icon gallery beginning with the letters 
you typed is highlighted. The Icon Editor gives you two sec­
onds between keystrokes as you type the name of the icon 
gallery. For example, to find an icon gallery named "Sample 
icons," you would have up to two seconds after typing the 
letter "s" to type "a" for the name "Sample icons" to be 
found. If you take longer than two seconds to type the letter 
"a, " the Icon Editor starts the search again and finds the 
first icon gallery or directory that begins with the letter "a." 

You can change the directory you're currently in by click­
ing the option menu above the icon gallery list and select­
ing a parent directory, or double-clicking one of the 
directories in the dialog. 
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33o Click Open. 

The icon gallery opens in a Gallery window. Its full pathname is 
displayed in the title bar and in the Icon Editor window. 

By default, the icons in a Gallery window are displayed alpha­
betically by name. You can change the display order of the 
icons with the Sort menu. For information about changing the 
order of icons, refer to the "Changing the display order of icons 
in a Gallery window" section later in this chapter. 

Creating a new icon gallery 

There are two ways to create a new icon gallery: 

• Use the New Gallery command in the File menu in the Icon 
Editor window 

• Use the New command in the File menu in a Gallery window 

::.o To create a new icon gallery, choose: 

• New Gallery from the File menu in the Icon Editor 
window 
or 

• New from the File menu in an icon gallery 

A new Gallery window is displayed. 

If you started the Icon Editor from the Global window in 
Looking Glass, the new icon gallery is named untitledl. The 
name appears in the title bar of the Gallery window and in the 
Icon Editor window. Each new icon gallery you create is consec­
utively numbered. 

If you started the Icon Editor by double-clicking the Icon Editor 
program icon, or from a command line, the new icon gallery is 
named untitled2 (Untitledl automatically opens when you 
start) . Each new Gallery window you create is consecutively 
numbered. 

When you save an icon gallery for the first time, you can change its 
name from Unt itledn to another name. After the first time you 
save an icon gallery, use the Save As command to change its name. 
For information about saving icon galleries, refer to the "Saving 
your work" section later in this chapter. 
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Now that you've created a new icon gallery, you can create new 
icons, or cut and paste icons from other icon galleries. For more 
information about creating new icons, refer to the "Creating a new 
icon" section later in this chapter. 

For more information on cutting, copying, and pasting icons, refer 
to the "Working with icons in Gallery windows" section later in 
this chapter. 

Saving your work 

A checkmark appears next to an icon's name when the icon has 
been created, edited, or renamed since the last time the icon gallery 
was saved. You must save the icon gallery to save the changed icon. 

There are two ways to save an icon gallery: 

• Use the Save command from the File menu in the Icon Editor 
window or the Gallery window to save an icon gallery under its 
current name 

• Use the Save As command from the File menu in the Icon 
Editor window or Gallery window to save an icon gallery under 
a new name 

Saving an icon gal lery under its current name 

n. Choose Save from the File menu in the Gallery 
window. 

The icon gallery is saved with the new, edited, or renamed 
icons. 

Saving an icon gallery under a new name 

1. Choose Save As from the File menu in the Gallery 
window. 

The Save As dialog is displayed. 
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2. To change the name: 

• Enter the full or relative pathname for the icon gallery in 
the Gallery Name field 
or 

• Use the option menu and the list to select the directory you 
want to save the icon gallery in, then enter the new name 
for the icon gallery 
or 

• In the Gallery Name field, enter the full or relative path­
name of the directory in which you want to save the icon 
gallery, followed by a slash (/) . Press the Tab or Return key 
to view the contents of that directory. Then type the name 
of the icon gallery in the Gallery Name field. 

33. CUck Save. 

For information about closing Gallery windows or quitting the Icon 
Editor, refer to the "Closing a Gallery window" section later in this 
chapter, or "Quitting the Icon Editor" earlier in this chapter. 

Reverting to the last saved version of an icon gallery 

You can use the Revert command to discard any changes made to 
an icon gallery since the last time it was saved. The Revert com­
mand is only available when you have made changes to an icon 
gallery since last saving it; otherwise, the command is dimmed. 

1. Choose Revert from the Flle menu in a Gallery 
window. 

The Icon Editor displays a dialog asking if you want to discard 
changes to the icon gallery. 

�. CUck Yes. 

The changes are discarded. 

NOTE: 
Revert and Undo are similar commands with two differences: 
Revert discards a set of changes and restores the most recently 
saved version of an icon gallery or icon. Undo only reverses the 
last action performed, and is only available from the Edit menu 
in an Editing window. 
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Selecting icons in a Gallery window 

If you know the name of the icon you want to find, or the letter it 
begins with, you can narrow your search or select it by typing the 
first few letters of the icon's name. 

The name of the first icon in the gallery beginning with the letters 
you typed is highlighted. The Icon Editor gives you two seconds 
between keystrokes as you type the name of the icon. For example, 
to find an icon named "SAMPLE_ICON, " you would have up to two 
seconds after typing the letter "s" to type "a" for the name "SAM­
PLE_ICON" to be found. If you take longer than two seconds to 
type the letter "a, " the Icon Editor starts the search again and finds 
the first icon that begins with the letter "a." 

1. To select icons in a Gallery window: 

• Click an icon to select it 
or 

• Type the first few letters of the icon's name to narrow your 
search or find the exact icon you want to select 
or 

• Use the scroll bar to find the icons and Shift+elick each 
icon you want to select 
or 

• Click an icon and drag up or down the icon gallery to select 
a group of icons 
or 

• Choose Select All from the Edit menu to select all the icons 
in the Gallery window 

The icons are selected. Clicking a selected icon unselects it. 

Changing the display order of icons in a Gallery window 

There are three ways you can display icons in a Gallery window: 

• Alphabetically by name 
• With selected icons at the top of the list 
• With modified icons at the top of the list 

When you open an icon gallery, the icons are displayed alphabeti­
cally by name. You can group selected icons or modified icons 
alphabetically at the top of the list by choosing Group Selected or 
Group Modified. 
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As you work with the Icon Editor, a checkmark appears next to any 
icons that have been created, edited, or renamed, but not saved. 

n. From the Sort menu in a Gallery window, choose: 

• By Name to display all the icons alphabetically 

• Group Selected to group selected icons alphabetically at 
the top of the list 

• Group Modified to group modified icons alphabetically at 
the top of the list 

The icons are displayed in the order you chose. 

Working with icons in Gallery windows 

You can use the Edit menu in a Gallery window to cut, copy, and 
paste icons; clear, duplicate, and select all icons within the same 
Gallery window; or move icons between different Gallery windows. 

The images you cut or copy are stored on the clipboard, a temporary 
holding area. Because you can only perform one cut or copy action 
at a time, you will lose the images stored on the clipboard when 
you cut or copy a new image to the clipboard. 

1. Select the icons you want to modify. 

�. From the Edit menu, choose: 

• Cut to remove the icons from the Gallery window and 
place them on the clipboard 

• Copy to place a copy of the icons on the clipboard 

• Paste to place the icons from the clipboard into the current 
Gallery window 

• Duplicate to copy the icons and their masks in the same 
Gallery window 

• Clear to remove the icons without placing them on the 
clipboard 

• Select All to select all of the icons in a Gallery window 

Some menu commands have equivalent accelerator keys. For 
more information about accelerator keys, refer to "Using acceler­
ator keys" in Chapter 2, "How you interact with Looking Glass." 
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The following table shows the commands and their equivalent 
accelerator keys used to edit icons in the Gallery window: 

Window Command Menu Accelerator key 

Gallery window New File Controi+N 

Open File Controi+O 

Close File Controi+W 

Save File Controi+S 

Quit File Controi+Q 

Cut Edit Control+ X 

Copy Edit Controi+C 

Paste Edit Controi+V 

Duplicate Edit Controi+D 

Clear Edit Controi+B 

Select All Edit Controi+A 

Create Icon Controi+K 

Edit Icon Controi+E 

I mporting bitmap fi les 

You can import a bitmap file used by another program into an icon 
gallery and edit it just as you would any icon. Importing a bitmap is 
a quick way to "create" a new icon without having to draw it from 
scratch. Almost any image, including original artwork and pho­
tographs, can be scanned as bitmap files and imported into an icon 
gallery for further editing. 

Because Looking Glass icons are based on a 40-by-40 pixel grid, you 
can only import bitmaps that are 40-by-40 or smaller. If the bitmap 
is larger than 40-by-40, you must choose a 40-by-40 area to edit. 

A bitmap file doesn't include a mask; you must create the mask 
after the bitmap is imported as an icon. 
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1. Open the icon gallery you want to import the bitmap 
file into. 

2. Choose Import from the Icon menu. 

The Open Bitmap dialog is displayed: 

I bitmapst l 
f:l 
Ill l xl 

Ill 2x2 

Ill black 

lil boxes 

Ill cntr_ptr 
Ill cntr _ptrmsk 

I I [I __ II Open Bitmap canca1 Open 
- -

3. To select the bitmap file you want to import: 

• Use the scroll bar to find a bitmap file and click the one 
you want to open 
or 

• Type the first few letters of the bitmap filename 

The name of the first bitmap file beginning with the letters 
you typed is highlighted. The Icon Editor gives you two sec­
onds between keystrokes as you type the name of the bitmap 
file. For example, to find a bitmap file named "Sample 
bitmap," you would have up to two seconds after typing the 
letter "s" to type "a" for the name "Sample bitmap" to be 
found. If you take longer than two seconds to type the letter 
"a, " the Icon Editor starts the search again and finds the first 
bitmap file that begins with the letter "a." 

You can change the directory you're currently in by click­
ing the option menu above the bitmap file list and select­
ing a parent directory, or double-clicking one of the 
directories in the dialog. 

1lo Click Open. 
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If the bitmap is larger than 40-by-40, the Bitmap Selection dia­
log is displayed: 

Oloose secUon of image: � I G_n 
If the Bitmap Selection dialog is displayed, use the Selection 
tool to select a 40-by-40 section of the bitmap, then click OK. 

The bitmap file is imported into your icon gallery. You can now 
edit and save it just like any other icon. 

Exporting icons as bitmap files 

When you export an icon, you create a bitmap file that can be read 
by any application that uses the standard bitmap file format sup­
ported by your windowing system. An icon's mask is not exported 
along with the icon. 

1. In a Gallery window, select the icon you want to 
export. 

2. Choose Export from the Icon menu. 
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The Save dialog is displayed: 

0 
lil •! /.l  
m :·.;;t. 
m ula·: r 
II ll> :.:'fl-! 
Iii crttr�.Ph 
Iii CMr ! l infl•:!... 

Bitmap Nama: 

!ww;+;il+ 

save 

3. To open the directory you want to save your icon in: 

• Use the option menu and scroll bar to open a directory to 
save your icon in. Selecting a directory in the option menu 
opens the directory in the list below. Double-click a direc­
tory in the list to open it. 
or 

• In the Bitmap Name field, type the name or pathname of 
the icon you want to export. 

4:\o Click Save. 

The icon is exported to the directory you selected. 

Changing the name of an icon 

Use the Rename command to rename any icons. 

1. In a Gallery window, select the icon whose name you 
want to change. 
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2. Choose Rename from the Icon menu. 

The Rename Icon dialog is displayed: 

w Old Name: PING_PRG 

New Name: l!!iiilil&ilidl __ !!!L _______ .....J 

Rename Icon Cmlcel 1 � ----�-�-----· 1 1  
3 .  Enter a new name for the icon i n  the New Name field. 

t,;. Click OK. 

A checkmark appears next to the renamed icon in the Gallery 
window. The checkmark indicates that the icon has been 
changed since the last time the icon gallery was saved. For 
information about saving an icon gallery, refer to the "Saving 
your work" section earlier in this chapter. 

Closing a Gallery window 

When you dose a Gallery window, its name is removed from the 
list of open galleries in the Icon Editor window. 

Jl. Choose Close from the File menu in the Gallery win­
dow that you want to close. 

If you haven't made changes to the icon gallery since the last 
time it was saved, the Gallery window doses. 

If you have made changes to the icon gallery since the last time 
it was saved, the Icon Editor displays a Save dialog. In this dia­
log, you specify where to save the new icon gallery. 

For information on saving an icon gallery, refer to the "Saving your 
work" section earlier in this chapter. 



10-18 A. Looking Glass User's Guide 

Working with Editing windows 

You can use Editing windows to edit icons that you've cut or copied 
from existing Gallery windows, or to create new icons. For informa­
tion on Gallery windows, refer to "Working with Gallery windows" 
earlier in this chapter. 

NOTE: 
If you're creating a new icon in an existing icon gallery, make sure 
that you have write permission for that icon gallery. For more infor­
mation about access permissions, refer to Chapter 7, "Accessing 
information about directories and files." 

Creating a new icon 

You can create a new icon and begin editing immediately, or you 
can store several new icons in an icon gallery until you are ready to 
edit them. The icons can then be pasted into the Main Gallery, or 
merged with the Main Gallery using the icon_merge utility. 

n. Choose Create from the Icon menu in a Gallery window. 

A new, generic icon is displayed in the Gallery window. It is 
named I conl ,  and it is highlighted. Each new icon you create is 
consecutively numbered. 

A checkmark appears next to the name of the icon in the 
Gallery window, indicating that the icon has been created or 
changed since the icon gallery was last saved. 

After you create a new icon, you can edit it. For information about 
editing icons, refer to the "Using commands from the Edit menu" 
section later in this chapter. 

You can also change the name of the icon (refer to the "Changing 
the name of an icon" section earlier in this chapter) . If you don't 
rename it, the icon will be saved as Icon l .  

Opening a n  Editing window 

When you edit icons, you start by opening an Editing window. The 
Editing window is where you will work on any icons you have cre­
ated or edited before, including any icons that you have cut or 
copied from other galleries. 
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l1o T o  open the Editing window for the icon: 

o Double-click the icon 
or 

o Select the icon, then choose Edit from the Icon menu 

Each icon is edited in its own Editing window. Each Editing win­
dow has a menu bar, a tool palette, two editing areas, and four pre­
view boxes. 

Here is a typical Editing window: 

Mask --��--------------------------------� 
editing 

area 

Icon --IIF';:;;;j.j.­
editing 

area 

Tool 
pale tte 

Image Unselecbld Selecbld Mask 

Icon Icon 

The information shown in the preview boxes varies depending on 
whether you are using a monochrome or color monitor. The above 
illustration shows an icon displayed on a monochrome monitor. 

On a monochrome monitor: 

o The Image preview box reflects any changes you make to the icon 
in the icon editing area. 

o The Unselected Icon preview box displays the same image as the 
Image preview box. It shows what the unselected icon will look 
like in Looking Glass. 

o The Selected Icon preview box displays how the icon will look 
when it is selected. 

o The Mask preview box reflects any changes you make to the 
mask in the mask editing area. 
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The following illustration shows an icon displayed on a color monitor: 

Image Unselected Selected Mask 

On a color monitor: 

leon Icon 

• The Image preview box reflects any changes you make to the icon 
in the editing area. 

• The Unselected Icon preview box displays the image in the fore­
ground color with the mask behind it. The mask appears white. 

• The Selected Icon preview box displays a negative, or reversed, 
image. The image is displayed in white, and the mask appears 
behind it in the foreground color. 

• The Mask preview box reflects any changes you make to the 
mask in the mask editing area. 

When you edit an icon, you should also edit its mask so it will best 
highlight the icon. You can change all or part of the mask. A mask 
most closely resembles the icon it was created for when the icon is 
drawn as a closed-path image. A closed path is made of pixels that 
connect to form a closed shape. A circle is one example of a closed 
path image. If you create a mask for a circular icon, it appears as a 
filled-in circle in the mask editing area. However, a mask does not 
necessarily have to follow the icon design. 

In the examples above, the hourglass image is formed by "on" pix­
els. Notice that the mask doesn't follow the hourglass design; 
instead, it is a closed-path rectangle filled in with "on" pixels. 
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Examine the four preview boxes at the bottom of the Editing win­
dow to become familiar with the relationship between the icon and 
its mask. For more information on masks, refer to the "Creating a 
mask" section later in this chapter. 

You can edit any icon from any icon gallery for which you have read 
permission; however, you can only save the changes you make if you 
have write permission for the icon gallery. 

If you want to edit and save changes for the icons that came with 
Looking Glass, it's a good idea to make a "working copy" of the 
icons that you want to edit. Copy the icons you want to edit and 
paste them into a new icon gallery. This way, you can retain the 
original icons in the Main Gallery, and edit and save the copies. For 
information about cutting, copying, and pasting icons, refer to the 
"Using commands from the Edit menu" section later in this chapter. 

Some menu commands have equivalent accelerator keys. For more 
information about accelerator keys, refer to "Using accelerator keys" 
in Chapter 2, "How you interact with Looking Glass. " 

The following table shows the commands and their equivalent 
accelerator keys used to edit icons in the Editing window: 

Window Command Menu Accelerator key 

Editing window Close File Controi+W 

Undo Edit Controi+Z 

Cut Edit Control+ X 

Copy Edit Controi+C 

Paste Edit Controi+V 

Clear Edit Controi+B 

Mask Selection Edit Controi+M 

Each editing area in the Editing window is a 40-by-40 grid of squares. 
Each square corresponds to a pixel on a screen. Pixels are the individ­
ual dots that form images on a computer screen. Images in the edit­
ing areas are created when the dots are either "on" or "off" (displayed 
or not displayed). When you create or edit an icon, you are determin­
ing which pixels will be on and off within a 40-by-40 pixel area. 
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The editing area on the left of the Editing window displays the pix­
els that form the icon; the editing area on the right displays the pix­
els that form the icon's mask. For information on creating a mask, 
refer to the "Creating a mask" section later in this chapter. 

Any changes made to the icon and its mask are shown in their 
actual size in the preview boxes below the editing areas. For more 
information about preview boxes, refer to the "Creating a mask" 
section later in this chapter. 

Use the tools from the tool palette and commands from the menu 
bar to edit the icon and its mask. 

Using the tool palette 

[] 

' 
' 
' 
' 

The following tools are displayed in the tool palette on the left side 
of the Editing window. 

Use the Selection tool to select a rectangular area of an icon when 
cutting and copying, or when creating a mask for the icon. 
Dragging the mouse selects a rectangular area of the icon. When 
you release the mouse button, the area within the rectangle is 
selected. You can select any area within the 40-by-40 grid. The area 
you select is highlighted, and is ready to be cut, copied or masked. 
You can also erase the selected area by pressing the Backspace or 
Delete key. The Selection tool can also be used to select and move 
part of the icon to another area of the 40-by-40 grid. Because both 
"on" and "off" pixels are selected, the highlighted area appears 
"solid" and blocks out all the other pixels in the grid. To select the 
entire editing area, click in one of the editing areas and then dou­
ble-click the Selection tool in the tool palette. 

Use the Lasso tool to select any part of an icon. To select part of an 
icon, click the Lasso tool, and then drag around the area you want 
to select. When you release the mouse button, the selection path is 
automatically closed, and the selected area is highlighted. The Lasso 
tool can also be used to select and move part of the icon to another 
area of the 40-by-40 grid. Because only the "on" pixels are selected, 
the highlighted area appears "transparent" and does not block out 
any other pixels in the grid. To select the entire editing area, click 
in one of the editing areas and then double-click the Lasso tool in 
the tool palette. 

Use the Fill tool to fill in any closed-in area of an icon. When you 
select the Fill tool, the pointer changes to a paint can cursor. Click 
in the area of the icon you want filled in. You can include any of 
the four sides of the 40-by-40 grid to complete your closed-path 
shape. 
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Use the Pencil tool to draw or erase one pixel at a time by clicking 
the mouse, or draw a continuous line by dragging the mouse. The 
pointer changes to a pencil when the Pencil tool is selected. 
Pressing the Shift key before you start to drag constrains the line 
horizontally or vertically, depending on the direction you started to 
drag the mouse. The Pencil tool is best for detail work on the icon 
where you need pinpoint control. 

Use the Eraser tool to erase the image you drag over in the editing 
area. The pointer changes to a square when the Eraser tool is selected. 
Pressing the Shift key before you start to drag constrains the eraser 
horizontally or vertically, depending on the direction you started to 
drag the mouse. To erase the entire editing area, click in one of the 
editing areas, and then double-click the Eraser tool in the tool palette. 
It is especially helpful when you want to erase a large area of an icon. 
(fhe Pencil tool is recommended for erasing smaller areas.) 

Use the Line tool to draw straight lines one pixel wide. The pointer 
changes to a crosshair cursor when the Line tool is selected. 
Pressing the Shift key when you first start to drag constrains the 
line horizontally, vertically, or to a 45-degree angle, depending on 
the direction you started to drag the mouse. 

Use the Ellipse tool to draw an ellipse as you drag the mouse in the 
editing area. The pointer changes to a crosshair cursor when the 
Ellipse tool is selected. Pressing the Shift key when you first start to 
drag constrains the ellipse to a circle. 

Use the Rectangle tool to draw a rectangle as you drag the mouse in 
the editing area. The pointer changes to a crosshair cursor when the 
Rectangle tool is selected. Pressing the Shift key when you first start 
to drag constrains the rectangle to a square. 

1. Click the tool you want to use. 

2. Move the pointer to the editing area for the icon or 
mask. 

The pointer changes to the appropriate shape for the tool you 
selected. You can now use the tool. 

33, Click or drag the mouse to make the changes you 
want. 

As you edit the icon, you can see what your changes look like 
in the preview boxes below the editing areas. 

You can use the Undo command from the Edit menu to undo 
the last action performed. 
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Using commands from the Edit menu 

You can use the Edit menu in an Editing window to cut, copy, and 
paste icons, as well as clear icons, undo the last action performed, 
and create a mask for icons.  

1.  Use the Selection tool or Lasso tool to select the whole 
icon or part of the icon. 

NOTE: 
Don't use the Selection or Lasso tool if you want to use the 
Undo or Paste command. 

�, From the Edit menu, choose: 

• Undo to reverse the last action performed 

• Cut to remove the icon or part of the icon from the editing 
area to the clipboard 

• Copy to copy the icon or the selected part of the icon to 
the clipboard 

• Paste to place the icon or part of the icon from the clip­
board to the editing area (cutting or copying an object to 
the clipboard replaces any previously placed object) 

• Clear to remove the icon or part of the icon without saving 
it on the clipboard 

•. Mask Selection to create a mask for the icon or part of the 
icon you selected 

The images you cut or copy are stored on the clipboard, a tem­
porary holding area. Because you can only perform one cut or 
copy action at a time, you lose the images stored on the clip­
board when you cut or copy a new image to the clipboard. 

Creating a mask 

A mask is used to give an icon its highlighted appearance when it is 
selected. A selected icon generally appears as the negative, or 
reverse image, of an icon. It's important for an icon to have a mask 
so you can tell the difference between selected and unselected icons 
as you work. 
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The following illustration shows a side view of an icon separated 
into three layers. The unselected icon, or the bottom layer, is repre­
sented by the picture on the right. If you select the entire icon and 
choose Mask Selection from the Edit menu, the Icon Editor pro­
gram creates the mask, represented by the middle layer. The 
selected icon is shown in the top layer, represented by the picture 
on the left. 

Mask created ----------+ 
by the Icon 

Editor program 

Selected icon 

If you examine the top and bottom of the hourglass, you'll notice 
the "on" pixels in the unselected icon and the "on" pixels in the 
mask have cancelled each other out, and are "off" in the selected 
icon, so there is no top or bottom to the hourglass icon. 

Similarly, the hourglass design in the unselected icon is formed by 
"on" pixels. The unselected icon layer is masked by "on" pixels in 
the mask layer, so the design is reversed in the selected icon layer. 
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Beg in with 
unselected icon 

Edit the 
created by the 

Icon Editor to 
achieve the 

effect you want 

As you click 
"off" in the 

the pixels in the 
selected icon 
appear "on" 

If you want the top and bottom base of the hourglass to appear in the 
selected icon, you'll need to edit the mask layer created by the Icon 
Editor program. The following illustration shows the mask being 
edited so that the hourglass icon will have a top and bottom base. 
You can use the Pencil tool from the tool palette to turn the mask 
pixels "off." As you turn off the mask pixels that make up the bases, 
the pixels that are "on" in the unselected layer are "unmasked" and 
the bases will appear in the selected icon. 

An unselected icon looks a little different on a color monitor. Pixels 
that are "on" in the unselected icon and "on" in the mask are "on" 
in the selected icon, rather than "off," as it is displayed on a 
monochrome monitor. The Icon Editor program creates a white 
mask, so that when the icon is selected, the image appears white 
and the mask appears in the foreground color. 

Changing al l  or part of the mask 

1. Use the Selection Tool to select all or part of the icon. 

�0 Choose Mask Selection from the �dit menu. 

The Icon Editor examines the part of the icon you selected and 
makes its best guess at what the mask should look like. After the 
mask is created, you can edit it to achieve the effect you want. 
You can edit the mask the same way that you edit icons, and 
view your changes in the preview boxes at the bottom of the 
Editing window. 
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After you edit an icon, a checkmark appears next to the icon's 
name in the Gallery window. The checkmark disappears when 
you save the Gallery window. 

Closing the current Editing window 

1. Choose Close from the File menu in the Editing win­
dow you want to close. 

� o Ciick: 

• Yes to close the Editing window and save the changes you 
made to the icon 

• No to close the Editing window without saving the changes 
you made to the icon 

• Cancel to cancel the Close command and leave the Editing 
window open 

Saving the changes to the icon and mask 

1. Click in the Gallery window where you want to save 
the icon and mask. 

:ilo Choose Save from the File menu. 

The checkmark next to the icon disappears and the changes to 
the icon and mask are saved. 

Installing new icons 

Before Looking Glass can use a new icon to represent directories or 
files on your system, you must first perform two steps. 

To be accessible to Looking Glass, the icon must be in the Main 
Gallery, lg_ icons . d. For instructions on putting new icons into the 
Main Gallery, refer to the "Merging icon galleries" section later in 
this chapter. If the new icon is going to replace an existing icon, 
make sure it has the same name as the existing icon so that the 
existing icon is overwritten by the new one. In this case, no modifi­
cation of the file typing rulebase is necessary, and Looking Glass 
uses the new icon correctly. 
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If the new icon isn't going to replace an existing icon with the same 
name, you must modify the file typing rulebase. A file typing rule 
must be created that tells Looking Glass how to identify the type of 
directory or file the icon is going to represent, and what actions to 
perform when files of that type are activated. For information about 
assigning an icon to a file type, refer to Chapter 13,  "Defining file 
types, " or see your system administrator. 

Merging icon galleries 

Looking Glass uses the contents of a single icon gallery, lg_ i cons . d, 
as its icon source. To maintain the integrity of the icons shared by 
all Looking Glass users, this Main Gallery should be owned by the 
super-user and protected from changes by other users. Users should 
create or modify icons in galleries that they own. When users are 
ready to put new or changed icons into the Main Gallery, the sys­
tem administrator can help them gain temporary access to the 
Main Gallery or to a copy of the Main Gallery. 

There are two ways to put new or changed icons into an icon 
gallery: 

• Use the Icon Editor's copy and paste commands 
• Use the icon_ merge utility 

For information on the first method, using the copy and paste com­
mands, refer to "Working with Gallery windows" earlier in this 
chapter. 

Using the icon_merge utility 

The icon_ merge utility merges one or more icon galleries into a sin­
gle gallery. The output file contains all uniquely named icons from 
each of the input icon files, as well as any icons that were already in 
the output file. If you are not experienced using operating system 
utilities, ask your system administrator for assistance. 

Here is the syntax of the icon_ merge utility: 

ican�rge [ -v ]  [ -n )  inputfi l e  . . .  [ -o output fi l e ]  

The -v flag tells icon_ merge t o  report o n  its status a s  i t  opens and 
merges each icon file. 
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The -n flag tells icon_ merge to exit immediately if a duplicate icon 
name is encountered. If this flag is not specified, icon_ merge 
retains the first icon with a given name and discards duplicates 
without notification. 

inputfile specifies the file or files that are to be merged. Any number 
of files can be merged. 

outputfile specifies the file into which the merged output is to be 
placed. It can be an existing icon gallery. The -o flag must precede 
any output file specification. If output file is not specified, the out­
put is placed in a file named icons . out . 

The icon _merge utility issues appropriate exit codes. These codes 
allow you to run the program from a shell script and take action 
based on the outcome of the merge operation. 
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The following table lists the exit codes issued by i con_merge : 

Retum code 

0 

2 

3 

4 

5 

6 

Meaning 

All input files were successfully merged into 
the output file, and the output file was suc­
cessfully written. 

The command line used to invoke 
icon_ merge was incorrect. 

The merge fai led because of a duplicate icon 
(the -n flag was given). 

The merge failed because an input file could 
not be read. 

The output file could not be written. The 
original version of the output file has been 
restored. 

The dialog manager could not be initialized. 
You may need to set the value of your DIS­
PLAY environment variable. 

icon_ merge failed as the result of an 
unknown problem. 
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In this chapter, you'll learn how to use the Environment Variables command from 
the Show menu to view, edit, add, and remove environment variables. 
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What are environment variables? 

Environment variables provide a short-hand way to insert data into 
a command line or directory path and to pass information between 
programs. 

Standard environment variables contain information about your 
operating environment, such as the pathname of your home direc­
tory (HOME) and your search path (PATH) . You can't change or 
delete the name of some standard environment variables, but you 
can change their contents. The variables whose names you can't 
change or delete include: 

• HOME 
• PATH 
• TERM 

You can also use environment variables with the command-line 
feature in Looking Glass. For more information about the com­
mand-line feature, refer to "Using the Looking Glass command 
line" in Chapter 8, "Running programs." 

To use an environment variable in a Looking Glass text field or in 
another shell, enter a dollar sign ($) and the variable name. Looking 
Glass, or another shell, will substitute the value of the variable at 
the point where the variable appears in the field. 

Looking Glass automatically exports environment variables so that 
any program run by Looking Glass will inherit the current list of 
variables. 

NOTE: 
Looking Glass uses the environment variable LG_FEATURE_SET to 
determine whether certain file typing rules will be used. For more 
information about LG_FEATURE_SET, refer to Chapter 13 ,  
"Defining file types. "  
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Editing environment variables 

1 .  Choose Environment Variables from the Show menu 
in the Global window. 

The Environment Variables dialog is displayed: 

Name 

DISPLAY 

HOME 

PATH 

SHELL 

TERM 

USER 

Value 

prelude 0 

/usrlhal 

/usr/hal/bln/DECMIPS:IusrlhaVbinJusr�ocaVbin:/u 

/bin/csh 

vll 00 

hal 

Remove I I  Add... I I  Edit. . .  I I  Save... I I  Oose 

2. Select the variable you want to edit. 

3. Click Edit. 

The Edit Variable dialog is displayed: 

Name: TERM 

Edit Variable cancel I II OK II 

4. Edit the Name and/or Value fields. 

5. Click OK. 

The Edit Variable dialog closes. 
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rfii o Click: 

• Add to add a new environment variable 
• Remove to delete an environment variable 
• Edit to edit an environment variable 
• Save, and then Yes, to save the changes you made 
• Close to leave the dialog 

Adding environment variables 

1. Choose Environment Variables from the Show menu 
in the Global window. 

The Environment Variables dialog is displayed. 

2.  Click Add. 

The Add Variable dialog is displayed: 

Name:�===========;;: 
�

e
: l I 

Add variabl
e 

3. Enter the name of the variable in the Name field. 

4. Enter the value for the variable in the Value field. 

S. Click OK. 

The Add Variable dialog closes. 

rlii o Click: 

• Add to add a new environment variable 
• Remove to delete an environment variable 
• Edit to edit an environment variable 
• Save, and then Yes, to save the changes you made 
• Close to leave the dialog 
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Removing environment variables 

1. Choose Environment Variables from the Show menu 
in the Global window. 

The Environment Variable dialog is displayed. 

2. Select the variable you want to remove. 

3. Click Remove. 

The variable is deleted. 

NOTE: 
When you remove an environment variable created by Looking 
Glass and save your changes, it is permanently removed. 
However, your external shell also defines environment variables 
that Looking Glass adds to its own list of variables at startup 
time. When you remove an environment variable created by 
your external shell using Looking Glass and save your changes, 
the variable is only removed from Looking Glass's list of vari­
ables. It will appear again the next time you start Looking Glass 
if it is defined by your external shell. 

4\o Click: 

• Add to add a new environment variable 
• Remove to delete an environment variable 
• Edit to edit an environment variable 
• Save, and then Yes, to save the changes you made 
• Close to leave the dialog 



'• !. 



Changing Looking Glass 
preferences 
This chapter tells you how to set and change your Looking Glass preferences. 
Preferences are options that control the operation of Looking Glass-use them to 
specify your personal preferences for the way Looking Glass does certain things. 

With the System menu in the Global window, you can: 

• Use the Color Preferences command to change the color of all Looking Glass 
user interface elements 

• Use the Removal Preferences command to tell Looking Glass when to ask for 
confirmation before you delete a directory or file 

1 2  

• Use the Execution Preferences command to specify which program to use for dis­
playing terminal emulator windows, which text and data editors to use, which 
external shell to use, and how to format and spool a file to be printed 

• Use the Creation Preferences command to define a creation mask and define 
default access permissions for new directories and files 

• Use the Cleanup Preferences command to change the grid on which directories 
and files are aligned when you use the Cleanup command in Directory windows 

• Use the Display Preferences command to change the default characteristics of 
new Directory windows, including their size, display format, and the arrange­
ment of directories and files 

• Use the Operational Preferences command to control the size of the copy buffer, 
the limit for file size, the double-click speed, and the action Looking Glass per­
forms when you double-click a directory 

NOTE: 
You may need help from your system administrator to set some preferences 
correctly. 
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Changing color preferences 

Top shadow color 

If you have a color monitor, you can change the colors of user 
interface elements with the Color Preferences command from the 
System menu in the Global window. If you don't have a color mon­
itor, the Color Preferences command is dimmed. 

With the Color Preferences command, you can change the color 
used to display the following elements: 

• Background 
• Foreground 
• Top shadow 
• Bottom shadow 

Background is the "canvas" that objects are drawn on. For example, 
the workspace area behind directories and files displayed in 
Looking Glass. 

Foreground is what is drawn on the "canvas." For example, text, 
icons, buttons, and check boxes. 

Top shadow is the shadow that appears on the top and left edges of 
three-dimensional objects. 

Bottom shadow is the shadow that appears on the bottom and right 
edges of three-dimensional objects. 

If you are using the two-dimensional look and feel, the top shadow 
and bottom shadow elements are not used. 

Here is an example of background, foreground, top shadow, and 
bottom shadow elements: 

Foreground color 

Background color 

The following paragraphs give you some guidelines for setting your 
color preferences. 
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If you are using the two-dimensional look and feel for Looking 
Glass, the foreground color should stand out well against the back­
ground color. 

If you are using the three-dimensional look and feel for Looking 
Glass, the top shadow color should be the lightest color. It is a good 
idea to use a color similar to the background. For example, if you 
set the background to a blue hue, the top shadow should have a 
blue hue, but should be a much lighter shade. The bottom shadow 
color should be the darkest color. It should also be similar to the 
background, but should be a much darker shade. The foreground 
color should stand out well against the background color. 

There are three ways to specify colors in Looking Glass: 

• The Name method, where you choose a color from a list 

• The Hue, Saturation, Brightness (HSB) method, where you 
adjust the hue, saturation, and brightness values to specify a 
color 

• The Red, Green, Blue (RGB) method, where you adjust the red, 
green, and blue values to specify a color 

HINT: 
A fast way to choose a color is to use the Name method to pick the 
basic color and then use the RGB or HSB option to adjust the color. 

Accessing the Color Preferences dialog 

1. Choose Color Preferences from the System menu in the 
Global window. 
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The Color Preferences dialog opens. This dialog displays the col­
ors that Looking Glass currently uses for the four user interface 
elements: 

Set bal:kgrDUnd color ••• 

set foreground color ••• 

set top shadow color • • •  

I set bottom shadow color ... I 
lllange System Colors 

c==J 
-
-
-

�0 Select the button for the user interface element you 
want to change or adjust. 

The Name, HSB, or RGB or dialog is displayed: 

Name dialog ----1+-

aquamarine 
medhun aquamarine 
blal:k 
blUe 
cadet blUe 
comllower blUe 

Pick Baclcground Color 

The color readout box in the upper right corner of the dialog 
shows the color currently used for the selected element. When 
you adjust the color, the top half of this box changes to show 
the new color; the bottom half displays the original color. 

Use one of the three methods to change the color of the selected 
element. 

Using the Name method 

1. Choose Name from the option menu (below the color 
readout box). 

A scrolling list of colors appears on the left side of the dialog. 
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2. Select a color. 

The top half of the color readout box changes to show the 
selected color. You can return to the original color by clicking 
the bottom half of the color readout box. 

33, Click OK. 

Using the HSB method 

1. Choose HSB from the option menu (below the color 
readout box). 

2. To define the new color, drag the: 

• Hue slide arrow to set the base color 

• Saturation slide arrow to set the amount of the base color 
displayed 

• Brightness slide arrow to make the color lighter or darker 

The top half of the color readout box displays the changes you 
make. You can return the slider arrows to their original posi­
tions by clicking the bottom half of the color readout box. 

33, Click OK. 

Using the RGB method 

1. Choose RGB from the option menu (below the color 
readout box). 

2. To define the new color, drag the: 

• Red slide arrow to set the amount of red in the color 
• Green slide arrow to set the amount of green in the color 
• Blue slide arrow to set the amount of blue in the color 

The top half of the color readout box displays the changes you 
make. You can return the slider arrows to their original posi­
tions by clicking the bottom half of the color readout box. 

33, Click OK. 
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Changing removal preferences 

Use the Removal Preferences command from the System menu in 
the Global window to tell Looking Glass when to ask you for confir­
mation before removing directories and files. 

There are two categories of removal options: one for files and one 
for directories. 

When you select the Removal Preferences command from the 
System menu in the Global window, the Removal Preferences dia­
log is displayed: 

File Removal----, 
Ill COnfinn Single 
Ill COnfinn Multiple 
0 COnfinn Read- Only 

Set Removal Preferences I 

DireciDry Removal­
+ COnfinn All 
<> COnfinn Non- Empty 
<> Don't COnfinn 

1. Choose Removal Preferences from the System menu in 
the Global window. 

2. Select: 

• Confirm Single if you want Looking Glass to ask you for 
confirmation before it removes each file 

• Confirm Multiple if you want Looking Glass to ask you for 
confirmation before it removes more than one file 

• Confirm Read-Only if you want Looking Glass to ask you 
for confirmation before it removes files with read-only pro­
tection 

• Confirm All if you want Looking Glass to ask you for con­
firmation before it removes each directory 

• Confirm Non-Empty if you want Looking Glass to ask you 
for confirmation before it removes each directory that con­
tains subdirectories or files 

• Don't Confirm if you never want Looking Glass to ask you 
for confirmation before it removes a directory 

33o Click OK. 
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Changing execution preferences 

Use the Execution Preferences command from the System menu in 
the Global window to specify programs (along with any needed 
arguments) that Looking Glass executes when you run certain 
programs. 

You can change the programs used for: 

• A terminal emulator 
• Editing a text file 
• Editing a non-text ("data") file 
• Functions handled by an external shell 
• Formatting and printing text files 

When you select the Execution Preferences command from the 
System menu in the Global window, the Execution Preferences 
dialog is displayed: 

Tenninal Program:.�IMtlill!iiQIQI![I! ========� 
Ill Looking Glass Assigns POsition 

Text Editor:ltusr/ucb/vi �� ; lg pause 
Ill Run In !lew Tenninal Emulator Window 

Data Editor:'="--------------' 
1!!11 Hun in tt<�w l(mnilml E:nlulo:d . .or \Ylndow 

External Shen:lfb::::inl=s=h==========:::::: Print Fonnatter: 1/bin/pr tf 

Print Spooler: l�/u::,.:/u:c�b/:lpr
=========� 

Set Execution Preferences Cancel I � OK _ IJ 

Specifying a terminal emulator 

The Terminal Program field in the Execution Preferences dialog 
allows you to specify the pathname of the program you want 
Looking Glass to execute when you select Terminal Emulator from 
the Run menu, and when you use commands that must be run in a 
terminal emulator. 

You can also have Looking Glass determine the position of terminal 
emulator windows on the workspace by selecting the Looking Glass 
Assigns Position check box (below the Terminal Program field). If 
the check box isn't selected, the window manager determines the 
position. 



12-8 A. looking Glass User's Guide 

To specify a terminal program: 

1. Choose Execution Preferences from the System menu 
in the Global window. 

2. Edit the Terminal Program field. 

Include any arguments you would use if you were invoking the 
program from a shell command prompt. 

3. Select the Looking Glass Assigns Position check box if 
you want Looking Glass to determine the position of 
the terminal emulator window. 

If you want to determine the position of the window yourself, 
make sure the check box is not selected. 

4J" Click OK. 

Specifying text and data editors 

The Text Editor and Data Editor fields in the Execution Preferences 
dialog display the pathnames and arguments for the programs you 
want Looking Glass to execute when you double-click a text or data 
file. 

If you want to change your text or data editor, make sure you know 
the syntax used to invoke the program. If you enter just the path­
name of the editor, Looking Glass assumes it takes a filename as its 
only argument. 

For example: 
If you enter: 

/usr/bin/emacs 

in this field, Looking Glass executes the command: 

/usr/bin/emacs fi lename 

when you double-click a text file (fi lename is the name of 
the file you double-clicked). 
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Some editors and word processors may require additional command­
line arguments to edit a file. They may also need to have the filename 
in a spedfic position in the command line. If you want the editor 
called with command-line arguments, or if you want to run a shell 
script that runs your editor, you must insert the Looking Glass special 
symbol for selected files (#f) in the appropriate place in the com­
mand line. 

For example: 
If all of your text files are encrypted, you may want to use the 
editor vi with the -x argument. (This argument allows you 
to edit encrypted files.) In this case you would enter: 

/usr/bin/vi -x #f 

This causes Looking Glass to execute the vi editor with the -x argu­
ment. When you open a text file, its name is inserted where the #f 
sign appears in the command line. 

If the text or data editor you use does not create its own window, it 
must be run in a new terminal emulator window. If you tell 
Looking Glass to run your editor in a terminal emulator window, 
we also recommend that you put the lg_pause command after the 
command that calls the editor (see the example below). 

To tell Looking Glass to run your editor in a new terminal emulator 
window, select the Run In New Terminal Emulator Window check 
box, which is immediately below the Text Editor or Data Editor 
field in the Execution Preferences dialog. 

If you want to read any exit messages from your editor or other pro­
gram before its window disappears, put the lg_pause command 
after the command that calls the editor. The lg_pause command 
provided with Looking Glass prompts you to press the Return key 
before exiting the terminal emulator window. When you use 
lg_pause, you must specify the position of the filename in the 
command line using the Looking Glass special symbol for selected 
files (#f) .  

For example: 
To use the editor vi as your text editor, select the Run in 
New Terminal Emulator Window check box and enter the 
following in the Text Editor field: 

/usr/bin/vi #f ; lg_pause 

Note the use of the semicolon between the command that runs the 
editor and lg_pause; this causes lg_pause to run after the editor 
has exited. 
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To run a shell script that runs your editor, enter the full pathname 
of your shell, the full pathname of the shell script it will execute, 
and #f .  

For example: 

/bin/sh /usr/hal /edscript #f 

To specify a text or data editor: 

I. Choose Execution Preferences from the System menu 
in the Global window. 

2. Edit either the Text Editor or Data Editor field. 

Include any necessary programs and arguments. 

If the editor you specify does not create its own window, select 
the Run In New Terminal Emulator Window check box (below 
the Text Editor or Data Editor fields). 

3�" Click OK. 

Specifying an external shell 

The External Shell field in the Execution Preferences dialog displays 
the pathname of the shell Looking Glass uses for any operation that 
requires an external shell, for many double-click actions, and for 
the Terminal Emulator command from the Run menu in the Global 
window. 

If you want to change the shell, enter the full pathname of the shell 
in the External Shell field. We recommend that you use the Bourne 
Shell (sh), the C Shell (csh), or the Korn Shell (ksh). 

I. Choose Execution Preferences from the System menu 
in the Global window. 

2. Edit the External Shell field. 

3l" Click OK. 
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Specifying commands for printing 

When Looking Glass prints a file, it uses two commands: one to for­
mat the file and one to spool it to the printer. These two commands 
are displayed in the Print Formatter and Print Spooler fields in the 
Execution Preferences dialog. 

The formatter command processes the file for printing-it may pag­
inate the document or put in headers. The spooler command 
receives the data produced by the formatter command and sends it 
to the printer. 

When you select the Print command from the File menu, Looking 
Glass checks to see if a special formatter command is defined for 
that type of file. If there is one, Looking Glass uses it. If there is no 
special command, Looking Glass uses the command specified by 
your execution preferences. For more information about file types, 
refer to Chapter 13, "Defining file types. "  

The output o f  the formatter command i s  then sent to  the spooler 
command specified by your execution preferences. 

To determine the correct values for the Print Formatter and Print 
Spooler fields, take the full command string you would normally 
use to print files and split it at the pipe symbol. Put the first half of 
the command in the Print Formatter field. Looking Glass assumes 
that the filenames of the files to be printed are inserted at the end 
of the print command. If the filenames belong somewhere other 
than the end of the command, you need to insert the special sym­
bol for selected files (#f) where the filename should be placed. Put 
the second half of the command in the Print Spooler field. 

Looking Glass supplies the pipe symbol at execution time. 

For example: 
If you would normally print a file by entering on the com­
mand line: 

pr filename I lp 

you enter: 

pr or pr #f in the Print Formatter Field and lp in the Print 
Spooler field. 

To specify print commands: 

1. Choose Execution Preferences from the System menu 
in the Global window. 
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2. Edit the Print Formatter and Print Spooler fields. 

3lo Click OK. 

Changing creation preferences 

Use the Creation Preferences command from the System menu in 
the Global window to define a creation mask and default access 
permissions (protection modes) for new files and directories you 
create in Looking Glass. 

A creation mask blocks out certain permissions for new files and 
directories. Creation masks are important for maintaining security. 
If you have used Looking Glass to set access permissions, you know 
that you select check boxes to allow permissions. The creation 
mask works in the opposite way-you select check boxes to exclude 
permissions. 

For example: 
If you select the W (write) check box for Group when defin­
ing a creation mask, other members of your group will not 
be given write permission for new files you create. 

When you define a creation mask, you also need to tell Looking 
Glass which creation mask to use when you start up Looking Glass: 
the mask already defined for that environment or a new mask that 
you want to define. You can use the Store Mask button or Inherit 
Mask button to do this. 

Default access permissions are permissions you set that are auto­
matically assigned to new files and directories you create. 
Therefore, any permissions that you block using the creation mask 
cannot become default access permissions. 

When you select the Creation Preferences command from the 
System menu in the Global window, the Creation Preferences dia­
log is displayed: 
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Oeation Mask-
R W X DOD • store Mask D O D  owner 

O D D  Group 0 Inherit Mask 

D O D  OUu!rs 

File Access -
R W X 

11 11  D owner  
1!11 D O  Group 
O D D  Olllers 

640 

Set FDe Oeation Defaults I 

Directory Access-
R W X 

11 11 11  owner 
II D II Group 
D D D Olllers 

750 

cancel I ll. __ 
OK 
·��·····�··· �JI 

Defining creation masks for new directories and files 

1. Choose Creation Preferences from the System menu in 
the Global window. 

2. To tell Looking Glass which creation mask you want 
to use, select: 

• Store Mask to tell Looking Glass that you want to specify, 
store, and use your own creation mask 
or 

• Inherit Mask to tell Looking Glass to use the creation mask 
already defined for your environment the next time you 
log in 

3. In the Creation Mask section, select the check boxes 
for the permissions you want to block out for new 
files and directories (see the table below). 

As you select check boxes in the Creation Mask section, notice 
that the corresponding check boxes are removed from the Files 
and Directories sections. 

For example: 
If you select the X (execute) check box for Owner in the 
Creation mask section, the check box in the X column for 
Owner is removed from the Files and Directories sections. 

The number displayed in the upper right corner of the creation 
mask area shows the selected creation mask in octal (base 8) 
notation. 

4.l. Ciick OK. 
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The following table describes the permissions you can block out 
for new directories and files: 

If you select this 
permission: 

R (read) 

W (write) 

X (execute) 

For directories: 

Their contents can't be 
viewed 

Subdirectories and files 
can't be put into them 

Subdirectories and files 
can't be removed from 
them 

They can't be opened 

For flies: 

Their contents can't 
be viewed 

Their contents can't 
be changed 

They can't be run as 
commands 

Defining default access permissions for files and directories 

1. Choose Creation Preferences from the System menu in 
the Global window. 

2. In the Files and Directories sections, select the check 
boxes for the permissions you want to assign for new 
files and directories (see the table below). 

Notice that the octal code changes as you select and unselect 
permissions. 

33" Click OK. 

The following table describes the permissions you can assign to 
new directories and files: 
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If you select this 
permission: For directories: For files: 

R (read) Their contents can be Their contents can be 

viewed viewed 

W (write) Subdirectories and files Their contents can be 

can be put into them changed 

Subdirectories and files 
can be removed from 
them 

X (execute) They can be opened They can be run as 
commands 

Changing cleanup preferences 

The Cleanup Preferences command lets you control the grid that 
directories and icons line up on when you use the Clean Up com­
mand in a Directory window. 

When you select the Cleanup Preferences command from the 
System menu, the Cleanup Preferences dialog is displayed: 

<> Name + lcun 

I [!J 
File 1 S<ew 

II [±J 
File 5 Space 

_I I . . . 
set Oeanup 1'11!ferences 

II 
File 2 

I 
File 6 

� El 

II • 
File 3 File 4 

I • 
File 7 File B 

I • 
Revert I I C3ncel I � O�m Jj 

I. Choose Cleanup Preferences from the System menu in 
the Global window. 
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2. Select: 

• Name to change how directories and files will be displayed 
in Name view when cleaned up 
or 

• Icon to change how directories and files will be displayed 
in Icon view when cleaned up 

The preview area contains small icons for Name view and large 
icons for Icon view. Notice that the top two icons in the second 
column are named Skew and Space. When you click one of 
these objects, your cursor turns into an arrow that shows you 
which direction you can move the object. 

3. Drag: 

• The Skew icon to move the entire column of objects up or 
down so that every other column is staggered 

• The Space icon to move the objects closer together or far­
ther apart in the grid 

4\o Click: 

• Revert to change the grid in the preview area back to its 
original layout without closing the dialog 

or 

• Cancel to close the dialog without saving the changes 

or 

• OK to save the changes and close the dialog 

Changing display preferences 

You can change the following default display options: 

• How Directory window titles are displayed 
• The size of new Directory windows 
• Whether hidden files are displayed in Directory windows 
• The position of the splitter in new Directory windows 
• The display format for new Directory windows 
• How directories and files are arranged in Directory windows 

when you use the Clean Up command 
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When you select the Display Preferences command from the 
System menu in the Global window, the Display Preferences dialog 
is displayed: 

[Directory YnndoW Titles 
Ill Include Host Name Ill Include FuD Pathnama I 

Size: 

[g] :-::.� . J <> Rt To FUes 
<> Rt To lllrec-

I 0 FosiU...- 0 Show Hidden I 

Set Display l'l'l!ferences I cancel I � 
Specifying how Directory window titles are displayed 

Use the Directory Window Titles section of the Display Preferences 
dialog to specify how titles are displayed in Directory windows. 

1. Choose Display Preferences from the System menu in 
the Global window. 

2. In the Directory Window Defaults section of the 
dialog, select: 

· 

• Include Host Name to display the host name of the system 
you are logged into in the title bar of each Directory 
window 

• Include Full Pathname to display the full pathname of the 
directory in the title bar of each Directory window 

33. Click OK. 

Specifying the size of new Directory windows 

Use the Size section of the Display Preferences dialog to specify the 
default size of new Directory windows relative to your display. 
When a Directory window opens, it will appear at the size you 
specified. 
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Drag here to set the 
default size of new 
Directory windows 

1. Choose Display Preferences from the System menu in 
the Global window. 

The Display Preferences dialog is displayed: 

r Directory Window TIUes 
� II Include Host Name II Include RID PaUmame I 
Size: 

g)-J + Leave /Irs Is 
0 At To FDes 
<> At To Directories 

I 0 Fosltlonable 0 Show .-n I 

Set Display fftfereru:es I C8ncel I II OK I! 
The rectangle on the left side of the dialog represents the size of 
a Directory window. The larger, outer rectangle represents the 
size of your screen. 

2. In the Directory Window Defaults section, drag the 
small shaded box in the lower right corner of the box 
that represents a Directory window to set the default 
size of new Directory windows. 

3lo Click OK. 

Specifying the display format for directories and files 

Directories and files can be displayed in Directory windows by their 
name or icon or in a wide format. For more information about 
these views, refer to "Changing display formats in Directory win­
dows" in Chapter 4, "Working with Directory windows." 

Use the View section of the Display Preferences dialog to specify the 
default display format. 

1. Choose Display Preferences from the System menu in 
the Global window. 
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2. Select: 

� Name if you want directories and files displayed in alpha­
betical order by name 
or 

• Icon if you want to view directories and files by their icon 
or 

• Wide if you want to view directories and files in a wide, 
detailed format 

33o Click OK. 

Specifying whether directories and files are positionable 

When a Directory window is in the non-positionable format, it con­
tains a splitter. The splitter is a horizontal bar that divides the win­
dow into two sections. The top section contains the subdirectories 
and the bottom section contains the files. 

Use the Splitter section of the Display Preferences dialog to change 
the default so that Directory windows open without the splitter and 
the directories and files can be positioned anywhere in their 
windows. 

1. Choose Display Preferences from the System menu in 
the Global window. 

2. Select Positionable. 

33o Click OK. 

Specifying whether hidden files are displayed in Directory windows 

Hidden files are directories and files whose names begin with " . "  
(with the exception of  the current and parent directories). These 
directories and files are not shown by default because the " ."  prefix 
is often used in naming system configuration files or data files that 
users rarely need to view. 

You can use the Display Preferences dialog to change the default so 
that hidden files are displayed automatically when a Directory win­
dow opens. 
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1. Choose Display Preferences from the System menu in 
the Global window. 

2. Select Show Hidden Files. 

�. Click OK. 

Specifying the default position of the splitter in Directory windows 

Use the Splitter section of the Display Preferences dialog to specify 
the default position of the splitter in Directory windows. 

1. Choose Display Preferences from the System menu in 
the Global window. 

If you want the splitter to automatically appear in your 
Directory windows, select Positionable in the Directory 
Window Defaults section of the dialog. 

2. In the Directory Window Defaults section of the d a­
log, select: 

• Leave As-Is to position the splitter the same as it was i 1 the 
Directory window that you opened the directory from. 
or 

• Fit Splitter To Files to position the splitter so that as n any 
of your files are displayed as possible (this may make the 
file section of the window larger than the directory section) 
or 

• Fit Splitter To Directories to position the splitter so that as 
many of your directories are displayed as possible (this may 
make the directory section of the window larger than the 
file section) 

3l. Click OK. 

Changing operational preferences 

The Operational Preferences dialog allows you to control the 
following: 

• The size of the Copy buffer 
• The limit for file size 
• The double-click speed 
• The action Looking Glass performs when you double-click a 

directory 
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When you select the Operational Preferences command from the 
System menu, the Operational Preferences dialog is displayed: 

Olpy BUffer Slze:l:=:J K File stze lhnlt: lzo971 51 fK 
-Double- a!ck Speed -Directory Double-a!ck Action 

<> Slow <> Cllntroi-Double-a!ck Opens Hew Window 
• Medium • Double- a!ck Opens Hew Window 
<> Fast 

S8conds Between Display Updates: D 
Set Opera- Praferences I Olncel I ll OK II 

Specifying the size of the Copy buffer 

Use the Copy Buffer Size field in the Operational Preferences dialog 
to specify the size of the Copy buffer Looking Glass uses when it 
copies files in 1K (1024 byte) increments. 

Looking Glass uses this memory to hold file contents between read 
and write operations to the disk. The larger the buffer size, the more 
efficiently Looking Glass can copy large files. Buffer size makes little 
difference when you copy small files. If you regularly move very 
large files, you should set this to a value between 4K and 16K. 

1. Choose Operational Preferences from the System menu 
in the Global window. 

2. Enter a number for the size of the Copy buffer in the 
Copy Buffer Size field. 

3l. Cllck OK. 

Specifying the limit for file size 

Use the File Size Limit field to change the file size limit in Looking 
Glass. The size must be in 1K (1024 bytes) increments. Users can 
reduce the file size limit, but only the super user can increase the 
file size limit. 

1. Choose Operational Preferences from the System menu 
in the Global window. 
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2. Enter a number in the File Size Limit field. 

33o Click OK. 

Specifying a double-click speed 

Looking Glass lets you choose how fast or slow you double-click a 
mouse button. Looking Glass matches the time it takes you to dou­
ble-click an object. 

1. Choose Operational Preferences from the System 
menu in the Global window. 

2. After the Double-Click Speed prompt, select: 

• Slow if you want to take a long amount of time between 
clicks 
or 

• Medium if you want to take a medium (or average) 
amount of time between clicks 
or 

• Fast if you want to take a very short amount of time 
between clicks 

33o Click OK. 

Specifying a directory double-click action 

By default, Looking Glass opens a new Directory window when you 
double-click a directory. In other words, a Directory window opens 
for each directory you double-click. 

However, if you hold down the Control key and double-click a 
directory, Looking Glass displays the contents of that directory in 
the current Directory window (no new window is opened) . In other 
words, the contents of the directory you double-click replaces the 
contents of the directory currently displayed in that Directory 
window. 

With the Operational Preferences dialog, you can indicate which 
double-click action you prefer as your default. You can specify 
whether you want to double-click or Control+double-click to open 
a new Directory window for each new directory. 
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1.  Choose Operational Preferences from the System menu 
in the Global window. 

2. After the Directory Double-Click Action prompt, 
select: 

• Control+Double-Click Opens New Window to tell 
Looking Glass to use the Control+double-click mouse 
action to open a new Directory window 
or 

• Double-Click Opens New Window to tell Looking Glass 
to use the double-click mouse action to open a new 
Directory window 

33, Click OK. 

Specifying the number of seconds between display updates 

Use the Seconds Between Display Updates field in the Display 
Preferences dialog to specify how frequently you want Looking 
Glass to update Directory windows to reflect the current status of 
the directory. 

For example: 
If you enter 1 in this field, Looking Glass examines the dis­
played directories every second to determine if changes have 
been made to the displayed directories and updates the 
appropriate windows. 

1. Choose Display Preferences from the System menu in 
the Global window. 

2. Enter the number of seconds in the Seconds Between 
Display Updates field of the dialog. 

33o Click OK. 





Defining file types 

In this chapter you'll learn: 

• How file typing works 
• The general capabilities of the File Typing Language 
• How to define, compile, and install file typing rules 

This chapter also contains a File Typing Language reference and an annotated file 
typing example. 

1 3  
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How file typing works 

Looking Glass's file typing mechanism consists of three basic 
components: 

• A File Typing Language (FTL), which is used to define the rules 
by which file types are identified 

• A File Typing Compiler (FTC), which compiles file typing rules 
written using the FTL 

• A File System Server (FSS), which manages file system informa­
tion and allows high-speed access to directories of any size 

File type definitions are written in text files using the File Typing 
Language. They include statements that describe files, such as a par­
ticular format for a filename, a string of characters that must be 
found in a particular location in the file, or a location in the file 
system in which the directory or file must be found. In addition to 
the rules used to determine file types, file type definitions specify 
the icon to display for each directory or file and any actions associ­
ated with that type of file. These definitions are compiled by the 
File Typing Compiler to create a binary file named LG _ rulebase.  
LG_rulebase is stored in the Looking Glass data directory (specified 
at installation) and is read into memory at startup. 

As an optional step in the installation of Looking Glass, each direc­
tory and file is examined to determine its type. A small database file 
named . lgclb is placed in each directory examined with file typing 
information for each directory and file in the directory. When 
Looking Glass displays the contents of a directory, the File System 
Server looks for a . lgclb file. If the file isn't found, the directory is 
typed. If the user has write permission for the directory, a . lgclb file 
is created for use the next time a Looking Glass user opens the 
directory. If a . lgclb file is present, the File System Server compares 
the contents of the . lgclb file to the contents of the directory to 
determine whether any directories or files were added to the direc­
tory since the last time the . lgclb file was modified. If so, any newly 
added items are typed according to the current rulebase. If the cur­
rent user has write permission for the . lgclb file (the normal situa­
tion), it is updated. 
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Overview of the File Typing Language 

The following syntax diagram shows the general format of a 
file type definition: 

DEFINE [ TYPE I DIRECTORY ] 
ICON 
F I LE DESCRIPTION 
<rule statement> 
<command section> 

END 

<type name> 
< icon name> 
<text> 

Each file type definition must include at least the following 
components: 

• A DEFINE TYPE or DEFINE DIRECTORY statement 
• An ICON statement 
• A rule statement 
• An END statement 

The DEFINE TYPE or DEFINE DIRECTORY statement signals 
the beginning of a file type definition. 

The ICON statement assigns a specific icon to the file type. 
The icon you assign represents the file type when viewed by 
icon in Looking Glass. 

The rule statement describes how to recognize the file type 
based on a file's name and content. 

Each definition may also have a command section. The com­
mand section provides a list of shell commands that are 
available to the user as double-click actions, as well as any 
special information about printing files of this type. If the 
command section is left out of a definition for a file, Looking 
Glass users who attempt to print or open a file of this file 
type are warned that the operation can't be completed. 

The END statement signals the end of a file type definition. 
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While the components of a file type definition are very strictly 
defined, the format of the file typing source code is not. For exam­
ple, from the compiler's point of view, the following two defini­
tions are identical even though they are formatted differently: 

Example 1 :  
DEFINE TYPE 

ICON 
EMPTY 

EmptyFile 
EMPTY FILE ICON 

COMMAND : TEXT EDITOR 
END 

Example 2: 
DEFINE 

TYPE EmptyFile 
EMPTY 
COMMAND : 

TEXT EDITOR 
ICON 

EMPTY FILE ICON 
END 

Building file type definitions 

This section describes the process of building file type definitions 
for a file typing rulebase. The order in which the the various steps 
are performed is not critical; however, if you have never created or 
modified file type definitions before, we suggest that you perform 
the steps in the order presented here. 

All of the keywords mentioned in this section are described in more 
detail in the "File Typing Language reference" section later in this 
chapter. 

Selecting a source file for new file type definitions 

Before creating a new file type definition, you need to select a 
source file to store the definition in. Five empty source files are pro­
vided with Looking Glass. These source files are normally stored in 
the directory /usr/ l ib/lg/lg_ftc.  Each of the source files is 
intended for a specific category of file type definitions. 
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The following table lists the categories of definitions that you 
should put in each source file: 

Store the file type definitions of: 

Specific binary executable files 

Specific types of data files 

Device files 

General fi le types, such as text or empty files 

Low-level file type classes such as shell scripts 
and devices 

In this source file: 

prog . loc . ft c  

data . loc . ftc 

dev . loc . ftc 

gen . loc . ftc 

class . loc . ftc 

It is important to put file type definitions in the appropriate source 
files to ensure accurate file typing. The source files are compiled in a 
specific order so that the more specific definitions (those in 
prog . loc . ftc) are put at the head of Looking Glass's rulebase, and 
the most general (such as those in class . loc . ftc) are put at the end. 

When you have selected the appropriate file for the file type defini­
tion you are creating, you are ready to edit the file and begin creat­
ing a file type definition. 

Assigning a name to a file type definition 

Each file type definition must begin with a DEFINE TYPE or DEFINE 
DIRECTORY keyword that assigns a unique symbolic name to the 
file type definition. 

For example: 
DEFINE TYPE SpreadSheet 

This statement signals the beginning of a definition for a file type 
called SpreadSheet. 
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Assigning an icon to a file type definition 

D 

Each file type definition must have an icon assigned to it using the 
ICON keyword. The assigned icon represents the file type when 
viewed by icon in Looking Glass. Icon names are created in the 
Icon Editor. For more information about the Icon Editor, refer to 
Chapter 10, "Working with the Icon Editor." 

The following statement identifies the icon SPREADSHEET_DOC to 
be displayed for files that match this file type definition: 

ICON SPREADSHEET DOC 

If you assign an icon that doesn't exist, Looking Glass displays the 
generic document icon shown on the left. 

Building file matching rules 

The rule statement of a file type definition tells Looking Glass how 
to identify the file type. It is made up of some combination of 
NAME, DIRECTORY, and CONTENT statements, and intrinsic key­
words. Intrinsic keywords identify file types that are recognized by 
Looking Glass without information specified in NAME, DIREC­
TORY, and CONTENT statements. 

These are the intrinsic keywords that Looking Glass recognizes: 

• EMPTY 
• TEXT 
• BINARY_EXECUTABLE 
• BLOCK_DEVICE 
• CHARACTER_DEVICE 
• FIFO 
• SOCKET 
• SYMBOLIC_LINK 

The following examples demonstrate the use of these components 
in constructing rules. For a detailed description of any statement, 
refer to the "File Typing Language reference" section later in this 
chapter. 

Any rule component can be used by itself. For example, the follow­
ing file type definition matches any text file: 

DEFINE TYPE 
ICON 
TEXT 

END 

Text Type 
ASC I I  TEXT 
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Rule components can also be combined with the AND and OR 
operators, as in this example of a file type definition for C program­
ming language source files: 

DEFINE TYPE 
ICON 

CSourceType 
C SOURCE ICON - -

TEXT AND NAME " * . c" 
END 

The AND in this definition's rule means that a matching file must 
satisfy both conditions: it must hold text, AND the last two charac­
ters of its name must be ".c".  (If the AND were replaced with OR, 
the definition would match files that satisfied either condition; that 
is, all files that contain text or end in " .c" .) 

The order in which file type definitions are presented is very impor­
tant. In general, definitions should be organized so that the defini­
tions with the more spedfic rules are put at the top of the source 
file, and the definitions with most general rules are put at the end. 

Remember that a file is compared to the rules of a definition until 
the first match is found. If the two preceding examples were defined 
in the order presented above (TextType first, CSourceType second), 
all C source files would mistakenly be classified as TextType files 
because the TextType definition would be matched first. If the order 
of the definitions were reversed, the rules would work as intended. 
Text files that failed to match the more stringent rules in CSourceType 
would "fall through" and match the TextType definition. Type defini­
tions as general as the TextType example are useful, but they must 
be placed near the end of the rulebase so that they don't prevent 
files from matching more specific definitions. 

The remaining major rule components are the CONTENT and 
DIRECTORY statements. Consider the following example: 

DEFINE TYPE ManDocType 
ICON UNIX MAN DOC 

END 

F I LE DESCRIPTION 
"Unformatted manual page " 

TEXT AND D IRECTORY " * /man * "  AND CONTENT 0 TO 
2000 STRING " \n . TH " OR 
TEXT AND DIRECTORY " * /man * "  AND CONTENT 0 TO 
2000 STRING " \n . so " 

This rule specifies that any files located in a directory whose name 
starts with "man" and that contain lines starting with " .TH " or 
" .so" in their first 2,000 characters are unformatted manual pages. 
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Organizing rules for maximum efficiency 

Improperly organized rules can seriously degrade Looking Glass's 
performance. Keep these points in mind when deciding on the 
order of rules in the rule section of a file type definition: 

• Intrinsic components are processed faster than NAME and 
DIRECTORY statements 

• NAME and DIRECTORY statements are processed much faster 
than CONTENT statements 

• Rule components are evaluated in the order they are presented 
in the file type definitions 

Wherever a series of rule components are to be joined by OR or 
AND, try to put the fastest components first. 

For example: 
D IRECTORY " * /man * "  AND CONTENT 0 TO 200 0  STRING 
" \n . so " 

is faster than: 

CONTENT 0 TO 2000 STRING " \ n . so " AND D IRECTORY 
" * /man * "  

because Looking Glass only needs t o  examine files in directories 
whose names match the "*/man*" expression. 

Building the command section 

The command section of a file type definition defines the actions 
that associated with a file type and, in some cases, how to print it. 
Since directories cannot be assigned actions, this section is left out 
of type definitions for directories. 

Actions are specified with the COMMAND statement. 

Here is our CSource example extended to include several actions: 

DEFINE TYPE 
ICON 

CSourceType 
C SOURCE ICON - -

TEXT AND NAME * . c  
COMMAND : TEXT EDITOR 



END 
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COMMAND "echo Lines ,  words , and characters of il f  
; we #: f  .. 

COMMAND DESCRIPTION 
"Count file ' s  l ines , words , and characters" 

COMMAND "make " basename il f  . c · . o" 
COMMAND DESCRIPTION 

"Generate object file with Make " 

Each COMMAND statement specifies a different command that a 
user can invoke for a matching file. The ilf symbol used in several 
of the commands is replaced at runtime with the name of the file 
that matched this file type definition. 

When a user double-clicks the icon for this file, the first command 
in the definition is invoked. In our example, the first command 
invokes the user's default text editor, specified as part of the user's 
Looking Glass execution preferences. 

If the user Control+double-clicks the icon for this file, a dialog is 
displayed listing all of the commands that can be used with a file. 
In the example above, the following three commands would be 
displayed: 

• The command that invokes the text editor 
• A command that counts the file's lines, words, and characters 
• A command that generates an object file 

When the user chooses a command from this list, the command is 
invoked (it is passed to the user's external shell). 

The command section also contains any special instructions for 
printing the file type. Printing in Looking Glass is done in a two­
step process using external programs: first the file is formatted, then 
the file is sent to a spooler for printing. The programs used by the 
Looking Glass Print command are specified in the user's execution 
preferences. 

To specify that a file type is printable and should be printed by this 
"default" method, include the ATTRIBUTE : PRINTABLE statement 
in the file type definition. If you don't include this statement, 
Looking Glass will not print this file type. For more information 
about printing, refer to "Printing files" in Chapter 5, "Managing 
directories and files." 
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Some types of files require spedal treatment before printing. To 
specify a custom print formatting command for a file type, use the 
COMMAND : PRINT statement. In the following example, the 
COMMAND : PRINT statement is used to spedfy custom formatting 
for files that contain the operating system manual: 

DEFINE TYPE ManDocType 

END 

ICON UNIX MAN DOC 
F I LE DESCRIPTION 

"Unformatted manual page " 
TEXT AND DIRECTORY " * /man* "  AND CONTENT 0 TO 

2000 STRING " \n . TH " OR 
TEXT AND D IRECTORY " * /man * "  AND CONTENT 0 TO 

2000 STRING " \n . so " 
COMMAND : TEXT .EDITOR 
COMMAND : PRINT 

"nroff -man ilf  " 

Manual pages are stored in the troff formatting language. The COM­
MAND : PRINT statement tells Looking Glass to replace the user's 
default formatting command with the nroff -man ilf command for 
files of this type. The output of the formatting command is still sent 
to the print spooler spedfied in the user's execution preferences. 

Because the ATTRIBUTE : PRINTABLE statement specifies printing 
in accordance with the user's print formatter preference and the 
COMMAND : PRINT statement spedfies special formatting for the 
file type, these two statements cannot be used in the same file type 
definition. 

Specifying the rule's FEATURE_SET 

Looking Glass has the ability to ignore or use file type definitions 
based on the value of the environment variable LG_FEATURE_SET. 
Looking Glass reads the value of LG_FEATURE_SET at startup time 
to determine if certain file typing rules should be used. This allows 
you to create file type definitions that can be turned on or off on a 
per-user basis You should use this capability to test new file type 
definitions in a restricted environment before you make them gen­
erally available. 

Including the following statement in a file type definition causes 
Looking Glass to ignore it unless the user's LG_FEATURE_SET envi­
ronment variable is set to "TEST": 

FEATURE SET TEST 
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Before testing the rule, set your own LG_FEATURE_SET environ­
ment variable to "TEST," save your environment variables, and 
restart Looking Glass. 

After you have tested the rule, return your LG_FEATURE_SET envi­
ronment variable to its usual value (or delete it) and restart Looking 
Glass. To make the rule available to other users, remove or change 
the FEATURE_SET statement in the FTL source file and then recom­
pile the rulebase. (Refer to the description of the FEATURE_SET key­
word in the "File Typing Keyword reference" section later in this 
chapter.) 

Ending a file type definition 

End a file type definition with the END keyword. 

Generating the Looking Glass rulebase 

The FTC directory that stores source files also contains a file named 
Makefile,  which is used by the make programmer's facility when it 
generates a new rulebase. 

To create a new LG rulebase file: 

1. Make sure you are in the FrC directory (normally 
/usr/ lib/lg/lg_ftc). 

� . Type make all at the command line. 

The make program generates a series of commands to create a 
new LG _ rulebase file. When the make program has finished, 
the rulebase is ready for installation. 

Installing the Looking Glass rulebase 

You are now ready to install a new Looking Glass rulebase contain­
ing any additions or changes you have made to the file typing 
source files. 

The FTC directory contains two files named icons . sym and 
records . sym .  These files are very important and should never be 
removed. 
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The icons . sym file is maintained by the FfC; it stores the informa­
tion that tells Looking Glass what icon to display for a file. A copy 
of i cons . sym must be installed with the LG _ rulebase file. 

The records . sym file stores the names of the various file type 
definitions (as specified in the DEFINE statement of each file type 
definition). 

The i cons . sym and records . sym files are maintained separately 
from the LG rulebase files to accommodate networks with differ­
ent types of computers that may share a common file system. To 
accommodate different operating environments, some machines 
may need their own LG _ rulebase files based on a different set of 
file typing source files. To ensure that typing information stored in 
a directory's . lgdb database file by one machine can be used by 
another, the rulebase for each machine must be compiled in the 
presence of the same icons . sym and records . sym files. 

To install icons . sym and LG _ rulebase: 

I. Make sure you are in the FTC directory (normally 
/usr/ l ib/lg/lg_ftc). 

:ll o Type make install at the command line. 

This invokes the make utility to copy LG_rulebase and 
icons . sym to Looking Glass's data directory. 

Restarting Looking Glass 

If you install a new set of file typing rules while Looking Glass is 
running, you must quit and restart Looking Glass so that the new 
LG_rulebase file is read. Refer to Chapter 1, "Getting started with 
Looking Glass" for instructions on quitting and starting Looking 
Glass. 

As a final consideration, you should note that it may be necessary 
to use the Looking Glass Retype Directory command to receive 
accurate file typing of directories that contain files or directories 
affected by changes to the rulebase. For more information on the 
Retype Directory command, refer to "Retyping a Directory" in 
Chapter 4, "Working with Directory windows. "  
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File Typing Language reference 

This section provides detailed descriptions of all the components of 
the FfL. The following subjects are included: 

• File Typing Language statements 
• Typing rule statements 
• Parsing and syntax guidelines 
• File Typing Language syntax summary 
• File Typing Compiler command-line arguments 

File Typing Language statements 

This section contains descriptions of the following keywords: 

• APPEND_COMMANDS 
• APPEND_RULES 
• ATTRIBUTE : HIDDEN 
• ATTRIBUTE : PRINTABLE 
• COMMAND 
• COMMAND : PRINT 
• COMMAND : TEXT EDITOR and COMMAND : DATA EDITOR 
• DEFINE DIRECTORY 
• DEFINE TYPE 
• END 
• FEATURE_SET 
• FILE_DESCRIPTION 
• ICON 
• INHERIT_COMMANDS 
• REDEFINE DIRECTORY 
• REDEFINE TYPE 

Keywords are described in alphabetical order for easy reference. For 
each keyword, we provide a description of its purpose, a syntax dia­
gram (if applicable), and additional usage information. 

APPEND_COMMANDS 

APPEND_COMMANDS {HEAD I TAIL ) Name Commands END 

Use the APPEND_COMMANDS statement to add new commands to 
an existing file type definition. 

Name identifies the type definition to which the commands that 
are defined will be attached. 
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Commands is one or more new commands that will be added to the 
list of commands for the file type. 

Either the HEAD or TAIL keyword must be used. Use HEAD to add 
the defined commands to the beginning of the type definition's 
command list. If you use HEAD, the first command defined after 
the APPEND_COMMANDS statement will become the default dou­
ble-click action for the file type. Use TAIL to add the defined com­
mands to the end of the type definition's command list. 

The APPEND_COMMANDS statement is most often used for 
installing application programs that require typing modifications 
and installing updates to Looking Glass. It allows the compiler to 
modify an existing rulebase without modifying and recompiling 
source code. The compiler will issue an error message and exit if the 
type definition referenced by Name hasn't been defined. 

APPEND_RULES 

APPEND_RULES Name Rules END 

Use the APPEND_RULES statement to append new rule components 
to an existing file type definition. 

Name identifies the type definition to which the rules that are 
defined will be attached. 

Rules is one or more new rules that will be effectively joined to the 
original with the OR keyword. For descriptions of the available 
statements, refer to "Typing rule statements, " later in this chapter. 

The APPEND_RULES statement is most often used for installing 
application programs that require typing modifications and instal­
lation of updates to Looking Glass. It allows the compiler to modify 
an existing rulebase without modifying and recompiling source 
code. The compiler will issue an error message and exit if the type 
definition referenced by Name hasn't been defined. 

ATIRI BUTE : H I DDEN 

Use the ATTRIBUTE : HIDDEN statement to tell Looking Glass that 
the file or directory type being defined is hidden. Users won't see 
files or directories of this type in Looking Glass Directory windows 
unless they explicitly choose to view hidden files. 
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ATTRI BUTE : PRI NTABLE 

Use the ATIRIBUTE : PRINTABLE statement to tell Looking Glass 
that the file type being defined can be printed with the default 
print formatting command (as defined in the user's execution pref­
erences) . This statement can't be used with any file type definition 
that uses the COMMAND : PRINT statement. 

If the ATIRIBUTE : PRINTABLE statement is not specified for a file 
type definition, and if no print command is specified, Looking 
Glass won't print files that match this type. 

COMMAND 

COMMAND [ATTRIBUTE : At tribute ]  " CommandString" 

[COMMAND_DESCRIPTION " CommandDescription " ] 

Use the COMMAND statement to define the commands that will be 
associated with a file type. 

Any number of COMMAND statements can be included in a file 
type definition. The first command specified is the default double­
click action that is assigned to the file. Any other commands you 
include in the file type definition can be viewed and selected in a 
dialog that is displayed when the user Control+double-clicks a file. 

CommandString is the text of a shell command, enclosed in single or 
double quotes, that is executed when the user double-clicks on the 
file. The command string can provide a full pathname to an exe­
cutable program, but this is not a requirement. (Looking Glass fol­
lows the user's search path-as specified in the PATH environment 
variable-to locate the program if a full pathname is not given.) 
Environment variables are allowed in the command string. Shell 
scripts can also be used, but should be preceded by the shell exe­
cutable to make sure the correct shell executes the script. (If the 
shell is not specified explicitly, Looking Glass uses the shell speci­
fied in the user's execution preferences.) 

For example: 
COMMAND " /bin/ sh $HOME/bin/myshellscript # f "  

The filename the user double-clicked is placed wherever the # f  spe­
cial symbol appears. To make the file run as a result of a double-click 
(for example, to run the Bourne Shell as a result of double-clicking 
on /bin/sh), the first argument in the COMMAND statement 
should be . I # f .  The " /" is necessary to ensure proper execution if 
the file is in a directory that is not included in the user's search path. 
The special Looking Glass symbols #u, #g, and #c are also available, 
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for the user's name, the group name, and the current directory, 
respectively. 

The optional COMMAND_DESCRl.PTION statement describes an 
entry in the list of commands generated by a Control+double-click. 
It's a good idea to keep command descriptions concise. 

CommandDescription is a description of the command, enclosed in 
double quotes ("), that appears when the user holds down the 
Control key and double-clicks a file. 

Attribute is a statement that gives Looking Glass more information 
about how the command should be run. With each command 
statement, you can include one (and only one) of the following 
attribute statements: 

This attribute: 

NATIVE 

TTY 

Does this: 

Tells Looking Glass that the command to be exe­
cuted will run as a native window system appl ica­
tion, and does not need a terminal emulator 
window 

Tells Looking Glass that the command needs a 
scrolling tty window, and does not need a termi­
nal emulator window 

(Many operating system utilities that print status 
information, such as ps and who, fit into this cate­
gory.) 

TERMINAL_ WINDOW Tells Looking Glass that the command needs a 
ful l-featured terminal emulator window (one that 
supports features such as cursor addressing) 

SINGLE_ARGUMENT 

Full-screen editors like vi need this type of win­
dow. This is the default. 

Tells Looking Glass that this particular command 
can only take one file at a time as an argument 

This attribute is used when the Open command 
from the Looking Glass File menu is selected to 
open several files of the same type. If SINGLE_ 
ARGUMENT is specified, Looking Glass will exe­
cute the command for that type selected. By 
default, Looking Glass will open al l  files of the 
same type with a single command. 
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COMMAND : PRINT 

COMMAND : PRINT [ATTRIBUTE : SINGLE_ARG!JMENT ] 

" CommandText " [COMMAND_DESCRIPTION " Descripti on " ] 

Use the COMMAND : PRINT statement to specify a special print for­
matter for files that match the file type. The special print formatter 
replaces the user's preferred print formatter when a file that matches 
the file type is printed. If no print command is specified, and if no 
ATTRIBUTE : PRINTABLE statement is specified for the file type def­
inition, Looking Glass won't print files that match this type. 

CommandText is the text of the print formatting command that is 
used when the file type is printed. 

Description is the description that will be associated with the print 
command in the Select A Command dialog (displayed when user 
Control+double-clicks a file) . 

COMMAND : TEXT _EDITOR 
and 
COMMAND : DATA_EDITOR 

COMMAND : { TEXT_EDITOR I DATA_EDITOR } 

The COMMAND : TEXT_EDITOR and COMMAND : DATA_EDITOR 
statements cause Looking Glass to insert the user's default text and 
data editors into the list of possible commands for files that match 
this type. (The pathnames and arguments for these executable pro­
grams are specified in the user's execution preferences.)  

DEFINE DIRECTORY 

DEFINE DIRECTORY Name ICON IconName { OPEN_ICON 

OpeniconName ]  [ FILE_DESCRIPTION Description ]  DIRECTORY 

DirectoryName [ DirectoryName . . .  ] [ FEATURE_SET Fea tureName 

[ Fea tureName . . .  ] ]  END 

Use the DEFINE DIRECTORY statement to assign one or more icons 
to a directory type. (Use the DEFINE TYPE statement, described 
below, to begin a file type definition.) The DEFINE DIRECTORY 
statement actually comprises a series of keyword clauses that make 
up a complete directory type definition. No commands can be asso­
ciated with a directory type. 

Name is the unique symbolic name for the directory type definition. 
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IconName is the name of the icon to be displayed for this directory 
type. 

Use the optional OPEN_! CON keyword to specify a separate icon for 
the directory when it is open in a user's Looking Glass workspace. 
OpenlconName is the name of the icon used to represent the open 
directory. If  the OPEN_ICON keyword is not used, Looking Glass 
will display the icon specified in IconName. 

Use the optional FILE_DESCRIPTION keyword to provide a descrip­
tion of the directory type. Description is a description of the direc­
tory type that appears in the Type field when directories and files 
are displayed in Wide view in Looking Glass Directory windows and 
in the Information dialog. It is advisable to keep this description 
concise. 

The DIRECTORY keyword defines the names of directories that 
match the directory type. DirectoryName is a string that is compared 
to the full pathname of the directory. It is usually a good idea to 
precede a full pathname with the "match all" character (*), because 
network file systems often include a mount directory that precedes 
the target. For example, * /usr /bin would match /usr/bin, as well 
as /machineA/usr/bin. 

The FEATURE_SET keyword restricts use of a directory type defini­
tion to specific environments (such as specific user groups or oper­
ating systems). FeatureName specifies a series of one or more feature 
symbols. If a directory type is defined with one or more feature 
symbols, and none of the symbols are set in the running version of 
Looking Glass, the directory type is disabled (no directories will 
match it) . For more information, refer to the general description of 
the FEATURE_SET statement below. 

The END keyword signals the end of a directory type definition. 

DEFI N E  TYPE 

DEFINE TYPE Name 

Use the DEFINE TYPE statement to begin a new file type definition. 
The DEFINE TYPE statement must be the first component of a file 
type definition. (Use the DEFINE DIRECTORY statement, described 
above, to begin a directory type definition.) 

Name is the unique symbolic name for the file type definition. The 
compiler will not allow duplicate names. 
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E N D  

END 

The END statement indicates the end of a file type definition. 

FEATURE_ S ET 

FEATURE__BET Name [Name ... ] 

Use the FEATURE_SET statement to restrict use of a file type defini­
tion to specific environments (such as specific user groups or oper­
ating systems). 

Name is a series of one or more feature symbols. If a file type is 
defined with one or more feature symbols, and none of the symbols 
are set in the running version of Looking Glass, the file type is dis­
abled (no files will match it) . 

There are two ways to set feature symbols in Looking Glass: 

• Certain feature symbols are intrinsically set in specific versions 
of Looking Glass to accommodate variations between hardware 
platforms and operating systems 

• The value of the LG_FEATURE_SET environment variable is 
read during Looking Glass startup 

If one or more of the feature symbols is set (either intrinsically or 
with the LG_FEATURE_SET environment variable), directories or 
files that meet the other criteria in the file type definition will 
match the file type. When no feature symbols are included in a file 
type definition, the file type is recognized in all environments. 

For a list of the feature symbols that are set intrinsically for your ver­
sion of Looking Glass, refer to the Looking Glass Release Notes. 

F I LE_DESCRIPTION 

FILE_DESCRIPTION "Description "  

Use the FILE_DESCRIPTION statement t o  create a text description 
of the type of file that will be identified by this record. 
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Description is the information that appears in the Type field when 
directories and files are displayed in Wide format in Looking Glass 
Directory windows and in the Information dialog. You should keep 
this description concise. 

ICON 

ICON Name 

Use the ICON statement to assign an icon to a file type. 

Name is the icon's symbolic name defined in the Looking Glass 
Icon Editor. 

You can use the same ICON statement for more than one file type 
definition. For example, you may want to use the cartridge tape 
icon for more than one type of cartridge tape ddve device file but 
vary other parts of the file type definitions. 

I N H ERIT_ COM MANDS 

INHERIT_COMMANDS Name [Name . . .  ] 

Use the INHERIT_ COMMANDS statement to add the commands 
assigned to other file types to the file type definition currently 
being defined. 

Name is the unique symbolic name (or names) of the file types you 
want to inherit commands from (these are referred to as parents) . 
Any command lists inherited from parents are added to the end of 
the current definition's command list. 

Any COMMAND : PRINT or ATIRIBUTE : PRINTABLE statements 
that you put in the current definition override those inherited from 
parents. If you don't put these statements in the current definition, . 
the print command or ATIRIBUTE : PRINTABLE statement is inher­
ited from the first parent that has one of them in its file type 
definition. 

Inheritance is performed by Looking Glass at the time the file is 
activated or when the possible actions for the file are displayed. 
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REDEFI N E  DIRECTORY 

REDEFINE DIRECTORY Name [ ICON I conName } [ OPEN_ICON 

OpeniconName ]  [ FILE_DESCRIPTION Description }  [ DIRECTORY 

DirectoryName [ DirectoryName . . .  } }  [ FEATURE_SET 

Fea t ureName [ Fea t ureName . . .  } }  END 

Use the REDEFINE DIRECTORY statement to replace any or all of 
the components of an existing directory type record. Name is a sym­
bolic directory type name that must already be defined. See the 
description of the DEFINE DIRECTORY statement, above, for 
descriptions of all of the other keyword clauses. Any item that fol­
lows REDEFINE DIRECTORY will replace the corresponding item in 
the referenced directory definition. 

The REDEFINE DIRECTORY statement is most often used for instal­
lation of application programs that require file typing modifications 
and installation of updates to Looking Glass. It allows the compiler 
to modify an existing rulebase without modifying and recompiling 
source code. 

REDEF I N E  TYPE 

REDEFINE TYPE Name [A'I'l'RIBUTE : HIDDEN} [ A'I'l'RIBUTE : 

PRINTABLE } [ COMMAND CommandSta temen t [ CommandSta tement 

• • .  } ]  [ COMMAND : PRINT PrintSta temen t }  [ COMMAND : 

{ TEXT_EDITOR I DATA_EDITOR ) }  [ FEATURE_SET Fea t ureName 

[ Fea t ureName . . .  } } [ FILE_DESCRIPTION "Description " }  [ ICON 

IconName} [ INHERIT_COMMANDS Name [Name . . .  } } END 

Use the REDEFINE TYPE statement to replace any or all of the com­
ponents of an existing file type record. Name is a symbolic file type 
name that must already be defined. 

Any item that follows a REDEFINE TYPE statement will replace the 
corresponding item in the referenced file type definition. This 
includes rule definitions and command definitions. (See 
APPEND_RULES and APPEND_COMMANDS, above, for an explana­
tion of how to add rules and commands to existing file type records 
without changing the current lists.) 

The REDEFINE TYPE statement is most often used for installation of 
application programs that require file typing modifications, and 
installation of updates to Looking Glass. It allows the compiler to 
modify an existing rulebase without modifying and recompiling 
source code. 
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Typing rule statements 

Typing rule statements are single- or multipart statements that dis­
tinguish one file type definition from another. They are used to 
determine if a file matches the file type definition. 

This section contains a general discussion of the technique for 
building typing rule statements, followed by a detailed description 
of the following statements: 

• BINARY_DATA* 
• BINARY_EXECUTABLE* 
• BLOCK_DEVICE* 
• CHARACTER_DEVICE* 
• CONTENT 
• DIRECTORY 
• EMP'IY* 
• FIFO* 
• NAME 
• TEXT* 
• SOCKET* 
• SYMBOLIC_LINK* 

The statements in this list marked with an asterisk are intrinsic typ­
ing rule statements. Intrinsic statements let you match file charac­
teristics that are typed intrinsically by Looking Glass. These rules 
are often used with NAME, DIRECTORY, and CONTENT rules to 
narrow the search for file types. 

Any typing rule statement can be used by itself to create a file­
matching rule, or it can be combined with another statement to 
create a rule. 

The typing rule statement in a file type definition is made up of 
some combination of NAME, DIRECTORY, and CONTENT state­
ments and the intrinsic typing rule statements. 
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You can use the following operators to connect typing rule 
statements: 

This 
operator: Does this: Use It: 

NOT Reverses the meaning of any statement Before a statement 

AND Connects any statements to indicate Between statements 
that both (or all connecting) statements 
must be matched to match the file type 

OR Connects statements to indicate that Between statements 
either the previous statement or the next 
statement must be matched to match 
the file type 

With these operators, you can combine file typing statements to 
create rules that will match files with unique or special characteris­
tics in your system. Combining statements with operators also 
helps Looking Glass to weed out the files that won't match a file 
type more efficiently. 

The following example shows a file typing statement that combines 
a TEXT and a NAME statement: 

DEFINE TYPE 
ICON 
TEXT AND NAME 

END 

CSourceType 
C SOURCE ICON - -

" * . c" 

The AND in this definition's rule means that a file must satisfy both 
conditions in order to match it. In other words, it must hold text 
and the last two characters of its name must be ".c".  

If the AND were replaced with OR, the definition would match files 
that satisfied either condition-all text files or all files that end with 
" .c". 
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B INARY_DATA 

Use the BINARY_DATA statement to match any file that contains 
more than 5 percent control characters or characters with the high 
bit set in the first two physical disk blocks. (Carriage returns, line­
feeds, tabs, and backspaces are not counted as control characters.) 

BI NARY _EXECUTABLE 

Use the BINARY_EXECUTABLE statement to match any file that is 
an executable binary file or command that is native to the system 
Looking Glass is running under. 

BLOCK_DEVICE 

Use the BLOCK_DEVICE statement to match any block special 
device file. 

CHARACTER_ DEVICE 

Use the CHARACTER_DEVICE statement to match any character 
special device file. 

CONTENT 

CONTENT Offset [TO Offset ] 

{ STRING I BYTE I SHORT I LONG )  [ < I > I = ] 

{ " String" I NumericValue ) 

Use the CONTENT statement to match files that have a given value 
at a given offset or within a given range. 

Offset is the position at which Looking Glass will begin searching 
for the Numeric Value. This argument must be provided. If Offset is 
followed by the keyword TO, another Offset must be provided to 
define a range in which the search will be made. All bounded 
searches are carried out in a byte-by-byte fashion, including short 
and long integers. 

String is the string Looking Glass will search for in the file; it must 
be enclosed in double quotes (") . 
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The value may be specified as a quoted string (indicated by the 
STRING keyword) or as an integer value (indicated by the BYTE, 
SHORT, and LONG keywords). 

You can also use the following operators to compare the data in the 
file to a value: 

Use this operator: 

= 

< 

> 

To define a file type where a <Value> Is: 

Equal to the file data 

This is the default operator, and the only one 
that can be used with strings. 

Less than the file data 

Greater than the file data 

Single-byte-replacement regular expression metacharacters can be 
used in a string value. The following table lists the metacharacters 
you can use: 

Use this character: To match: 

? Any character 

[c,c, ... ] One of the characters in the series 

[cl -c2] One of the characters in the designated range 

Integer values can be expressed in decimal, octal (with a leading 0), 
or hexadecimal notation (with a leading Ox) . 



1 3-26 A Looking Glass User's Guide 

DIRECTORY 

DIRECTORY Name [Name ... } 

Use the DIRECTORY statement to define the names of directories 
that a file must be in to match the file type, or to define directory 
names when creating a directory type. Directory names are treated 
as strings that are compared to the full pathname of the current 
directory. 

Name is the pathname of a directory that a file must be in to match 
a file type or the full pathname of a directory when creating a direc­
tory type. 

It is usually a good idea to precede a full pathname with the "match 
all" character (*), because network file systems often include a 
mount directory that precedes the target. For example, * /usr /bin 
would match /usr/bin as well as /rnachineA/usr/bin. 

DIRECTORY statements are most often used in conjunction with 
CONTENT and/or NAME statements. If the Name includes special 
characters, it must be placed in single or double quotes. 

EM PTY 

Use the EMPTY statement to match any empty file (in other words, 
files of zero length). 

FIFO 

Use the FIFO statement to match any FIFO (named pipe) files. 

NAME 

NAME Name [Name ... ] 

Use the NAME statement to define file or directory names that 
match a file type. Any number of names may be defined with the 
NAME statement; each name must be separated by at least one 
space. 

Name is the name of a file that the file type will match. 

Any Looking Glass regular expression metacharacter can be used if 
that the name expression is enclosed in double quotes (") .  
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Pathnames are not allowed. Use the DIRECTORY statement to indi­
cate the file's position in the file system or to define directory 
names when creating a directory type. 

SOCKET 

Use the SOCKET statement to match any socket file. (On systems 
that don't support sockets or socket "files," this rule is ignored.) 

SYMBOLIC_LINK 

Use the SYMBOLIC_LINK statement to match any symbolic link. 
(On systems that don't support symbolic links, this rule is ignored.)  

TEXT 

Use the TEXT statement to match any file that contains less than 5 
percent control characters or any characters with the high bit set in 
the first two physical blocks. (Carriage returns, linefeeds, tabs, and 
backspaces are not counted as control characters.) 

Parsing and syntax guidelines 

This section describes general parsing and syntax rules for the File 
Typing Compiler. 

Com ments 

Comments are C language style, starting with /* and ending with 
*/. 

Keywords 

Keywords must be in upper case. 
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Looking Glass symbols 

In COMMAND statements, the following Looking Glass symbols 
can be used: 

Inserts this 
This option: symbol: With this value: 

Selected Files #f The names of all the files cur-
(available only when Command rently selected in the Directory 
Une is run from a Directory window) window 

Selected Directories #d The names of all the directories 
(available only when Command currently selected in the 
Une is run from a Directory window) Directory window 

Effective User #u The current user name 

Effective G roup #g The group name associated with 
the looking Glass process 

Current Directory #c The full pathname of the current 
directory 

Regular  expressions 

The standard set of Looking Glass regular expression metacharacters 
(Bourne Shell syntax) are allowed in the strings of COMMAND, 
NAME, and DIRECTORY statements_ Metacharacters other than the 
asterisk (*) are also allowed in the strings of CONTENT rules. 

Backslash as an escape character 

Special characters such as # and "newline" can be escaped using the 
backslash (\) character. Escape characters inside comments are 
ignored. Special characters are not expanded if they are escaped. 

For example: 
COMMAND " \ il f " 
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This command tells Looking Glass to try to execute "#f , "  rather 
than the name of the matching file that is normally represented by 
the Looking Glass symbol #f .  

The following table lists the special characters that are recognized: 

This character sequence: Indicates this character: 

\n Control+) (New line) 

\t Control+! (Tab) 

\b Controi+H (Backspace) 

\r Controi+M (Carriage Return) 

\f Controi+L (Form Feed) 

Strings 

Character strings may be enclosed in double or single quotes. (A 
string is terminated by the same quote character that started it.) 
Quotes within quotes are treated as part of the quoted string as long 
as they aren't the starting quote character. 

A series of quoted strings is concatenated into a single quoted 
string, except in NAME, DIRECTORY, and FEATURE_SET 
statements. 

For example: 
COMMAND "echo II " one n "two " tl "three II 

is identical to: 

COMMAND "echo one two three " 

To include a control character in a quoted string, enter an escape 
character (\) followed by the three-digit octal value for the 
character. 
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For example: 
\001  

would be  interpreted as  an  ASCII start-of-header (Control-A) 
character in the name. 

· 

White space 

Extraneous white space (defined as newlines, blanks, and tabs) is 
ignored. Note that this is not true of blanks in quoted strings. 

Tokens 

A single token (including series of quoted strings) cannot be longer 
than 4095 characters. 

File Typing Compiler reference 

The following is a summary of the command-line interface to the 
File Typing Compiler (FTC) : 

. / ftc { -1 binaryinputFi l e  1 -c textinputFil e )  

[ -i i conSymbolFi l e l  [ -r recordSymbolFi l e ]  

[ -o binaryOutputFi le l  

At  least one binary or  text input file must be specified, preceded by 
-1 or -c, respectively. 

"-" may be used as the filename to designate standard input. Any 
number of input files may be specified, but each must be preceded 
by -1 or -c . 

An icon symbol table file may be specified with -i . The default is 
i cons . sym .  

A record symbol table file may be specified with -r. The default is 
records . sym .  

A binary output file may be specified with -o . By default, n o  out­
put is produced. 



Chapter 1 3: Defining file types A 1 3-31 

File Typing Language example 

This is an example for running the mythical Syforbase database on 
any of its data files: 

DEFINE TYPE 
ICON 

SyforbaseDatabase 
DATABASE APP 

F I LE DESCRIPTION 
" Syforbase Database File"  

/*  
* Any file with  a ' . sfb ' extension in 
* ' /usr/syforbase ' directory matches . 
*I 
NAME " * . s fb"  AND DIRECTORY " * / syforbase"  OR 

/ *  
* The following ( long ) value a t  byte 4 2  i s  in  the 
* standard Syforbase header for vers ion 3 . 4  and 
* later . 
*I 

CONTENT 42 long 0 7 5 6 4 3  OR 
/ *  

* Look f o r  the standard 1 6-bit magic number 
* 0 6 4 0 0 7  and of  course the obl igatory copyright 
* not ice . 
* I 

/ *  

CONTENT 0 short 0 6 4 007  
AND CONTENT 4 8 - 1 5 0  
string " ( c )  Copyright 1 9 ? ?  
Syforbase" 

COMMAND ATTRIBUTE : TERMINAL WINDOW 
" /usr/bin/syforbase -r ll f "  

COMMAND DESCRIPTION 
"Read file with syforbase" 

* Place the error output from the maintenance 
* program in a file in /tmp with the name of the 
* database with a ' err ' extension . 
*I 

COMMAND ATTRIBUTE : TTY 
" /usr/bin/ s fx fixdb llf 2> /tmp/ll f_err ; " 
"echo Error output in \ '  /tmp / ll f_err\ '  " 

COMMAND DESCRIPTION 
"Reconstruct file " 
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This example defines a file type definition that runs the syforbase 
database program if: 

• The filename ends in " .sfb, " and the file resides in a directory 
named syforbase 
or 

• The first "sizeof(long)" bytes of the file from byte 42 contain 
the (long) value 075643 octal 
or 

• The first "sizeof(short)" bytes of the file contain the (short) 
value 0640 octal, and the string "(c) Copyright 19?? Syforbase" 
starts anywhere in byte positions 48 through 1 50 inclusive. 
(The question marks are regular expression metacharacters that 
match any two characters.) 
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browsing 

a file system 6-2 
the help system 3-4 

building 
file matching rules 13-6 
file type definitions 13-4 
the command section of a file type definition 13-8 

button 
Absolute symbolic 5-9 
Access 7-3, 7-6, 7-8, 7-1 7  to 18 
Block 5-3, 5-7, 5-13 
Cancel 2-18  
Character 5-3, 5-7, 5-13 
Close 5-12 
Dates 7-3, 7-1 1  
default 2-19 
Device7-3, 7-12 to 13  
Hark link 5-7 
History 3-8 
lndex 3-5 
Inherit Mask 12-12 to 13 
Unk Protection 7-6 to 7 
Maximize 2-9, 2-12 
Minimize 2-9, 2-12 
mouse 2-2 to 3 
OK 2-18 
Ownership 7-3, 7-9 
radio buttons 2-20 to 21 
Pause After Execution 8-7 
Reference Protection 7-6 to 7 
Relative symbolic 5-9 
Restore 3-7 
Select 5-15 
setting the double-dick speed for 12-22 
Show (Find dialog) 5-10, 6-21 
showing color elements of 12-1 
Store Mask 12-12 to 13 
Unselect 5-15 
user interface element 12-4 
Window Manager 2-9 to 10 

By Name command (Gallery window) 10-1 1 to 12 
BYfE keyword 13-� 

c 
Cancel button 2-18 
capitalization P-3 to 4 
Change Directory command (Directory Window) 4-6 

to 7 
Change Properties command (Directory Window) 7-14 

to 22  
changes to rulebase 13-12 
changing 

color preferences 
background element 12-2 
bottom shadow element 12-2 
foreground element 12-2 
top shadow element 12-2 
using HSB method 12-3, 5 
using Name method 12-3 to 4 
using RGB method 12-3, 5 

device type 7-12 to 14 
directory displayed in the current Directory win­

dow 4-6 
display formats in Directory windows 4-8 to 16  

changing to Non-positionable format 4-13 
changing to Positionable format 4-13 
choosing whether to show or hide hidden 

files 4-12 
cleaning up repositioned directories and files 

4-14 to 15 
moving the splitter 4-14 
sorting directories and files 4-15  to 16 
specifying the size of new Directory win-

dows 12-18 
viewing directories and files by icon 4-9 to 10 
viewing directories and files by name 4-8 to 9 
viewing directories and files in wide view 4-10 

to 1 1  
display preferences 12-16 

specifying how Directory window titles are 
displayed 12-17 

specifying the default position of the splitter 
in Directory windows 12-20 

specifying the display format for directories 
and files 12-18 to 19 

specifying the size of new Directory win­
dows 12-17 to 18 

specifying whether directories and files are 
positionable 12-19 

specifying whether hidden files are displayed 
in Directory windows 12-19 to 20 

environment variables 1 1-1 to 5 
adding 1 1-4 
editing 1 1-3 
removing 1 1-5 



execution preferences 12-7 
specifying an external shell 12-10 
specifying a terminal emulator 12-7 
specifying commands for printing 12-1 1 to 12 
specifying text and data editors 12-8 to 10 

external shell 12-10 
defining environment variables at startup 1 1-5 

icon masks 10-26 to 27 
information for one directory or file at a time 7-4 

changing access permissions 7-5 to 7 
changing date and time information 7-10 to 12 
changing device information 7-12 to 13  
changing execution options 7-7 to  8 
changing major and minor device numbers 7-

13 to 14 
changing ownership and group reference 7-9 

to 10 
changing the directory or file name 7-4 to 5 

information for a group of directories and files in 
one operation 7-14 to 22 

changing access permissions 7-16 to 18  
changing date and time information 7-19  to 

22 
changing execution options 7-18 to 19  
changing ownership and group reference 7-

15 to 16 
name of an existing directory or file 5-3 to 4 
name of an icon gallery 10-9 to 10 
name of an icon 10-16 to 1 7  
number of seconds between display updates 12-23 
operational preferences 12-20 to 23 

specifying a directory double-dick action 12-
22 to 23 

specifying a double-dick speed 12-22 
specifying the limit for file size 12-21 to 22 
specifying the number of seconds between 

display updates 12-23 
specifying the size of the Copy buffer 12-21 

position of the splitter in Directory windows 4-14 
text and data editors 12-8 to 10 

CHARACfER_DEVICE 13-24 
check boxes . 

Confirm Multiple (Removal Preferences dialog) 
12-6 

Confirm Read-Only (Removal Preferences dialog) 
12-6 

Confirm Single (Removal Preferences dialog) 12-6 
description of 2-21 
Desktop Panel (Show menu) 9-6 
Devices (Find dialog) 5-10 to 1 1  
Directories (Find dialog) 5-10 to 1 1  
Directories (Select By Pattern dialog) 5-13 to 15 
E (Execute) (Creation Preferences dialog) 12-12 to 15 
FIFOs (Find dialog) 5-10 to 1 1  
Files (Find dialog) 5-10 to 1 1  
Files (Select By Pattern dialog) 5-13 to 15 

Index A 1-3 

Group (Change Properties dialog) 7-15 to 1 7  
Group (Creation Preferences dialog) 12-12 to 13  
Last Accessed 7-21 to  22 
Last Modified 7-20 to 21  
Looking Glass Assigns Position 12-7 to  8 
Others (Change Properties dialog) 7-15 to 1 7  
Others (Creation Preferences dialog) 12-12 to 1 3  
Owner (Change Properties dialog) 7-15 t o  1 7  
Owner (Creation Preferences dialog) 12-12 to 13  
Positionable 4-13 
R (read) (Creation Preferences dialog) 12-12 to 15 
Run In New Terminal Emulator Window 12-9 
Save Text After Execution 7-19 
Search Subdirectories (Find dialog) 5-10 to 12 
Search Tree View Selections (Find dialog) 5-10 to 

12 
Select (Select By Pattern dialog) 5-13 to 15  
Set Group ID On Execution 7-19 
Set User ID On Execution 7-19 
Show Hidden Files 4-12 
Sockets (Find dialog) 5-10 to 1 1  
Sorted (Tree View window) 6-20, 6-22 
Symbolic Unks (Find dialog) 5-10 to 1 1  
Unselect (Select By Pattern dialog) 5-13 to 15 
W (write) (Creation Preferences dialog) 12-12 to 

15 
X (execute) (Creation Preferences dialog) 12-12 

to 15 
children 

closing 6-16 
description of 6-3 
selecting 6-9 

Chosen Phrase field 3-6 to 7, 3-1 3  
choosing 

commands 
for printing 12-1 1 to 12  
from a pop-up menu 2-1 7  
from a pull-down menu 2-15 

default position of the splitter in Directory win­
dows 12-20 

directory displayed in the current Directory win-
dow 4-6 

· 

directory double-click action 12-22 to 23 
display format 

as the default for Directory windows 12-18 
to 19 

in current Directory window 4-8 to 16  
double-dick speed 12-22 
environment variables 1 1-4 
external shell 12-10 
help topic 3-2 to 8 
how Directory window titles are displayed 12- 17  
limit for file size 12-21 to  22 
Looking Glass preferences 12-1 to 23 
Non-positionable format 4-1 3  
Positionable format 4-13 



1-4 A Looking Glass User's Guide 

removal preferences 12-6 
size of new Directory windows 12-18 
size of the Copy buffer 12-21 
terminal emulator 12-7 
text and data editors 12-8 to 10 
the number of seconds between display updates 

12-23 
whether directories and files are positionable 12-19 
whether hidden files are displayed in Directory 

windows 12-19 to 20 
whether to show or hide hidden files 4-12 

class . lac . ftc 13-5 
Clean Up command (Directory window) 4-14 
Clean Up command (Desktop Panel) 9-9 to 10 
Qean Up Selection command (Direct01y window) 4-14 
cleaning up repositioned directories and files 4-14 to 15 
Qeanup Preferences command (Global Window) 12-15 

to 16 
Clear command (Editing window) 10-24 
Clear command (Gallery window) 10-12 
clicking 

description of 2-2 
push buttons 2-19 

clipboard 10-12, 10-24 
aose button 3-3 
Close command (Desktop Panel) 9-6 
Close command (Directory window) 4-5 
Close command (Editing window) 10-21 
closed-path image 10-20, 10-22 
closing 

Desktop Panel 9-6 
directory panels in Tree View 6-15 to 16 
Directory windows 4-5 
Editing windows 10-27 
Gallery windows 10-10, 10-17 
Tree View window 6-24 
windows 2-10, 2-12 to 13, 2-15 

aose In Tree command (free View window) 6-15 to 16 
Close Tree View command (free View window) 6-24 
color 

assigning to directories and files 4-1 7  
assigning to user interface elements 

guidelines for choosing 12-2 to 3 
preferences 12-2 to 6 
startup arguments 

Icon Editor 10-5 
Looking Glass 1-4 

display 1-11 ,  10-19 to 20, 10-26, 12-2 
menu 4-1 7  

Color Preferences command (Global Window) 12-1 
to 4 

column 
adjusting columns in Wide view 4-1 1 
cleaning up a Directory window 4-15 
cleaning up the Desktop Panel 9-9 

Group column 1-8 to 9, 4-10 to 1 1  
Inode column 1-8 to 9 ,  4-10 to 1 1  
link Content column 1-8 to 9, 4-10 to 1 1  
links column 1-8 to 9 ,  4-10 to 1 1  
Modification Time column 1-8 to 9, 4-10 to 1 1  
Name column 1-8 to 9 ,  4-10 to 1 1  
Other column 1-8 to 9, 4-10 to 1 1  
Owner column 1-8 to 9, 4-10 to 1 1  
Size column 1-8 to 9 ,  4-10 to 1 1  
skewing icons and filenames 12-16 
Type column 1-8 to 9, 4-10 to 1 1  

COMMAND : DATA_EDITOR statement 13-17 
command-line 

Icon Editor 10-3 to 5 
Looking Glass 1-2 to 6 
text and data editor 12-9 
using the Command line dialog 8-5 to 8 

Command line (Directory window) 2-6, 8-5 to 8 
Command line (Global window) 2-6, 8-5 to 8 
COMMAND : PRINT statement 13-17 
command section 

building 13-8 to 10 
definition of 13-3 
language syntax styles P-3 

COMMAND statement 
definition of 13-15 to 16 
building the command section 13-8 to 10 

COMMAND : TEXT_EDITOR statement 13-17 
comments in file type definitions 13-27 
compiling file typing rules 13-2, 13-4 to 5, 13-12, 13-8, 

13-21 
components of file type definitions 13-4, 13-18 
confirmation dialogs 

directory removal 5-20 
file removal 5-20 
layout removal 9-4 
message boxes 2-14 
setting direct01y and file removal preferences 12-6 

connecting 
different directories and files by links 5-5 
different entries by hypertext links 3-14 
typing rule statements 13-23 

CONTENT statement 13-24 
Continue button (Find dialog) 5-10 
continuing a Find operation 5-12 
Control key 

copying files by dragging 5-18 
specifying a directory double-click action 12-22 
using actelerator keys 2-7 

Control+double-dicking 
COMMAND statement 13-15 
specifying a directory double-dick action 12-22 

to 23 
to open a Directory window from Tree View 6-1 7  



controlling the appearance and behavior of windows 
2-8 to 13 

Copy buffer 12-20 to 21 
Copy command (Directory window) 5-19 
Copy command (Editing window) 10-21, 10-24 
Copy command (Gallery window) 10-12 to 13 
copying 

icons from Looking Glass's Main Gallery 10-6, 
10-21 

icons in Editing windows 10-21, 10-24 
using the Lasso tool 10-22 
using the Selection tool 10-22 

icons into an icon gallery 10-12 to 13 
files 

by dragging 5-18 
using the Copy command 5-19 

Create command (Gallery window) 10-12 to 13 
Create menu 

accelerator key 2-6 
Device command 5-2 
Directory command 5-2 
FIFO command 5-2 
File command 5-2 

creating 
bitmap files 10-15 to 16 
creation preferences 12-12 to 14 
devices 5-2 
directories 5-2 
FIFOs 5-2 
files 5-2 
icon galleries 10-6 to 9, 10-13 
icon masks 10-24 to 26 
icons 10-18 
layouts 9-2 to 3 
links 

hard links 5-7 to 8 
symbolic links 5-8 to 9 
creation mask 12-12 to 13 

new file type definitions 
assigning a name to 13-5 
assigning an icon to 13-6 
building file matching rules for 13-6 to 8 
building the command section for 13-8 to 10 
compiling a new rulebase 13-1 1 
selecting a source file for 13-4 to 5 
using File Typing Language statements 13-13 

to 21 
using typing rule statements 13-22 to 27 

new icons 10-12 to 13  
Creation Preferences command (Global Window) 

12-12 to 14 
current directory 

#c symbol for 13-15, 13-28 
changing the name of 5-4 
definition of 4-2 

Index A 1-5 

Looking Glass symbol for 13-15 to 16, 13-28 
Cut command (Editing window) 10-21, 10-24 
Cut command (Gallery window) 10-12 to 13 
cutting, copying. and pasting icons 10-21 

D 
data . loc . ftc 13-5 
default 

button 2-19 
changing default display options 12-16 to 20 
display of icons in a Gallery window 10-8 
display of title bar in directory panels 6-18 
display of title bar in Directory windows 4-2 
icon symbol table file 13-30 
operator 13-25 
record symbol table file 13-30 
specifying a default double-dick action 12-22, 

13-14 
defining 

cleanup preferences 12-15 to 16 
colors for directories and files 4-1 7  
colors for user interface elements 

using the Name method 12-4 
using the HSB method 12-4 
using the RGB method 12-4 

creation masks 12-15 
creation preferences 12-14 
default access permissions 12-12, 12-14 
display preferences 12-16 

specifying how Directory window titles are 
displayed 12-17 

specifying the default position of  the splitter 
in Directory windows 12-20 

specifying the display format for directories 
and files 12-18 to 19  

specifying the size of  new Directory win­
dows 12-17 

specifying whether directories and files are 
positionable 12-19 

specifying whether hidden files are displayed 
in Directory windows 12-19 to 20 

environment variables 1 1-3 to 5 
execution preferences 12-7 

specifying a terminal emulator 12-7 
specifying an external shell 12-10 
specifying commands for printing 12-1 1 
specifying text and data editors 12-8 

file typing rules 13-2 to 15 
building file type definitions 13-4 to 12 
File Typing Language 13-2 to 4 
reference 13-13 to 21 
statements 13-22 to 30 

removal preferences 12-6 
DEFINE DIRECTORY statement 13-3, 13-17 to 18 
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DEFINE TYPE statement 13-17 to 1 8  
deleting 

commands form the history list 8-8 
directories and files 5-20 
environment variables 1 1-5 
layouts 9-4 
text in a field 2-1 7  to 18  

Descending command (Directory window) 4-16 
descendants 6-3 
Desktop Panel 

accelerator keys for 2-7 
activating files by double-clicking 8-2 
assigning colors to directories and files on 4-1 7  
cleaning u p  9-9 t o  1 0  
closing 9-6 
copying directories and files to 5-18 
description of 1-12 to 13, 9-5 
displaying a directory or file 9-7 
moving directories and files around on 9-9 
moving directories and files to 5-1 7 
opening 9-6 
opening files from 9-8 
printing files from 4-3, 9-9 
putting directories and files on 9-7 
removing directories from 9-7 
selecting 6-10 to 1 1  
showing directories and files from 9-8 
typical Looking Glass workspace 1-9 
viewing directories and files by name or icon 9-8 
viewing the full pathname of directories and files 

9-8 
Desktop Panel (Global Window) 
detouring in the help system 3-9, 3-1 7 
device 

creating 5-2 to 3 

type 
block 5-3, 13-24 
changing 7-12 to 14 
character 5-3, 13-24 

viewing information about 7-3 to 4 
Device command (Directory window) 5-3 
dev . lee . ftc 13-5 
dialogs 

Change Directory (Directory window) 4-6 to 7 
Change Properties (Directory window) 7-14 to 22 
Cleanup Preferences (Global window) 12-15 to 16 
clicking on an area to enter the help system 3-2 

to 3 
Close Directory In Tree (free View window) 6-15 

to 16  
Color Preferences (Global window) 12-3 to  4 
Command line (Directory or Global window) 8-5 

to 8 
Copy (Directory window) 5-19 to 20 

Creation Preferences (Global window) 12-12 to 
15 

Device (Directory window) 5-3 to 4 
Display Preferences (Global window) 12-16 to 20 
Environment Variables (Global window) 1 1-3 to 5 
Execution Preferences (Global window) 12-7 to 12 
Find (Directory window) 5-10 to 12 
Find (Global window) 5-10 to 12 
Find (free View window) 5-10 to 12, 6-21 
Information (Directory window) 7-3 to 14  
Layouts (Global window) 9-2 to  5 
Unk (Directory window) 5-7 to 9 
Merge In Saved Tree (free View window) 6-23 to 24 
Move (Directory window) 5-1 7 to 18 
Open Bitmap (Gallery window) 10-14 to 15 
Open Directory (Global window) 4-4 to 5 
Open Directory (free View window) 6-1 7  to 18 
Open Directory In Tree (free View window) 6-1 1  

to 1 3  
Open Gallery (Icon Editor window) 10-7 
Open Saved Tree (free View window) 6-23 
Operational Preferences (Global window) 12-20 

to 23 
removal confirmation (Directory window) 5-20 
Removal Preferences (Global window) 12-6 
Rename Icon (Gallery window) 10-17 
Save (Gallery window) 10-15 to 16 
Save As (Gallery window) 10-9 
Save Tree As (free View window) 6-21 to 22 
Select A Command dialog 8-3 to 4, 13-9, 13-15, 

13-17 
Select By Pattern (Directory window) 5-13 to 15 
Show Directory In Tree (free View window) 6-13 

to 15 
using 2-14 to 23 

dimmed 
arrow in History arrow 3-1 1 
arrow in Subtopic area 3-10 
commands in Create menu in Directory win-

dows S-2 
description of 2-10, 2-15, 2-18 
directories and files on the Desktop Panel 9-6 to 7 
entries in Section menu of Help window 3-15 
Hyperpath menu 3-16 

Directory command (Directory window) 5-2 
Directory double-click action 12-22 to 23 
Directory menu (free View window) 
DIRECTORY statement 13-18, 13-26 
directory panel (see also Tree View) 

changing the display format of 6-18  to 19 
definition of 6-2 to 4 

Directory windows 
accelerator keys for commands in 2-6 to 7 



assigning colors to directories and files 4-1 7  
bringing a window to the front of a stack o f  win­

dows 2-10 to 1 1  
changing display formats in 

Icon view 4-9 to 10 
Name view 4-8 to 9 
Wide view 4-10 to 1 1  

changing information in 7-4 to 22 
changing the directory displayed in the current 

Directory window 
by double<licking 4-6 
using the Change Directory command 4-6 to 7 

changing the name of a directory or file 5-4, 7-4 
to 5 

cleaning up repositioned directories and files 
using the Clean Up command 4-15 
using the Clean Up Selection command 4-15 

closing windows 
using looking Glass 4-5 
using the window manager 2-12 to 13 

creating 
devices 5-3 
directories 5-2 
FIF0s 5-2 
files 5-2 

description of 1-11  to 12, 4-2 to 3 
grouping selected directories and files 4-16 to 1 7  
moving 

stacking 4-8 
to the foreground 4-7 

opening 
by double-clicking 4-3 
using the Open command 4-4 
using the Open directory command 4-4 to 5 

resizing 2-1 1  to 12 
retyping a directory 4-1 7  to 18 
selecting all files or all directories in 5-15 
sorting directories and files in 4-15 to 16 
specifying 

a directory double<lick action 12-22 to 23 
how titles are displayed in 12-1 7 
the default position of the splitter in 12-20 
the display format for directories and files 

12-18 to 19 
the number of seconds between display 

updates 12-23 
the size of 12-17 to 18 

splitter 
definition of 1-12 
moving 4-14 
specifying the default position of 12-20 

viewing information in 7-2 to 4 
display format 

changing the current 
to Icon view 4-9 to 10 

Index A. 1-7 

to Name view 4-8 to 9 
to Positionable or Non-positionable format 

4-13 
to Wide view 4-10 to 11 

changing the default 
Directory window titles 12-17 
display format for directories and files 12-18 

to 19 
for hidden directories or files in Directory 

windows 12-19 
positionable format for directories and files 

12-19 
size of new Directory windows 12-17 to 18 

choosing whether to show or hide hidden files 
4-12 

display preferences 
description of 12-16 
specifying how Directory window titles are dis­

played 12-17 
specifying the default position of the splitter in 

Directory windows 12-20 
specifying the display format for directories and 

files 12-18 to 19 
specifying the size of new Directory windows 12-

1 7  
specifying whether directories and files are posi­

tionable 12-19 
specifying whether hidden files are displayed in 

Directory windows 12-19 to 20 
displaying 

a terminal window 8-8 
a Tree View window 

directories 6-2 to 4 
the display format of directory panels 6-18 

to 19 
the way names are displayed in title bars 6-

19 to 20 
and changing the order of icons in a Gallery 

window 10-11  to 12 
and choosing actions for a file 8-3 
changing the display order of icons in a Gallery 

window 10-11 to 12 
directories and files in Directory windows 

in Icon view 4-9 to 10 
in Name view 4-8 to 9 
in Wide format 4-10 to 1 1  

directories or files on the Desktop Panel 
by dragging 9-7 
by full pathname 9-8 
by name or icon 9-8 
with the Put On Desktop Panel a Help win­

dow 3-2 to 4, 3-9, 3-14 to 1 7  
Directory windows 

by double-clicking 4-3 to 4 
using the Open command 4-3 to 4 
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using the Open Directmy command 4-3 to 5 
the History window 3-7 to 8 
the Index window 3-5 to 7, 3-12 to 13  

Display Preferences command (Global Wmdow) 12-17 
distinguishing one file type from another 13-22 
double-dick actions 

command section shell commands 13-3 
specifying 12-22 to 23 

double-clicking 
definition of 2-2 
on any word in a Help window to open the 

Index window 3-7 
on hypertext links 3-14 to 15 
to activate a file 8-2 
to change the directory displayed by 4-6 
to close a directory in Tree View 6-15 
to display the name of a directory or file in the 

Find dialog 5-12 
to eliminate unused space between categories in 

Wide view 4-1 1 
to erase the entire editing area with the Pend! 

tool 10-23 
to open 

a directory in Tree View 6-1 1  
the Editing window for an icon 10-19 
windows 4-3 to 4 

to select the entire editing area 
using the Lasso tool 10-22 
using the Selection tool 10-22 

to sort by a category in Wide view 4-1 1  
to start the Icon Editor from Looking Glass 10-2 

double-dick speed 12-22 
dragging 

definition of 2-3 
directories and files in Positionable format 4-13 
directories and files to new positions on the 

Desktop Panel 9-9 
directories and files to the Desktop Panel 9-7 
the slide arrow to adjust a value with a scale bar 

2-24 
the slider box to scroll to a spedfic location 2-23 
the splitter to adjust the amount of space in a 

Directory window 4-14 
to copy selected files 5-18 
to define a new color for user interface elements 

12-5 
to delete text in a field 2-18 
to increase or decrease the width of a column in 

Wide view 4-1 1  
to move a column from one position to another 

in Wide view 4-1 1 
to move a window to another position on the 

workspace 2-10 
to move selected files 5-16 

to remove a category from the display in Wide 
view 4-1 1  

to replace text in a field 2-1 8  
t o  resize a window using the frame 2-12 
to select a group of directories in Tree View 6-5 

to 6 
to select all or part of an icon with the Lasso tool 

10-22 
to select all or part of an icon with the Selection 

tool 10-22 
to select icons in Gallery windows 10- 1 1  
to select text i n  a text box 2-5 
to set the default size of new Directory windows 

12-18 
drawing 

constrained to a horizontal or vertical line 10-23 
ellipses using the Ellipse tool 1 0-23 
one pixel at a time using the Pencil tool 10-23 
rectangles using the Rectangle tool 10-23 
straight lines using the Une tool 10-23 

Duplicate command (Gallery window) 10-12 to 1 3  

E 
Edit command (Gallery window) 10-18 to 19 
Edit menu (Editing window) 10-21, 10-24 
Edit menu (Gallery window) 10-12 to 13  
editing 

areas 10-19, 10-21 to 23 
commands 8-5 to 6 
environment variables 1 1 -3 to 4 
files 1-2, 12-7 to 10, 13-5 
icons 1-13, 10-12 to 1 6, 10-18 to 27 
names of directories or files 5-3 to 4, 7-4 to 5 
text in a text field 2-1 7  to 18  

Editing window 10-10, 10-18 to 19, 10-21 to 22, 10-
24, 10-26 to 27 

Icon editing area 10-19 
Mask editing area 10-19 
Preview boxes 10-19 to 22 

Image preview box 10-19 to 20 
Mask preview box 10-19 to 20 
Selected Icon preview box 10-19 to 20 
Unselected Icon preview box 10-19 to 20 

Tool palette 10-19, 10-22 to 23 
editor 

quitting the Icon Editor program 10-6 
spedfying text and data editors 12-8 to 10 
starting the Icon Editor program 10-1 to 5 

by double-clicking 10-2 
spedfying command-line arguments 10-3 to 5 
using the Icon Editor command 10-2 to 3 

eliminating unused space between two categories in 
Wide format 4-1 1 

Ellipse tool 10-23 



EMPTY statement 13-6, 13-22, 13-26 
END statement 13-3, 13-11 ,  1 3-13, 13-19 
enlarging windows 2-12 
entering 

commands 8-5, 8-8 
the help system 3-2 to 3, 3-5, 3-9 

using the Help command 3-3 to 4 
using the Help or F1 key 3-2 to 3 

the Icon Editor 10-2 to 5 
environment variables 

adding 1 1 -4 
editing 1 1-3 
HOME 1 1-2 
LG_FEATURE_SET 1 1-2, 13-10 to 1 1, 13-19 
names of variables you cannot change or delete 

1 1-2 
PATH environment variable 1 1 -2, 13-15 
removing 1 1-5 
TERM environment variable 1 1-2 
using 1 1-2 

Environment Variables command (Global Window) 
1 1-3 to 5 

Eraser tool 10-23 
escape characters 13-28 to 29 
excluding access permission 12-12 to 14 
execute check box 12-12 to 15 
execute permission 7-5 to 7, 7-1 7 
executing 

files 7-8 to 9, 7-19 
programs 1-3 

execution option 7-7 to 8, 7-15, 7-18 to 19 
execution preference 5-21, 12-7 to 12, 13-9 to 10, 13-15, 

13-17 
Execution Preferences command (global Window) 

12-7 to 8, 12-10 to 1 1  
exit codes 10-29 to 30 
exiting programs 8-4 
Export command (Gallery window) 10-13, 10-15 to 16 
extending selections 6-6 

F 
F1 (Help) key 2-7, 3-2, 3-9 
FEATURE_SET 1 1 -2, 1 3-10 to 1 1 ,  13-18 to 19, 13-29 
FEATURE_SET environmentvariable 13-10 to 11 , 13-19 
feature symbols 13-18 to 19 
FIFO 

creating 5-2 
statement 13-26 

FIFO command (Directory window) 5-2 
File command (Directory window) 5-2 
FlLE_DESCRIPTION statement 13-19 
File menu 

Desktop Panel 9-6 to 9 

Index A 1-9 

Directory window 4-4 to 6, 4-18, 5-5, 5-7 to 8, 5-16 
to 1 7, 5-19 to 21, 7-3 to 4, 7-6, 7-S to 10, 7-12 to 
13, 7-15, 7-1 7 to 18, 7-20 to 21, 8-2, 9-7 

Editing window 10-21,  10-27 
Gallery window 10-6 to 10, 10-13, 10-17 
Icon Editor window 10-6 to 9, 10-17 

File System Server (FSS) 13-2 
file type definition 13-3 to 15, 13-1 7 to 22 

assigning an icon 13-6 
building the command section 13-8 to 10 
compiling 13-2 , 13-5 , 13-13 to 14, 13-27, 13-30 
ending 13-3, 13- 1 1 ,  13-18 to 19 
format 13-4 
sample 13-31 
selecting a source file 13-4 
testing 13-10 to 1 1  

File Typing Compiler (FTC) 13-2 
parsing and syntax 13-27 
reference 13-30 

File Typing Language (FI'L) 13-1 
backslash as an escape character 13-28 
comments 13-27 
definition 13-2 
escape character 13-28 to 29 
general rules 13-7 
keywords P-3, 13-5 to 6, 13-13, 13-27 
Looking Glass symbols 13-15, 13-28 to 29 
organizing rules for maximum efficiency 13-8 
parsing and syntax guidelines 13-27 
regular expressions 13-25 to 26, 13-28 
special characters 5-10 to 1 1 ,  5-13 to 14, 6-21, 

13-26, 13-28 to 29 
strings 13-29 to 30 
white space 13-30 

file typing rulebase 10-27 to 28 13-2 
installing 13-12 

file typing rules 4-18, 13-2, 13-10 
Fill tool 10-22 
Find command (Directory window) 5-9 to 12 
Find command (Global window) 5-9 to 1 1  
Find command (Tree View window) 2-7, 6-21 
finding 

directories and files in a Directory window 5-9 to 14 
directories and files in a Tree view window 6-21 
names of icon galleries 10-7, 10-1 1 
names that match a pattern 5-10 to 1 2  

Force job Termination command (Global window) 
8-2, 8-4 

forcing monochrome display on a color monitor 1-5, 
10-4 

foreground 
color 1-5, 10-5, 10-20, 10-26, 12-2 to 3 
moving windows 2-10, 3-7 to 8, 4-7, 5-12 to 13 

format 
bitmap file format 10-15 
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display formats 1-1 1, 4-8 to 16, 12-18 to 19 
directory panels 6-18 
Directory windows 4-8 to 13 
Non-positionable format 4-13 to 16, 12-19 
Positionable format 4-13, 4-15 

of a file type definition 13-3 
of file typing source code 13-4 
Print Formatter 12-1 1 to 12, 13-1 7 
print formatting command 13-10, 13-15, 
text files 5-21, 12-7, 12-11 ,  13-9 

frames 
around windows in Looking Glass 1-5 
around windows in the Icon Editor 10-4 

FSS {File System Server) 13-2 
FfC {File Typing Compiler) 13-2 
FIL {File Typing Language) 13-2 
Full Pathname check box (Tree View window) 6-18 

to 19 

G 
galleries 

creating 10-8 to 9 
description 1 ().6 
opening 1 ().6 to 8 
saving 10-9 to 10 

Gallery window 10-2 to 3, 10-6 to 13 
general rules for creating file type definitions 13-4 to 12 
generating a file typing rulebase 13-22 to 23 
generic document icon 13-6 
gen . lee . ftc 13-5 
getting help in Looking Glass 3-2 to 8 
getting information about directories and files 7-2 to 3 
Global window 1-8 tolO, 2-6, 2-13 
Group Access command (Directory window) 4-10 
Group Modified command (Gallery window) 10-12 
group name 

Jig symbol for 8-6, 13-15, 13-28 
Group Name command (Directory window) 4-16 
Group Selected command (Gallery window) 10-12 
Group Selected Objects command (Directory win-

dow) 4-1 7 
grouping selected files and directories in a Directory 

window 4-1 7  

H 
hard link 5-5 to 7 
Help command (Global window) 3-3 to 4 
Help or F1 key 3-2, 3-9 
help system 

detouring 3-9, 3-17 
jumping 3-4, 3-9 to 10, 3-12, 3-14 to 17  
types of  help windows 3-4 to  8 
walking 3-9 to 10, 3-16 to 17  

Help window 3-3 to  5 ,  3-7, 3-9 to  12, 3-14 to  1 7  
subtopics 3-5, 3-7, 3-9 t o  1 0  3-12 t o  1 5  

hidden files 4-12, 12-19 t o  20, 13-14 
hidden 

directories 6-12 to 13 
directory panels 6-4 
files 4-12, 12-19 to 20, 13-14 
windows 2-1 1  

highlighting an object 2-2 to 5 
History arrows (Help window) 3-9, 3-11 ,  3-16 
History button (Help window) 3-8 
history list 

Change Directory dialog 4-7 
Close Directory In Tree dialog 6-16 
Command line dialog 8-5 to 8 
Copy dialog 5-19 
Help window 3-1 1, 3-1 7 
History window (Help system) 3-4, 3-7 to 9, 3-1 7  
link dialog 5-7 to 8 
Move dialog 5-18 
Open Directory dialog 4-4 to 5 
Open Directory In Tree dialog 6-13 to 14 

home directory 
creating links for 5-7 to 8 
displaying 4-3, 4-5, 4-7 
icon for 1-14 
in the Command Une dialog 8-5, 8-8 
moving files to 5-18 to 19 
showing in Tree View 6-2, 6-13 to 16 
using an environment variable for 1 1-2 

HOME environment variable 1 1-2 
HSB (hue, saturation, brightness) method 12-3, 12-5 
hyperpath 3-9, 3-12, 3-14 to 1 7  
Hyperpath menu (Help window) 3-9, 3-12, 3-14, 3-16 

to 17 
hypertext link 3-4, 3-9' 3-12, 3-14 

I 
Icon command (Desktop Panel) 9-8 
Icon command (Directory window) 4-9 to 10 
Icon command (Tree View window) 2-7, 6-18 to 19 
Icon Editor 

assigning icons to a file type 13-6 
brief tour 10-1 
choosing the icons you want to edit 10-11  
clipboard 10-12 to 24 
closing icon galleries 10-17, 10-27 
closing the current Editing window 10-27 
cutting, copying, and pasting icons 10-12, 10-13, 

10-21, 10-24 
drawing 

circles 10-23 
horiwntal lines 10-23 
lines 10-23 



one pixel at a time 10-23 
ovals (ellipses) 10-23 
rectangles 10-23 

editing icons 10-18, 10-21 
erasing 10-23 
making a copy of a selected area 10-24 
masks 

changing 10-19 to 20, 10-24 to 27 
creating 10-24 to 26 

opening icon galleries 10-6 to 8, 10-18 to 19 
preview boxes 

description of 10-19 to 21, 26 
Image preview box 10-19 to 20 
Mask preview box 10-19 to 20 
Selected Icon preview box 10-19 to 20 
Unselected Icon preview box 10-19 to 20 

quitting the Icon Editor 10-3, 10-6 
removing with the selection tool 10-22 
renaming an icon 10-16 to 1 7  
restoring the last saved version o f  a n  icon 10-10 
saving 

icons 10-6, 10-8 to 9, 10-1 7, 10-27 
icon galleries 10-6, 10-8 to 9, 10-17, 10-27 
under a new name 10-9 
under its current name 10-9 

selecting 
areas by drawing freehand 10-22 
editing areas 10-22 
icons and parts of icons 10-22 
rectangular areas by dragging 10-22 

sorting 
by modification 10-12 
by name 10-12 

tools 10-22 to 23 
window 10-2 to 3, 10-6 to 9, 10-17 

Icon Editor command (Global window) 10-2 
Icon Editor window 10-2 to 3, 10-6 to 9, 10-17 
Icon menu (Gallery window) 10-13 to 15 
Icon preview box 10-19 to 20 
ICON statement 13-3, 13-20 
Icon view 4-9 to 10, 4-1 7, 13-3, 13-6 
icons 

assigning an icon to a file type definition 13-6 
creating 10-18 to 24 
displayed in the Global window 1-10, 8-2, 8-4 
editing 10-12 to 16 
fanned 1-14, 6-7 
file type definitions for 13-2, 13-12, 13-18, 13-20 
icon symbol table 13-30 
in Directory windows 1-11, 4-17, 5-17 to 18, 12-18, 
in the Desktop Panel 4-17, 5-17 to 18, 9-5, 
introduction to 1-13 to 14 
lining up on a grid 12-15 to 16 
preloading icon images 1-6 
saving 10-9, 10-27 

selecting 2-2, 6-4, 
viewing 10-6 

icons . sym 13-11  to 12, 13-30 

Index A. 1-1 1 

Image preview box (Editing window) 10-19 to 20 
Import command (Gallery window) 10-13 to 14 
indexed keywords 3-4 to 5, 3-7 
indexed words P-1 
Index button (Help window) 3-5, 3-7 
Index window (Help window) 3-3 to 10, 3-12 to 15 
Information command (Directory window) 2-6, 7-2 

to 4, 7-6, 7-8 to 10, 7-12  to 14 
INHERIT_ COMMANDS statement 13-20 
inheritance 13-20 
inheriting a creation mask 12-12 to 13 
inode 4-10, 7-2 
!node command (Directory window) 4-10 
inserting 

data into a command line or directory path 1 1 -2 
directory and filenames in the current Directory 

window 8-5 
special symbols 8-6, 12-9, 12-11 ,  13-28 

insertion cursor 2-2, 2-18 
installing 

application programs 13-14, 13-21 
file typing rules in the Looking Glass rulebase 13-

11 to 12 
Looking Glass 1-3 
new icons 10-27 to 28 

intrinsic 
components 13-8 
keywords 13-6 
typing rule statements 13-22 

invoking programs 

J 

by double-clicking 8-2 
from a terminal window 8-8, 12-7 to 8 
from an external shell 12-10 
text and data editors 12-8 to 10 
using the Command Une dialog 8-5 
using the Open command 8-2 

jobs 
definition of 8-4 
terminating 8-4 

fordng termination 8-2, 8-4 
requesting termination 8-2, 8-4, 8-7 

jobs menu (Global window) 8-2, 8-4 
jumping to new topics in the help system 3-4, 3-9, 3-12, 

3-14 to 17  
using hypertext links 3-4, 3-14 
using the Hyperpath menu 3-16  
using the Section menu 3-15 
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K 
keystrokes 2-8 

accelerator keys 2-6 to 7 
seconds between 10-7, 10- 1 1  

keywords 
File Typing Language P-3, 1 3-4 to 6, 13- 1 1 ,  13-13 

to 14, 13-1 7 to 1 8, 13-21,  13-24 to 25, 13-27 
help system 3-4 to 5, 3-7 

killing (terminating) a job 8-2, 8-4 
Kom shell 12-10 

L 
Lasso tool 10-22, 10-24 
launching an application 1-2, 1-6 to 7, 1-10 
layers of an icon 10-25 to 26 
layouts 

Looking Glass workspace 9-2 to 5 
Tree View 6-2, 6-21 to 24 

Layouts command (Global window) 9-2 to 5 
leaving the Icon Editor 10-6 
LG_FEATIJRE_SET environment variable 1 1 -2, 13-10 

to 1 1 , 1 3-19 
lg ftc 13-4, 13- 1 1  to 12 
LG-rulebase 13-2, 1 3-1 1 to 12 
Ucense Server 1 -2 
Une tool 10-23 
Unk command (Directory window) 2-6, 5-7 to 8 
Unk Content command (Directory window) 4-10 
linked reference 5-6 to 8 
links 

definition of 5-4 
hard link 5-5 to 8 
linking multiple files or one or more directories 5-8 
symbolic link 

absolute 5-6, 5-9 
definition of 5-5 to 6 
relative 5-6, 5-9 

SYMBOUC UNK statement 1 3-6, 13-27 
Unks command (Directory window) 4-10 
Ust of saved layouts (Global window) 9-3 
listing selected directories and files first in a Directory 

window 5-15 to 1 6  
login shell 1-2 t o  3 
LONG keyword 13-25 

M 
machine display used by Looking Glass 1-6, 10-5 
malfunctioning programs 8-4 
mask 

changing all or part of 10-26 to 27 
creating 10-24 to 26 
definition of 10-24 
Mask preview box (Editing window) 10-19 to 20 

Mask Selection command (Editing window) 10-21,  
10-24 to 26 

"match all" character 13-18 
matching 

file type definitions 13-6 to 7, 13-9, 13-15, 13-17, 
13-19, 13-22 to 26, 13-29, 1 3-32 

names of directories or files 5-10 to 1 1 ,  5-13 to 15  
symbolic links 1 3-27 

Maximize button 2-9, 2-12 
memory 12-21,  13-2 
menu bar 10-19 
menus 

option 2-15 to 1 6  
pop-up 2-16 t o  1 7  
pull-down 2-14 to 1 5  
title 2-1 7 

Merge In Saved Tree command (Tree View window) 
2-7, 6-23 to 24 

merging 
icon galleries 10-27 to 30 
icons 10-18 
Tree View layouts 6-23 to 24 

metacharacters 13-25 to 26, 13-28, 13-32 
Minimize button 2-9 
Modification field 7-1 1 
Modification Tune command (Directory window) 4-10, 

4-16 
modifying 

date and time information 7-10 to 1 1, 7-19 to 20 
file typing definitions 13-4, 1 3-14, 1 3-21 
file typing rulebase 10-28 
icons 10-6, 10- 1 1  to 12 

monitor 
color 1-5, 10-4, 10-20, 10-26, 12-2 
monochrome 10-19 

mounted directories and files 5-5, 13-18, 13-26 
mouse 

clicking 2-2 
double-clicking 2-3 
dragging 2-3 to 5 
mouse actions 2-2, 5-1 6, 12-23 
mouse buttons 2-2 
Shift-clicking 2-3 

Move command (Directory window) 5-16 to 18 
moving 

by dragging 2-4, 5-16 to 1 7  
columns from one position to another i n  Wide 

format 4-1 1  
cursor to the place where you click 2-2 
directories and files to the Desktop Panel 9-7 
Directory windows to the foreground 4-7 
files 1-2, 1-1 1 to 12, 4-13, 4-15, 5-16 to 18, 9-6, 9-9 

to 10, 12-21 
through the help system 3-9 
windows 2-8, 2-10 to 1 1 , 2-21, 4-7, 4-14, 9-6, 10-12 



N 

windows to the foreground 2-10, 3-7 to 8, 4-7, 5-12 
to 13 

Name command (Directory window) 4-8 to 9, 4-15 
to 16 

Name command (Desktop Panel) 9-8 
Name command (Tree View window) 2-7, 6-18 to 19 
name of new icon gallery 10-8 
Name option 13-14, 1 3- 1 7  
NAME rule 13-22, 13-26 
NAME statement 13-23, 13-26 
Name view 1 -8, 4-8 to 9, 4-15, 6-19, 12-16 
New command (Gallery window) 10-8, 10-13 
New Gallery command (leon Editor window) 10-8 
Non-positionable format 4-13 to 1 6, 12-19 
nopreload 1-6 
NOT operator 13-23 

0 
object P-1 
OK button 2-1 8  
Open command (Desktop Panel) 2-7, 8-2, 9-8 
Open command (Directory window) 2-6, 4-3 to 4, 8-2 
Open command (Gallery window) 10-7, 10-13 
Open Directory command (Global window) 2-6, 4-3 

to 5 
Open Gallery command (leon Editor window) 10-7 
opening 

directories 4-4 to 5 
allowing others to open your directories 7-1 7, 

12-12 to 15  
at  startup 1-3  to  4 
directory windows from Tree View 6-1 7  to 

18 
fanned directory icon indicating that it is 

open 1-14 
from the Desktop Panel 9-8 
in the Tree View window 6-1 1 to 13, 6-15, 6-21 

to 22 
more than one at a time 4-4 
selecting all open directories in Tree View 6-7 

to 8 
directory panels 6-3 
Directory windows 

by double-clicking 4-3 
from Tree View 6-17 to 18 
new Directory windows 4-6, 12-22 to 23 
with or without the splitter 12-19 

files 8-2, 9-8, 13-16 
from the Global window 9-6 
in a new Directory window 4-6 

icon galleries 10-6 

subdirectories in Tree View 6-20 
terminal emulator window 8-8 
Tree View window 6-2 

Index A. 1-1 3 

Open In Tree command (Tree View window) 2-7, 6-1 1 
to 12 

Open In Window command (Tree View window) 2-7, 
6-17 

Open Saved Tree command (Tree View window) 2-7, 
6-23 

Operational Preferences command (Global window) 
4-4, 12-20 to 23 

operators for typing rule statements 13-7, 13-23, 13-25 
option menus 2-15  to 16 
options that control the operation of  lDoking Glass 

12-1 
OR operator 13-23 
organization of this user's guide P-1 
OSF/Motif 2-1 
Other Access command (Directory window) 4-10 
outlined type P-2 
Oval (Ellipse) tool 10-23 
Owner Access command (Directory window) 4-10 
Owner Name command (Directory window) 4-16 
Owner Name command (Directory window) 4-1 6  

p 
Paint (Fill) tool 10-22 
palette (tool) 10-19, 10-22 to 23 
panel 

Desktop 1-9, 1-12 to 13, 2-7, 9-5 to 10  
directory 6-2 to  4 

parent directory 4-2, 6-3 to 4, 6-20, 10-7 
Parent Directories command (Tree View window) 2-7, 

6-8 to 9 
parsing and syntax guidelines 13-13, 13-27 
passing information between programs 1 1-2 
Paste command (Editing window) 10-21 to 24 
Paste command (Gallery window) 10-12 to 1 3  
pastin g  icons 10-12 t o  1 3 ,  10-21, 10-24 
PATII environment variable 1 1-2, 13-15 
pathname 

file types and pathnames 13-15, 13-17 to 18, 13-26 
to 28 

Find command and pathnames 5-1 1  
full pathname in title bars 4-2, 9-8, 6-19 to 20, 

10-8 
in Command Une dialog 8-6 
in Directory windows 4-6 
links and pathnames 5-4 to 9 
Main Icon Gallery's full pathname 10-6 
naming a Tree View with a pathname 6-22 
opening a directory using its pathname 10-16 
renaming an icon gallery using the full or rela-

tive pathname 10-10 
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specifying a directory using its pathname 4-5, 4-7, 
5-18 to 19, 6-13, 6-15 to 16, 6-18 

specifying a terminal emulator using the path­
name of the program 12-7 

specifying text and data editors using the path-
name of the program 12-8 

Pend! tool 10-23, 10-26 
permission (see access permissions) 
Phrase list (Help window) 3-6 to 7 
pixel 

description of 10-20 to 23, 10-25 to 26 
platform 13-19 
pointer 

crosshair 10-23 
dragging the pointer 6-5 to 6 
eraser 10-23 
paint can 10-22 
pendl 10-23 
pointing device 2-2 

pop-up menus 2-16 to 1 7  
Positionable command (Directory window) 4-12 to 

13, 4-15, 5-15 
preferences 

cleanup 12-15 
color 12-2 to 4 
creation 12-12 to 1 4  
display 12-16 t o  20, 12-23 
execution 12-7 to 1 1, 13-9 to 10, 13-15, 13-17 
operational 12-20 to 23 
removal 12-5 to 6 

preview 
Icon Editor preview boxes 

description of 10-19 to 21, 10-26 
Image preview box 10-19 to 20 
Mask preview box 10-19 to 20 
Selected Icon preview box 10-19 to 20 
Unselected Icon preview box 10-19 to 20 

Cleanup Preferences preview area 12-16 
Layouts preview area 9-3 to 4 

Print command (Desktop Panel) 2-7, 9-9, 12-1 1 
Print command (Directory window) 2-6, 5-21, 12-1 1 
printing 

accelerator key 2-6 to 7 
changing preferences 12- 1 1  to 12 
command-line arguments 1-4 
files 5-21 
File Typing Language statements 

AITRIBlJI'E : PRINrABLE 13-13, 13-15, 13-20 
COMMAND : PRINr 13-13, 13-1 7, 13-20 to 21 

from the Desktop Panel 9-9 
In the command section of the F1L 13-3, 13-8 to 10 
Print Formatter 12- 1 1  to 12, 13-10, 13-17 
Print Spooler field 12-1 1 

prog . loc . ftc 1 3-5 
protection modes (see access permissions) 

pull-down menus 12-14 to 15 
push button 

default button 2-19 
description of 2-18 to 19 

Put On Desktop Panel command (Directory window) 
9-7 

Q 
question mark (?) 3-2 to 3 
Quit command (Gallery window) 10-6 
Quit command (Icon Editor window) 10-6 
Quit Looking Glass command (Global window) 1-6 

to 7 
quitting 

R 

a find operation 5-12 
an application 2-13 
Icon Editor 10-6 
Looking Glass 1-6 to 7, 1-10, 3-8 
to Install a new set of file typing rules 13-12 
radio buttons 2-20 to 21 

radio buttons 2-20 
readout box 12-4 to 5 
records . sym 13- 1 1  to 12, 13-30 
Rectangle tool 10-23 
REDEFlNE_DIRECfORY statement 13-21 
REDEF1NE_1YPE statement 13-21 
regular expressions 13-28 
relative symbolic links 

creating 5-8 to 9 
definition of 5-6 

Removal Preferences command (Global window) 12-6 
Remove command (Directory window) 5-20 
removing 

categories from Wide format display 4-1 1 ,  4-16 
directories and rues from Directory windows 1-2, 

1-1 1 ,  5-5, 5-20 
directories and rues from the Desktop Panel 9-5, 

9-7 
environment variables 1 1-4 to 5 
icons from a Gallery window 10-12, 10-24 
layouts 9-4 to 5 
links to directories and files 5-6 
permissions for rues and directories 7-7, 7-16 to 

18, 12-13 to 15 
preventing accidental removal of directories and 

files 7-5 
setting removal preferences 12-6 
the splitter from Directory windows 1-12, 4-12 to 

13 



renaming 
an icon 10-16 to 18  
an icon gallery 10-9 
directories and files 5-3, 7-4 

Rename command (Gallery window) 10-16 to 18 
replacing 

access permissions 7-1 6  to 18  
command-line arguments 8-7, 1 3-9 to 10 
icons in the Main Gallery 10-27 to 28 
items on the clipboard 10-24 
layouts 9-5 
text in a text box 2-1 7  to 18  
the contents of  a Directory window 12-22 
Tree View layouts 6-23 

repositioning directories and files 1-12, 4- 13 to 1 5  
Request job Termination command (Global win­

dow) B-4 
resizing 

column headings in Wide view 4-1 1  
the Desktop Panel 9-6 
windows 2-8 to 9, 2-1 1 to 12 

restarting 
a Find operation 5-12 
when installing new file typing rules 13- 1 1  to 12 

Restore button 3-7 
restoring 

a directory or file name in a Directory window 5-4 
a Help window entry 3-7 to 8, 3-1 1 
a maximized window 2-12 
directory panel arrangement in Tree View 6-2 
the last saved version of an icon or gallery 10-10 
window arrangement when starting Looking 

Glass 1 -7, 9-1 
retracing your steps through help 3-1, 3-16 
Retype Directory command (Directory window) 4-1 7 
retyping a directory 4-1 7  to 1 8, 1 3-12 
Revert button 12- 1 6  
Revert command (Editing window) 10-10 
Revert command (Gallery window) 10-10 
reverting 

to the last cleanup preference saved 12-16 
to the last icon gallery saved 10-10 

RGB (red, green, blue) method 12-3, 12-5 
R (read) permission 7-5 to 7 
rule base 

defining file types 
building file matching rules 13-7 
building file type definitions 1 3-4 to 5 
installing 1 3-1 1 to 12 

description of  1 3-2 
installing new icons 10-27 to 28 

rule statement 1 3-3, 1 3-6, 13-22 
Run button 8-7 
Run menu (Global window) 2-6, 8-5, 8-8, 10-2, 12-7, 

12-10 

Index A.. 1-15 

running 

s 

Looking Glass from a command line 1-3 
programs 

by double<licking 8-2, 13-15 to 16  
from the Desktop Panel 9-5 
using the Command Une dialog 8-5 to 7 
using the Open command 8-2 
using a terminal emulator 4-1 7, 8-8 

files 7-5 to 7, 7-1 7  
Icon Editor 

from a command line 10-3 
from Looking Glass 10-2 

while installing new file typing rules 1 3-12 

sample file type definition 1 3-3 1 
saturation 12-3, 12-5 
Save As command (Gallery window) 10-8 to 9 
Save command (Gallery window) 10-9 to 10, 10-13 
Save Tree As (Tree View window) 2-7, 6-21,  6-23 
saving 

layouts 1-13, 9-1 to 5 
Tree View layouts 6-21 to 24 
Icon Editor 

exporting icons as bitmap files 10-16 to 18 
icon galleries 10-8 to 1 0, 10-12, 1 0-21 
icons in an Editing window 10-27 
icons to the Main Gallery 10-6, 10-21 
images to the clipboard 10-24 
imported bitmap files as icons 10-15 

environment variables 1 1 -4 to 5, 1 3- 1 1  
scale bar 

description of 2-23 to 24 
slide arrow 2-24, 12-5 

scrolling 
a variable amount 2-23 
line by line 2-22 
one windowful of information 2-22 
scroll bar 2-21 to 22 
scroll region 2-22 to 23 
slider box 2-21 to 23 

searching using the Fmd command 5-9 to 12, 6-4, 6-21 
security 12-12 
Select All command (Gallery window) 10-12 to 13, 

10-21,  10-24 
Select All Directories command (Directory window) 

5-15 
Select All Files command (Directory window) 5-1 5  
Select By Pattern command (Directory window) 5-13, 

5-15 
selected directories 

#d symbol for 8-6, 1 3-28 
selected files 
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u symbol for 8-6, 13-28 
Selected Icon preview box 10-19 to 20 
selecting 

a help topic 3-12 to 1 7  
a rectangular area by dragging 2-3 to 4 
a source file for a file type definition 13-4 to 5 
a word 2-3, 2-5 
all directories 2-3 to 4, 5-15 6-4, 6-6 to 1 1  
all files 2-6, 5-15, 13-16 
an action for a file 8-3 
by clicking 2-2, 12, 15 to 1 7, 19 to 21,  23 
by double-clicking 2-3 
by dragging 2-3 
check boxes 2-20 to 21 
names that match a pattern 5-10 
radio buttons 2-20 
several files and directories at one time 2-3 to 4 
text 2-2 to 3, 2-5 

Select menu 5-9 to 10, 5-13, 5-15, 6-7 to 1 1  
Selection tool 10-15, 10-22, 10-24, 10-26 
setting 

access permissions 
for directories and files 7-6 to 9 
for symbolic links 5-9, 7-6 

display variables 
for Looking Glass 4-3 
for the Icon Editor 10-5 

double-click speed 12-22 
execution options 7-7 to 8, 7-18 to 19 
limit for file size 12-21 to 22 
number of seconds between display updates 12-23 
preferences 12-2 to 21 
size of the Copy buffer 12-21 

shell 
exiting a shell 2-13  
shell commands in  file type definitions 13-3, 13-5, 

13-15, 13-28 
specifying an external shell 12-10 
starting Looking Glass from a login shell 1-2 to 4 
using a shell script to execute text and data edi-

tors 1 2-10 
showing 

directories and files in Directory windows 5-12, 
9-8 to 9 

directories and files in Tree View 6-13 to 15, 6-21 
hidden files 4-12  

Show command (Desktop Panel) 2-7 
Show Full Pathname command (Desktop Panel) 9-8 
Show Hidden Files command (Directory window) 4-12 
Show 1n Tree command (free View window) 6-13 to 14 
Show menu 3-3, 5-9 to 10, 6-2, 9-6, 1 1-3 to 5 
specifying an external shell 12-10 
SHORT keyword 1 3-25 
SINGLE_ARGUMENT statement 13-6 
slide arrow 2-24, 12-5 

slider box 2-22 to 23 
SOCKET statement 13-27 
Sorted command (free View window) 6-20 
sorting 

directories and files in a Directory window 
by color 4-15  
by name 6-1 ,  10-12 
in ascending or descending order 4-15  

directories and files in  Wide view 4-1 1 
directory panels in Tree View 6-20, 6-22 
icons in a Gallery window 10-10, 10-12 

Sort menu 4-14 to 1 7, 5-16, 10-8, 10-12 
special symbols 8-6, 13-28 
splitter 

changing to Non-positionable format 4-12 to 14 
description of 1-12 
specifying the default format 12-19 to 20 

spooler 
print instructions in a file type definition 13-9 to 10 
printing files 5-21 
specifying a default print spooler 12-1 1 to 12  

Stack command (Global Window) 4-8 
stacking windows 2-10 to 1 1 , 4-7 to 8 
startup arguments (see arguments) 
starting 

Icon Editor 
from a command line 10-3 
from Looking Glass 10-2 

Looking Glass 
as a login shell 1-2 
from a command line 1-3 

the Ucense Server 1-2 
programs (see running) 

stopping 
a Find operation 5-12 
jobs that were launched from Looking Glass 8-4, 

8-7 
storing 

colors 4-1 7  
command history 8-5, 8-7 
creation masks 12-12 to 13 
date and time information 7-10 
file type definition 13-4 to 5 
icons 10-6, 10-12, 10-18, 10-24 
LG rulebase 13-2 
Tree layouts 6-21 

STRING keyword 13-25 
style conventions in manual P-2 to 4 
Subdirectories command (free View window) 2-7, 6-8 

to 9 
subdirectory 

defining creation masks for 1 2-14 to 15  
deleting 5-20 
displaying 1-12, 4-2, 12-19 
in Tree View 



closing 6-15  to 1 7  
description 6-2 
finding 6-21 
opening 6-1 1  to 13 
opening Directory windows for 6-1 7  to 18 
relationships 6-3 to 4 
selecting 6-4 to 1 1  
showing 6-1 3  to I 5 

searching 5-12 
subtree 6-10 to 1 1  
Subtrees command (free View window) 2-7, 6-10 
symbolic link 

creating 5-8 to 9 
definition of 5-5 to 6 
information about 7-4, 7-6 

SYMBOUC_UNK keyword 13-6 
SYMBOUC_UNK statement 13-27 
systems (see file system) 
System menu 1 -6, 2-15, 4-4, 4-14, 8-8, 12-3, 12-6 to 

8, 10 to 15,  1 7  to 23 

T 
Take Off Desktop Panel command (Desktop Panel) 9-7 
TERM 1 1 -2 
Terminal Emulator (Directory window) 8-8 
Terminal Emulator (Global window) 12-10 
TERMINAL_ WINDOW statement 13-16 
terminating jobs 8-4, 8-7 
text box 

description of 2-1 7 to 1 9  
in help 3-7 

TEXT statement 1 3-27 
title 

bar of Directory windows 2-9 to 10, 4-2 
line in Wide view 4-1 1 
of directory panels 6-2, 6-4 to 5 
of Directory windows 12-16 to 1 7  
o f  icon galleries 10-8 
of lists 2-20 
of menus 2-1 4  to 1 7  

token 1 3-30 
tools 10-15, 10-19, 10-22 to 24, 10-26 
top shadow 1 -6, 10-5, 12-2 to 3 
Tree View 

closing directories in 6-15  to 6-16 
description of  6-3 to 4 
directory panels 

changing the display 6-18 to 20 
description of 6-2 to 3 
opening 6-1 1  to 13  
organizing 6-20 

opening Tree View 6-2 
saving Trees 6-21 to 6-24 
selecting directories 6-4 to 1 1  

Index A 1-1 7 

showing directories 6-1 3  to 1 5  
TrY statement 13-6 
typing (see also file typing) 

accelerator keys P-2 

u 

text in a field 2-18 to 1 9  
text i n  Courier font P-3 

Undo command (Editing window) 1 0-21,  10-23 
undoing 

changes to an icon 10-2 1 ,  10-23 to 24 
changes to an icon gallery 10-10 

Unselected Directories command (free View win­
dow) 6-8 

Unselected Icon preview box 10-19 to 20 
unselecting 

by clicking 2-2 to 3 
by pattern 5-1 5  
selected directories i n  Tree View 6-4, 6-8, 6-1 1  

updating 
Looking Glass 1 3- 1 4, 1 3-21 
the . lgdb file 1 3-2 
the display in Directory windows 12-23 

user name 
#u symbol for 8-6, 13-15, 13-28, 

utility programs 
example for running 8-7 
icon_ merge 10-18, 10-28 to 29 
make 13-12 

uwm 1-4 

v 
View menu (Desktop Panel) 9-8 to 10 
View menu (Directory window) 4-9 to 10,  4-12 to 1 3, 

7-1 
View menu (free View window) 6-18, 6-20 
viewing 

actions for a file 8-3 
by Icon in a Directory window 4-9 to 1 0, 4-1 7, 

13-3, 13-6 
by Name in a Directory window 4-8 to 9 
changing view permissions 1 2-14 to 1 5  
directories and files o n  the Desktop Panel 9-7 t o  8 
directories in Tree View 6-2 to 4 
environment variables 1 1 -3 
in Wide view in a Directory window 4-10 to 1 2  
information for directories and files 7-2 t o  4 
objects found with the Find command 5-12 
setting the default view 1 2-18 to 19 
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w 
W (write) permission 5-2, 7-5 to 7, 10-6, 10-18, 10-

21,  12-12 
walking through the help system 3-9, 3-17 
Wide view 

eliminating unused space between categories 4-1 1  
increasing or decreasing the size of headings 4-1 1  
moving columns from one position to another 

4-1 1 
removing a category from the display 4-1 1  
sorting i n  Wide View 4-1 1 

window manager 
determining window position on the workspace 

12-7 
frameless window managers 2-8, 10-4 
uwm 1-4 
mwm 2-8 to 13 

Windows menu 2-1 1 , 2-19, 4-3 to 4, 4-7 to 8 
words printed in 

bold P-2 to 3, 1-5, 10-4 
boldface Courier font P-3 
Courier font P-2 to 3 

workspace 

X 

changing the default color 12-2 
description 1-7 
determining window position on the workspace 

12-7 
layouts 1-13 to 14, 9-2 to 7 
moving windows around 2-10 to 13, 4-7 to 8 
opening directories on 4-3 to 4 

X (execute) permission 5-2, 7-5 to 7 
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